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How to interpret data in ‘Activity Control Information’ window …  
 
Background Knowledge: 
 
The Activity Control Info window displays the R-Supply application's operational controls 
specific to the parent activity. This information is generally required to ensure the proper 
operation of the R-Supply batch and interactive functions. Examples of data included are 
identification of the parent Unit Identification Code (UIC), Commanding Officer’s name or 
the Supply Officer's name (if delegated by the CO) as signing authority and the Signing 
Authority should be ‘By Direction’, dollar value thresholds and sequence numbers for 
various functions. The Activity Info tab maintains data that is validated in other functions 
and provides information on your own activity such as Service Code, Ship Name, Activity 
Type, Reporting Officer, and Routing Identifier. It also displays the first and second prior 
fiscal years. Provides the capability to enable and disable the Logistics Replenishment 
(LOGREP) functionality and other interface switches at each R-Supply Force Afloat 
activity based on operational need. 
 
Data found in Activity Control Information windows are common and self explanatory. 
However, there are data items that you (the user of R-Supply) may not be familiar with 
and how the data is used by R-Supply processes.  
 
Activity Control Information consists of three tabs: They are: (1) Activity Info, (2) 
Address, and (3) Controls. Selected items on each tab are discussed below: 
 
 Activity Info tab: 
 

Reporting Officer: This data field should bear the Financial (OPTAR) 
reporting officer. Normally, the Commanding Officer’s name 
should be on this field. However, the Commanding Officer may 
delegate this function to the Supply Officer (which is normal). 
This data will be passed and printed on the Financial Reports 
and on material transfer document (Picking Ticket - DD 
Form1348-1A). 

 
Signing Authority: This data field should be “CO” if the Commanding 

Officer’s name is on the ‘Reporting Officer’ block. It will be “By 
direction” if the Supply Officer’s name is on the ‘Reporting 
Officer’ block.  

 
High Money Value: This data field is the basis for transactions to appear 

on the Stock Control Review report. Any transaction that has 
an extended money value equal to or greater than the specified 
amount will appear on the Stock Control Review report under 
the header “TRANSACTIONS WITH HIGH MONEY VALUE” 
for Stock Control Officer/Supervisor to review. This money 
value is normally specified by the Supply Officer or normally 
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set to $2,500.00. The lesser the value on this field, the more 
transactions will appear on the “Stock Control Review” report. 

 
Next Local Stock Number: This information can not be changed. It is 

used to keep track of assigning the local stock numbers unique 
to your own Ship or Activity. As you notice, the local stock 
number configuration includes the Routing Identifier (RI) of the 
Ship or Activity. The last four digits of the local stock number is 
the serial number. Serial numbers are split into two: 0001 
through 4999 are assigned to Surface items and serial 
numbers 5000 through 9999 are assigned to Aviation items. 

 
Note: The standard local stock number configuration 

is LL-(RI of the Ship/Activity)-(four digits Serial 
number). Example: Local stock number for USS 
Forrest Sherman is configured as follows:  

xxxx-LL-PWS-0001 
      xxxx = FSC of type item (i.e. 7510 for office supplies, etc.). 

      PWS = Routing Identifier of USS Forrest Sherman. 
 

You may ask how and when to use it or how the local stock 
number is updated on this field. The local stock number is 
initially entered on the “variable_parameters” table and 
updated automatically when the number is used for assignment 
to a Part Number cross reference.  
 
Here is a situation where R-Supply used the ‘Next Local Stock 
Number’ data automatically: When you process a ‘Part 
Numbered’ requisition through the “Initiate Requisitions” 
function, R-Supply automatically pick-up the next local stock 
number from the “variable_parameters” table which is 
displayed on the ‘Activity Info’ tab and assigned the local stock 
number to the requisition. It will also automatically establish the 
local stock number to the item, stock_item and part_number 
tables, eliminating the need to use the “Maintain Stock Items” 
function to establish the local stock number into your item, 
stock_item and part_number tables. In a situation that the 
customer submits ‘Part Numbered’ requirement through the 
“Material Request, Internal (MRI)” function, R-Supply will 
suspend the requirement and you have to manually establish 
the local stock number (using the local stock number displayed 
on the “Next Local Stock Number” data field on the ‘Activity 
Info” tab) into the item table before you can process the 
suspended transaction. 

 
Checkboxes: These checkboxes are switches to interfaces. Select the 

corresponding checkbox to turn-on the interface. Common 
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interfaces are: IBS RIP, DAAS Interface, Ship In ILO, New 
Construction, LOGREP, etc. 

 
 Address tab:  Self explanatory. 
 
 Controls tab: 
 
 Controls tab is divided into four major sections/blocks: They are: Financial 

Transmittal Numbers, SMART Threshold Values, Interfaces, and Force 
Inventory Drawdown.  

 
Financial Transmittal Numbers: This section indicates the next 

transmittal number for the available OPTAR for the current 
Fiscal Year plus five prior Fiscal Years. It cannot be less than 6 
years prior to current Fiscal Year. To obtain the next transmittal 
number for the last five years, type-in the year on the ‘Fiscal 
Year’ data field. (Note: Remember, the Activity is only 
authorized to maintain three Fiscal Years vise five.) 

 
SMARTS Threshold Values: This section indicates the number of 

days for the following categories with their recommended 
values: SFOEDL Challenge Follow-up (60 days), UOL (120 
days), and Purged Days (30 days). Also indicated on this 
section is the Threshold Dollar Value ($250.00). 

 
Interfaces: This section indicates what interfaces are available and 

the money value approval to process the requirements. These 
money values are Extended Money Values of the 
requirements. Any requirements coming in from that particular 
interface with extended money value of equal to or greater than 
the indicated money value approval will suspend. 

 
Force Inventory Drawdown: This section indicates the sequence 

number of the FITSDL and the last up-lined date. For Viking 
Release, this data is updated daily if the AUTOFITS feature is 
set. Some Activities are not required to submit inventory 
drawdown (FITSDL). 

 
Process MRI based on OH QTY checkbox: This checkbox when 

selected or activated will cause R-Supply to process 
requirements based on the OH QTY in your stock_item table 
(including Substitute O/H QTY). The remaining quantity will be 
ordered. 

 
 For example: If the requirement is for 3EA and the 

total OH QTY on the stock_item table is only 
1EA, R-Supply will produce a picking ticket for 
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1EA (with suffix code of “0”) and the remaining 
quantity will be screened for any substitute 
available onboard. If substitute quantity is 
available to fill the remaining or portion of the 
remaining quantity, R-Supply will produce 
another Picking Ticket with a suffix code of “1”… 
then “2” if another Picking Ticket is produced. If 
no substitute quantity is available to fill the 
remaining quantity, R-Supply will prompt the 
customer if the remaining quantity will be ordered 
as DTO. The DTO document is written to 
material_request_line, material_request, and 
material_request_tbl tables but not eligible for 
release at the “Release Outgoing Transactions” 
function until the disposition of the document at 
the Issue Pending Queue is completed. (Note: 
The unfilled document is put on hold. The unfilled 
document on hold can be released by selecting the 
‘Records on Hold’ radio button at the ‘Release Requisitions’ 
window in ‘Post Only’ option. You have to release the 
document to supply source in offline mode. However, this 
process is not recommended… wait until all the documents 
in the ‘issue pending queue’ are processed.) If the 
document is not issued or partially issued due to 
NIS condition and chooses to order the remaining 
quantity of the requirement, the unfilled quantity 
on the issue Picking Ticket will be added to the 
partial document on hold at the pending queue 
for release off-the-ship. It is highly recommended 
not to release documents that are on hold until 
the partial documents at the issue pending queue 
are completed. 

 
This checkbox is normally not selected.  

 
Procedures: 
 
To view or make changes to Activity Control Information, follow the menu path listed 
below:  
 
Site>Activity Controls>Activity Control Info… then Click the appropriate tab. 
 
(Note: To make changes, you must be a Functional Area Supervisor (FAS) with 
Administrative permission granted at the NTCSS Level) 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to view or update “Activity Serials” in R-Supply …  
 
Background Knowledge: 
 
The Activity Serials window contains and displays serial number information for the 
Activity to be used in the assignment of stock replenishment, CASREP requisition, 
Inventory adjustment document numbers, DLR reorders, Expenditure document 
numbers, etc. It is used to serialize and validate transactions applicable to UIC own. You 
will be able to add, change, or delete records on this window.  
 
The serial number ranges established are determined in combination by the activity's 
Type Commander, and higher authority. For example, Serial Type NAVSEA is 
predetermined and should not be altered by the activity. TYCOM instructions and 
directives provide guidance as to the appropriate range values for each Serial type. 
 
 
Procedures: 
 
To view or update the Activity Serials, follow the steps listed below: 
 
Step #1: Logon to R-Supply. GoTo: Site>Activity Controls>Activity Serials. 
 

Notes: Depending on platform, the following serial types can be added: 
 

CASREP Used for requisitions submitted for a Casualty 
Report. 

 
CNSMBL/ILO Requisitions for consumables, other chargeable 

material, medical/dental, chargeable services 
other than for bunker fuel delivery charges. 

 
DLR Used for Depot Level Repairable maintenance 

related material. 
 
EMRM Used for equipment maintenance related 

material including APA material. 
 
EXPEND Assigned to expenditure transactions (includes 

OSO Transfers, Material Turned into Shore). 
 
Inv Adj/ Survey Assigned to gains, losses, and survey 

transactions 
 
LAMPS Assigned to requisitions required to support 

Light Airborne Multi-purpose System embarked 
onboard. 
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NAVSEA Assigned to NAVSEA funded requisitions, not 

directly chargeable to Activity's OPTAR. 
 
NMCS Assigned to requisitions for aviation material 

required to correct a Not Mission Capable 
Supply Condition. 

 
Non-DLR Assigned to requisitions for material that does 

not have an MCC of E, G, H, Q, or X. 
 
Offload  Assigned to offload documents. 
 
PUBS Assigned to requisitions for OI Cog, 

hydrographic material, and other miscellaneous 
non-chargeable material. 

 
QCOSAL  Assigned to requisitions for QCOSAL material. 

 
 
Step #2: View the “Activity Serial” table. You may add, delete or update data.  
 

• To add serial type, point and click the “Insert” icon. 
Click the ‘Type’ dropdown menu and select a 
predefined category. Type-in the serial ranges. Click 
the “Apply” icon to save the entry or simply close the 
window. 

 
• To delete “Serial Type”, select the ‘Serial Ranges’ 

then point and click on the “delete” icon to delete 
entry. Click “Yes” on the alert or prompt window and 
Click “Apply” icon to save the changes or simply close 
the window. 

 
• To update serial ranges, select and update the ‘Serial 

Ranges’. Click the “Apply” icon to save the changes 
or simply close the window. 

 
 
Step #3: Close the “Activity Serial” table. 
 
 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 

6

mailto:absalon.auza@navy.mil


DRAFT 

How to “Create Ad Hoc Parameters” …  
 
Background Knowledge: 
 
The word “Ad Hoc” simply means a specific purpose, case, or situation. Ad Hoc is a 
utility program in the NTCSS environment that enables R-Supply user to create 
customized queries. The user can select specific data elements from the database 
tables for display. Additionally, the user can establish criteria for the data elements, 
perform calculations, sort and group items, and specify print formats.  

 
The primary purpose of Ad Hoc is to quickly generate customize reports or pull out 
information stored in any Relational database.  Caution…large Ad Hoc Queries can 
substantially slow down the system. Ad Hoc is very powerful tool for querying data from 
various tables in R-Supply database. 
 
What is Ad Hoc Query? Ad Hoc Query is a set of SQL (Structured Query Language) 
statements to generate customized reports. It is used to pull information from your 
database for managers who want immediate answers. Departmental managers, line 
managers, and other business managers often need fast answers to very precise 
operational questions. Ad hoc delivery of specific data is a key component of Enterprise 
Reporting, designed to speed up and improve decision-making. 
 
What is SQL? SQL (Structured Query Language) is an ANSI standard computer 
language for accessing and manipulating relational databases. SQL is used to access, 
define, and manipulate data in Oracle, DB2, Sybase, Informix, Microsoft SQL Server, 
Microsoft Access, and other relational database systems. 
 
What is “Relational database”? A relational database is a set of tables containing data 
fitted into predefined categories. Each table (which is sometimes called a relation) 
contains one or more data categories in columns. Each row contains a unique instance 
of data for the categories defined by the columns. It is a collection of data items 
organized as a set of formally-described tables from which data can be accessed or 
reassembled in many different ways without having to reorganize the database tables. 
The relational database was invented by E. F. Codd at IBM in 1970. The standard user 
and application program interface to a relational database is the structured query 
language (SQL). SQL statements are used both for interactive queries for information 
from a relational database and for gathering data for reports.  
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Procedures: 
 
To create ‘Ad hoc’ parameters, LOGON to: http://www.force-rsupplyViking.com and Click 
on the links provided below.) 
 

(1) Ad Hoc Crash Course 
(2) Ad Hoc Simulated Process (Click-by-click simulation) 
(3) Ad Hoc Trainee Guide 

 
 
Refer to: Appendix A – Ad Hoc Training Guide 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to “Add New Item” into the R-Supply database …  
 
Background Knowledge: 
 
You may ask, how and when ‘New Items’ are added into the R-Supply database? New 
items are added into the R-Supply database either during a batch process or interactive 
process. The following are situations where new items are added to R-Supply database: 
(1) Processing suspended MRI transactions (most common). Items are suspended due 
to NSN not carried… meaning, there is no Stock Record Card for the requested item (not 
in stock_item and item table). To process the suspended transaction, the item must be 
added to the R-Supply database before processing the suspended item. (2) Allowance 
processing (ASI process). (3) TYCOM authorized items. There are situations TYCOM 
will direct the Activity to carry interim support items. (4) Re-COSAL or Re-AVCAL 
process. Before adding a new item into the database, research must be done to ensure 
only valid items with valid data elements are added to the database. 
 
Procedures: 
 
To add new item to the R-Supply database, follow the steps listed below: 
 
Step #1: Research the item for validity. The item must be verified against the current 

edition of the FEDLOG. The following data elements are mandatory to 
successfully add a new item into the R-Supply database: FSC, COG, UI, 
UP and Nomenclature. If the item is DLR (7_ COG), MCC and Net UP are 
also required. 

 
Step #2: LOGON to R-Supply. GoTo: Inv>Stock Item>Maintain Stock Items. Enter 

the NIIN or Part Number onto the data field provided in the “Stock Item 
Search” window. If you are adding QCOSAL or otherwise called 
‘Restricted’ item, click the dropdown menu on the “Stores Type” then select 
‘Restricted’ stores type. You must have QCOSAL or ‘Restricted’ item 
permission to do or add QCOSAL item. 

 
Step #3: Click “OK” button. An alert message pops up indicating that the “NIIN does 

not exist on RSUPPLY database. Do you wish to continue?” Verify the NIIN 
to make sure you entered the correct NIIN. If the NIIN you entered is 
correct, Click “Yes” button otherwise, click “No”. 

 
Step #4: Enter the required or mandatory data elements (see Step #1) to 

successfully add the item into the item, stock_item and other related 
tables. 

 
Step #5: Click on the ‘Management Data’ tab and verify the ERC Code. This code 

defaults to C or R depending on the FSC and COG combination. Make 
sure the default is correct. If not, change the default ERC Code. 
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Step #6: Click ‘Apply’ icon to process the transaction. An alert message pops up 
indicating that “Transaction Completed Successfully”. 

 
Step #7: Click “OK” button on the “Maintain Stock Item” alert message… then select 

the appropriate response to prompt whether you need to add a location for 
the item. If the requested item is DTO, response is “No”. If the item you are 
adding is for stock, then you have the option to pre-establish a location for 
the item. R-Supply will take you back to ‘Stock Item Search’ window for the 
next item to be added. If you are done, click “Cancel” button and R-Supply 
will take you back to the highest R-Supply window you are authorized to 
access (depending on your access level). 

 
Step #8: Verify the Cumulative Transaction Ledgers (CTL). GoTo: Qry>Transaction 

Ledgers>Material. Type-in the NIIN and click “OK” button to display the 
transactions. You may click the “Descend” radio button to display the latest 
transaction on top of the list.  

 
If the transaction or transactions is/are not listed on the transaction ledgers, 
most likely the Batch Job JSS105 is not up and running. Activate the CTL 
(Batch Job JSS105) from the Predefined Parameters. GoTo: 
Site>Management>Site Internal>Batch Job Scheduling>Predefined 
Parameters… then select JSS105 (Activate CTL). Run the Batch Job. After 
a few minutes, go back and re-check the transaction ledgers. The item you 
added should be on the transaction ledgers.  

 
 
 

Note: If you’re login to the internet and want to see a simulated 
process, click here… then follow the steps listed above. 

 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to add or delete Appropriation Data in Appropriation table …  
 
Background Knowledge: 
 
Every OPTAR chargeable transaction in R-Supply requires appropriation data. When 
your Activity was implemented with R-Supply, most of the appropriation data for the 
current and two prior ‘Fiscal Years’ were pre-loaded into the R-Supply ‘appropriation 
data’ table. However, appropriations table is updated annually at the start of the new 
Fiscal Year. Every time the ‘Yearly’ Financial is ran, the appropriation data for the 
second prior Fiscal Year will be dropped automatically… then the Stock Control or 
Financial person will manually add the Appropriation data for the new Fiscal Year. Also, 
you may be required to add appropriation data for external customers that you do not 
normally provide support. For reference, consult NAVSO P-3013-2 for all types of 
Appropriations or P-485, Volume II, Appendix 30. 
 
Procedures: 
 
To add the Appropriation data at the start of the new Fiscal Year, follow the steps listed 
below: 
 

Note: Display the icon descriptions for easy identification of the displayed icons. To display the 
description, point and right click on any of the displayed icon and select “Show Text”. 

 
Step #1: LOGON to R-Supply and GoTo: Site>Financial Controls>Appropriations. 
 
Step #2: Select the Appropriation data to be updated for the new Fiscal Year. 

Normally, this Appropriation is identified by your Activity Service Code plus 
your Appropriation indicator (Normally, the first digit of your Fund Code). 

 
Step #3: Click “Insert” icon to display an empty appropriation line right above the old 

appropriation data you’ve selected (see Step #2). 
 

Note: If you erroneously or accidentally click ‘Insert’ icon and you 
want to delete the empty or blank line, just click the ‘Delete’ 
icon (Pencil Eraser) to delete the blank line. 

 
Step #4: Type-in or enter (by copying the appropriation line) except the Fiscal Year 

portion of the appropriation line. Enter the new Fiscal Year. 
 

Notes:  (1) If adding a new Appropriation that is not on the 
Appropriation table, consult NAVSO P-3013-2 or P-485, 
Volume II, Appendix 30 for validity and accuracy. 

 
(2) If error occurs due to Alpha characters in the OB 

Nbr/BCN column, call SPAWAR for Fin Password so the 
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Appropriation can be added through Financial Audit 
option. 

 
Step #5: Click “Apply” icon to save the appropriation data you added.  
 

Note: All Fund Codes that are related to the appropriation data you 
updated to new FY will be automatically updated at the Fund 
Code table to reflect the New FY. 

 
Step #6: Verify the new Appropriation line to ensure accuracy of data. 
 
 
 
Deleting Appropriation Data 
 
 To delete Appropriation data, select the appropriation line to be deleted 

and click the delete button. 
 
 
Note: After three Fiscal Years of operating in R-Supply (from initial implementation), the only 
‘Appropriation Data’ left in your Appropriation data table should be the current and two prior ‘Fiscal Years’ 
that the Activity used… plus appropriation data for Activities that you perform material transfers to. 
 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to add or delete LMC, ARRC, or IRC to an existing stock item 
records … 
 
Background Knowledge: 
 
Maintaining Stock records is a never ending process. One of these many processes is 
inserting or adding management codes (i.e. LMC, ARRC, IRC, etc.) to stock item record. 
A good example is adding ‘Local Management Code (LMC)’ or ‘Automatic Reorder 
Restriction Code (ARRC)’ or ‘Issue Restriction Code (IRC)’ to a stock item so the Stock 
Control can easily pull these items through ‘Ad hoc’ if need arises… like managing your 
“Never Out” items. “Never Out” Items are those items that must be onboard 100% 
(range) at any given time… never NIS of these items. The only way to achieve this goal 
is to closely monitor these items. It must be frequently sight and physically inventoried. 
To accomplish the goal of having 100% (range), a list must be produced as an aid to 
physical inventory of the ‘never out’ items. This is where Local Management Code (LMC) 
becomes handy to key-in during the production of the listing either through Ad Hoc 
Query or MSSLL Print program. 
 
Procedures: 
 
To add or delete Local Management Code (LMC), Automatic Reorder Restriction Code 
(ARRC) or Issue Restriction Code (IRC) to an existing stock item, follow the steps listed 
below: 
 

Note: Display the icon descriptions for easy identification of the displayed icons. To display the 
description, point and right click on any of the displayed icon and select “Show Text”. 

 
A. To add Local Management Code (LMC) to an existing stock item, follow the steps 
listed below: 
 
 
Step #1: LOGON to R-Supply and verify the ‘Local Management Code (LMC)’ in 

“LMC” table in Validation tables. GoTo: Site>Validation Tables then click 
on the dropdown menu to display the list of validation tables. Select the 
LMC table. If intended LMC is listed on the LMC Validation table, proceed 
to Step #2. If the intended LMC is not listed on the LMC table, refer to 
‘how to add or delete data element into Validation tables’ before 
proceeding to Step #2. 

 
Step #2: GoTo: Inv>Stock Item>Maintain Stock Item. 
 
Step #3: Enter the NIIN of the stock item in the space provided for NIIN search. 

Select the ‘Stores Type’. If it is a QCOSAL item, select ‘Restricted’ option. 
 
Step #4: Click “OK” button to continue the process. ‘Maintain Stock Item’ window 

will be displayed. 
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Step #5: On the “Maintain Stock Item” window, select the “Other Actions” icon on 

the toolbar (This icon should be next to ‘Apply’ or ‘Delete’ icon). The “Other 
Actions” menu will be displayed. Select “Maintain Local Management 
Codes” option then click “OK” button or simply double click on the selected 
option. ‘Maintain Local Management Codes’ window should be displayed.  

 
 Note: Display the icon descriptions for easy identification of the displayed icons. To 

display the description, point and right click on any of the displayed icon and select “Show 
Text”. 

 
 
Step #6: Select the ‘Local Management Code’ dropdown menu then select the 

appropriate LMC to continue the process. If the LMC is not displayed on 
the dropdown menu, the LMC was not added to the LMC table in the 
Validation tables. (Refer to: Add or Delete data elements in ‘Validation 
Tables’.  

 
Note: If other LMC already exist for the item, the existing LMC will be 

displayed. Select the “Insert” icon on the toolbar and click on the 
‘Local Management Code’ column. Dropdown menu should appear. 
Click the dropdown menu to display the list of LMCs. Select the 
intended LMC. 

 
Step #7: Click “Apply” icon on the toolbar to save the selected LMC. An alert 

prompt will display confirming that transaction was successfully completed. 
Close the window. Make sure to save all changes. 

 
Step #8: Verify the deleted LMC for accuracy. Perform item ‘Query’ to verify. 
 
 
 
B. To delete Local Management Code (LMC) to an existing stock item, follow the steps 
listed below: 
 
Step #1: LOGON to R-Supply and GoTo: Inv>Stock Item>Maintain Stock Item. 
 
Step #2: Enter the NIIN of the stock item in the space provided for NIIN search. 
 
Step #3: Click “OK” button to continue the process. 
 
Step #4: Click the “Other Actions” icon on the icon toolbar. “Other Actions” menu 

will be displayed. 
 
Step #5: Select ‘Maintain Local Management Codes’ option… then click “OK” 

button or simply double click the selected item to continue the process.  
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Step #6: Select the ‘Local Management Code (LMC)’ to be deleted.  
 
Step #7: Click “Delete” icon to delete the LMC. 
 
Step #8: Click “Apply” icon to save the changes. 
 
Step #9: Verify the deleted LMC. Perform item ‘Query’ to verify. 
 
 
 
C. To add ‘Automatic Reorder Restriction Code (ARRC)’ or ‘Issue Restriction Code’ 
(IRC) to an existing stock item, follow the steps listed below: 
 
Step #1: LOGON to R-Supply and verify the ‘ARRC’ or ‘IRC’ in “ARRC or IRC” table 

in Validation tables. If intended ARRC or IRC is listed on the ARRC or IRC 
Validation table, proceed to Step #2. If the intended ARRC or IRC is not 
listed on the ARRC or IRC table, refer to ‘how to add or delete data 
element into Validation tables’ before proceeding to Step #2. 

 
Step #2: GoTo: Inv>Stock Item>Maintain Stock Item. 
 
Step #3: Enter the NIIN of the stock item in the space provided for NIIN search. 
 
Step #4: Click “OK” button to continue the process. 
 
Step #5: Click the “Management Data” tab. 
 
Step #6: Click the dropdown menu on the ARRC or IRC and select the intended 

‘ARRC or IRC’. If the ARRC or IRC is not displayed on the dropdown 
menu, the ARRC or IRC was not added to the ARRC or IRC table in the 
Validation tables. (Refer to: Add or Delete data elements in ‘Validation 
Tables’). 

 
Step #7: Click “Apply” icon to save the added ARRC or IRC to the stock item. 
 
Step #8: Verify the added data element to the stock item for accuracy. Perform item 

‘Query’ to verify. 
 
 
 
D. To delete ‘Automatic Reorder Restriction Code (ARRC)’ or ‘Issue Restriction Code 
(IRC)’ to an existing stock item, follow the steps listed below: 
 
Step #1: LOGON to R-Supply and GoTo: Inv>Stock Item>Maintain Stock Item. 
 
Step #2: Enter the NIIN of the stock item in the space provided for NIIN search. 
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Step #3: Click “OK” button to continue the process. 
 
Step #4: Click the “Management Data” tab. 
 
Step #5: Clear the ‘ARRC or IRC’ on the ARRC or IRC data field using ‘Back 

Space” or “Delete” key on the keyboard.  
 
Step #6: Click “Apply” icon to save the changes. 
 
Step #7: Verify the added data element to the stock item for accuracy. Perform item 

‘Query’ to verify. 
 
 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to add data into or delete data from ‘Validation’ tables …  
 
Background Knowledge: 
 
Validation tables contain data that are used or passed during R-Supply transaction 
processes. These data are critical part of the process to ensure validity of processed 
transaction. Every R-Supply transaction is subjected to a series of validation before it is 
posted to R-Supply database tables. Any R-Supply transactions that do not pass during 
the validation process will be posted to the suspense table. 
 
There are two types or categories of Validation tables. They are: Privilege and Non-
privilege validation tables. Privilege Validation tables are tables that requires password 
from SPAWAR to modify entries. Password is unique and only works that particular day. 
If you know the password today, same password will not work the next day. Privilege 
Validation table contains data that are common to all Navy users (i.e. COG, UI, MCC, 
etc.). These validation tables can only be modified by SPAWAR personnel in which 
password is required to add or delete entries into/from the table. Non-privilege Validation 
tables are updated or maintained by the local user without any restrictions. Some of the 
data within these tables are unique to the local users (i.e. LMC, ARRC, IRC, etc.). 
 
 
Procedures: 
 
To add data into or delete data from the ‘Validation’ tables, follow the step-by-step 
procedure listed below: 
 

Note: Display the icon descriptions for easy identification of the displayed icons. To display the 
description, point and right click on any of the displayed icon and select “Show Text”. 

 
A. To add data into the validation table, follow the steps listed below: 
 
Step #1: LOGON to R-Supply and GoTo: Site>Validation Tables. Select the 

dropdown menu to display the list of tables. 
 
Step #2: Select the “Validation Table” you want updated. 
 
Step #3: Click “Insert” icon on the toolbar. 
 
Step #4: Enter the required data or code to be added. 
 
Step #5: Click “Apply” icon to save the data. 
 
Step #6: Verify data to ensure correctness of new added data into the validation 

table. To verify, close the ‘Validation Table’ screen then go back in and 
open the table you’ve just updated. 
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B. To delete data from the validation table, follow the steps listed below: 
 
 
Step #1: LOGON to R-Supply and GoTo: Site>Validation Tables. Select the 

dropdown menu to display the list of tables. 
 
Step #2: Select the “Validation Table” you want updated. 
 
Step #3: Select the data or code to de deleted. 
 
Step #4: Click “Delete” icon to delete the data. A confirmation alert prompt will be 

displayed. Click ‘OK” to continue. 
 

Step #5: Click “Apply” icon to save the updated table. 
 
Step #6: Verify data to ensure data was deleted from the validation table. To verify, 

close the ‘Validation Table’ window then go back in and open the table 
you’ve just updated. 

 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to add or delete Fund Code Data in Fund Code table …  
 
Background Knowledge: 
 
Every OPTAR chargeable transaction in R-Supply requires Fund Code in addition to 
appropriation data. Most commonly used Fund Codes are already loaded in R-Supply 
during implementation. However, you may be required to add or delete Fund Code and 
appropriation data for external customers that you do not normally provide support. For 
reference, consult NAVSO P-3013-2 for all types of Appropriations or P-485, Volume II, 
Appendix 30. 
 
Procedures: 
 
To add Fund Code data, follow the steps listed below: 
 

Note: Display the icon descriptions for easy identification of the displayed icons. To display the 
description, point and right click on any of the displayed icon and select “Show Text”. 

 
Step #1: LOGON to R-Supply and GoTo: Site>Financial Controls>Fund Codes. 
 
Step #2: Click “Insert” icon to display an empty Fund Code entry line. 
 
Step #3: Type-in the Fund Code you want to add. 
 

Note: Appropriation data must be current in the Appropriation table 
to add new Fund Code data, consult NAVSO P-3013-2 or P-
485, Volume II, Appendix 30 for validity and accuracy. 

 
Step #4: Click “Apply” icon to save the new Fund Code entry.  
 

Note: All Fund Codes must be related to an appropriation line that is 
currently in-use for the current Fiscal Year. 

 
Step #5: Verify the new Fund Code line to ensure accuracy of data. 
 
 
Deleting Fund Code Data 
 
To delete a Fund Code data on the Fund Code table, select the Fund Code to be 
deleted then click the delete icon on the icon toolbar.  
 
Note: Fund Codes that are currently in use cannot be deleted. 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to add or delete ‘Maintenance Control’ data …  
 
Background Knowledge: 
 
Maintenance Control data are loaded into three separate maintenance tables. The three 
maintenance tables are: Aircraft Data, Engine Technical Data, and Availability Data. 
These tables are applicable to Force Level R-Supply only. 
 
Aircraft Data table contains two tabs: the Aircraft Type Info tab and the Aircraft 
Identification tab. Aircraft Info tab contains four entry columns: TEC, Description (Aircraft 
Description), Aircraft Type and WSDC (Weapons System Designator Code). The Aircraft 
Identification Info tab also contains four entry columns: Bureau Number, TEC, UIC, and 
Org Cd (Organization Code). These data must be obtained from the Aircraft Squadron 
who owns the Aircraft or simply from S-6 (Supply Application Administrator (SAA)) so that 
NALCOMIS and R-Supply data are in synchronize. Otherwise, NALCOMIS transactions 
will not process through R-Supply. 
 
Engine Technical Data table is a cross-reference data between Engine TEC and Aircraft 
TEC. 
 
Availability Data table is maintained by 3M coordinator in OMMS NG. This table is used 
to keep track of the maintenance performed by your Ship’s maintenance for equipment 
owned by other Activity (i.e. USS Enterprise is fixing a motor that belongs to USS Elrod). 
 
Procedures: 
 
To add or delete ‘Maintenance Control’ data, follow the step-by-step procedure listed 
below: 
 

Note: Display the icon descriptions for easy identification of the displayed icons. To display the 
description, point and right click on any of the displayed icon and select “Show Text”. 

 
A. To add ‘Maintenance Control’ data into Aircraft data table, follow the steps listed below: 
 
Step #1: LOGON to R-Supply and GoTo: Site>Maintenance Controls>Aircraft Data. 

Aircraft Data table will be displayed with ‘Aircraft Type Info’ tab as default. If 
not, then click ‘Aircraft Type Info’ tab to display. 

 
Step #2: Click ‘Insert’ icon on the toolbar. A blank line will display for new entry. 
 
Step #3: Enter the required data. 
 
Step #4: Click ‘Apply’ icon to save data. 
 
Step #5: Click ‘Aircraft Identification Info’ tab. 
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Step #6: Click ‘Insert’ icon on the toolbar. A blank line will display for new entry. 
 
 
Step #7: Enter the required data. 
 
Step #8: Click “Apply” icon to save the data. 
 
Step #9: Verify data to ensure correctness of new added data into the Aircraft Data 

table. To verify, close the ‘Aircraft Data’ table screen then go back in and 
open the table you just updated. 

 
 
B. To delete ‘Maintenance Control’ data from the Aircraft data table, follow the steps listed 

below: 
 
 
Step #1: LOGON to R-Supply and GoTo: Site>Maintenance Controls>Aircraft Data. 

Aircraft Data table will be displayed with ‘Aircraft Type Info’ tab as default. If 
not, then click ‘Aircraft Type Info’ tab to display. 

 
Step #2: Select the line entry to be deleted. 
 
Step #3: Click ‘Delete’ icon on the icon toolbar to delete data.  
 
Step #4: Click ‘Apply’ icon to save changes. 
 
Step #5: Click ‘Aircraft Identification Info’ tab. 
 
Step #6: Select the line to be deleted. 
 
Step #7: Click ‘Delete’ icon on the icon toolbar.  
 
Step #8: Click “Apply” icon to save data changes. 
 
Step #9: Verify data to ensure deleted data is not on the table. To verify, close the 

‘Aircraft Data’ table screen then go back in and open the table you just 
updated. 

 
 
C. To add ‘Maintenance Control’ data into Engine Technical Data table, follow the steps 
listed below: 
 
Step #1: LOGON to R-Supply and GoTo: Site>Maintenance Controls>Engine 

Technical Data. Engine Technical Data table will be displayed. 
 
Step #2: Click ‘Insert’ icon on the icon toolbar. A blank line will display for new entry. 
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Step #3: Enter the required data. 
 
Step #4: Click ‘Apply’ icon to save data. 
 
Step #5: Verify data to ensure correctness of new added data into the ‘Engine 

Technical Data table. To verify, close the ‘Engine Technical Data’ table 
screen then go back in and open the table you just updated. 

 
 
D. To delete ‘Maintenance Control’ data from the Engine Technical Data table, follow the 
steps listed below: 
 
Step #1: LOGON to R-Supply and GoTo: Site>Maintenance Controls>Engine 

Technical Data. Engine Technical Data table will be displayed. 
 
Step #2: Select the line entry to be deleted. 
 
Step #3: Click ‘Delete’ icon on the icon toolbar.  
 
Step #4: Click ‘Apply’ icon to save data. 
 
Step #5: Verify data to ensure delete data from the ‘Engine Technical Data table is 

deleted. To verify, close the ‘Engine Technical Data’ table screen then go 
back in and open the table you just updated. 

 
 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to add, change, update or delete customer’s UIC in ‘Other 
Activities’ table …  
 
Background Knowledge: 
 
What is “Other Activities” table? ‘Other Activities’ table contains the customer profiles 
(i.e. Customer UIC and other pertinent data to successfully process supply transaction 
for the external customer). External customer simply means ‘other activities’ requesting 
supply and maintenance support items from your Activity. Customer UIC must be added 
to ‘Other Activities’ table prior to processing any supply request from that particular 
customer. 
 
Procedures: 
 
Adding, updating or deleting customer’s UIC in ‘Other Activities’ table: 
 

Note: Display the icon descriptions for easy identification of the displayed icons. To display the 
description, point and right click on any of the displayed icon and select “Show Text”. 

 
A. To add customer’s UIC in ‘Other Activities’ table, follow the steps listed below: 
 
Step #1: LOGON to R-Supply and GoTo: Site>Activity Controls>Other Activities. 

“Search Unit Identification Code” window will be displayed. 
 
Step #2: Type-in or enter the UIC of the prospective customer on the UIC field and 

select ‘Unit Type’. 
 
Step #3: Click “OK” button to display the ‘Other Activities’ window where the 

information of the prospective customer will be added. If the UIC is already 
on file, the Ship’s or Activity’s information will be displayed. Verify the 
entries to make sure data are current and up-to-date. If the data are current 
and up-to-date, stop at this point and proceed to processing the 
transaction. If the UIC is not present on the table, proceed to Step #4. 

 
Step #4: Enter the required data on the data field provided. Data fields are self-

explanatory. However, some data are specific to type of Ship or Activity. 
See notes below: 

 
Notes: (1) NWCF Indicator and NWCF Acty checkbox must be set if 

the customer is NWCF Activity. (Examples of NWCF 
Ship or Activity are: CVN, LHA, LHD, AS, T-AKE, etc.) 
Verify from the Customer whether they are NWCF or 
Not to confirm their current status.  

 
  (2) “Supported Unit” data field defaults to Non-Supported. 

However, if the UIC you are adding is one of the 
supported units, “Supported Unit (Accounting)” must be 
selected. Supported Unit means the Ship is performing 
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the accounting or financial reporting for the Activity. 
Also, if ‘Supported Unit (Accounting)’ is selected, the 
“Serial Numbers” tab must be updated. Enter the Serial 
Number range used by the Activity. 

 
(3) Cash Sales Option block: If the Activity you are adding is 

a UIC of Foreign Embassy (Refer to MFCS Users Guide 
for the list) Cash Sale Authorized checkbox must be set or 
selected and select the appropriate radio button whether 
the fund is “Not Collected Locally” or “Collected Locally”. 

 
Step #5: Click “Apply” icon to save the customer’s data.  
 
Step #6: Verify data to ensure the data you added are accurate. To verify, open the 

table again to ensure data were saved. 
 
B. To update customer’s UIC in ‘Other Activities’ table, follow the steps listed below: 
 
Step #1: LOGON to R-Supply and GoTo: Site>Activity Controls>Other Activities. 

“Search Unit Identification Code” window will be displayed. 
 
Step #2: Enter the UIC of the customer on the UIC field or Click the dropdown menu 

to display the list of UICs. 
 
Step #3: Select the target UIC. 
 
Step #4: Modify the appropriate data fields. 
 
Step #5: Click “Apply” icon to save the modified data.  
 
Step #6: Verify data to ensure accuracy by opening the table again to ensure data 

were saved. 
 
C. To delete customer’s UIC in ‘Other Activities’ table, follow the steps listed below: 
 
Step #1: LOGON to R-Supply and GoTo: Site>Activity Controls>Other Activities. 

“Search Unit Identification Code” pop-up window will be displayed. 
 
Step #2: Enter the UIC of the customer on the UIC field or Click the dropdown menu 

to display the list of UICS. 
 
Step #3: Select the UIC. 
 
Step #4: Click “Delete” icon to delete the UIC of the Activity from the ‘Other 

Activities’ table. 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to process ‘Backfit Offline Requisition and/or Offline Stock Issue’ 
into R-Supply and OMMS-NG …  
 
Background Knowledge: 
 
What is ‘Offline Requisition’? Offline Requisition is the process of submitting requisition 
to the supply system/source without going through the requisitioning procedures in 
OMMS/R-Supply. What is ‘Offline Stock Issue’? Offline Stock Issue is the process of 
issuing material from the storeroom (Supply Stock) without going through the MRI 
(Material Request Internal) procedures in OMMS/RSUPPLY. All documentations for 
material requests must be completed manually. (Very important note: If the material 
was issued from stock, the ‘Location’ of the material where it was pulled must be 
indicated in the issue document. You will need this information when performing the 
backfit stock issue, especially for stock items with multiple locations assigned.) This 
situation occurs when NTCSS system Suite is down and supply (maintenance or non-
maintenance) requirement is required. Supplies are issued from stock onboard if the 
material is available. However, when supply requirement is not available onboard for 
issue, the requisition for the maintenance requirement has to be processed offline and 
the MILSTRIP submitted to the supply source via any available means of submission. 
Hard copy documentation must be prepared and kept as source document during the 
“Backfit” process.  
 
Since R-Supply was by-passed during the requisitioning process, the requisition 
document was not recorded into the R-Supply active_rqn_tbl and other related database 
tables. When R-Supply is back up and running, Supply customer service must 
immediately process the offline requisitions into R-Supply to record the offline requisition 
or stock issue.  
 
If the requisition is not process or recorded in R-Supply, the impact will be two-fold: (1) 
monitoring the supply status of the requisition through the automated process is not 
feasible, (2) the money was not set aside or obligated to pay for the material when 
received. The un-obligated document will appear in Activity’s monthly SFOEDL report. 
‘Offline Requisitions’ must be processed as ‘Backfit’ into OMMS-NG for all 
maintenance-related requirements and through R-Supply using the ‘Initiate Requisition’ 
function for all non-maintenance related or consumable requirements. 
 
 
Procedures: 
 
To backfit ‘Offline Requisition or Stock Issue’ into R-Supply, follow the steps listed below: 
 
Situation #1: Backfit non-maintenance requirements into R-Supply. 
 

Note: Stock Control customer service must ensure the document is 
recorded in R-Supply database as soon as R-Supply is up and 
running or after the requisition has been submitted to the supply 
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system via naval message, email, FAX, OTS, phone call, or any 
other means of transmission to the supply source. 

 
RSUPPLY 
 
Step #1: Post the ‘Requisition’ or ‘Stock Issue’ to RSUPPLY.  

 
Notes:  (1) For posting ‘Offline Requisition’: proceed to Step #2.  
 

(2) For posting ‘Stock Issue’: proceed to Step #12. 
 
Step #2: LOGON to R-Supply and GoTo: Log>Initiate Requisitions (non-

maintenance related only). ‘Initiate Requisition’ window should display. 
 
Step #3: Select target Department and Division. 
 
Step #4: Enter target NIIN. 
 
Step #5: Select appropriate ‘Stores Type’ as applicable.  
 
Step #6: Enter the ‘Document Number’ that was used when the requisition was 

submitted to the supply source. 
 
Step #7: Select ‘Post Post’ checkbox. 
 
Step #8: Click ‘OK’ button to continue. ‘Build Requisition’ window should display. 
 
Step #9: Enter the MILSTRIP information exactly the same as what was passed or 

submitted to the supply system. Refer to the outgoing MILSTRIP message 
or other means of transmitting the requisition off-station. 

 
Step #10: Click ‘Apply’ icon to post the transaction. ‘Build Requisition Message’ alert 

window should be displayed to inform the user that the transaction has 
processed successfully. Click ‘OK’ to acknowledge the prompt. You can 
process the next transaction or click ‘Cancel’ button to go back to the main 
menu. 

 
Step #11: Verify the document to make sure it was successfully processed. Perform 

‘Transaction Ledgers’ and ‘Requisition’ queries to verify transactions. 
 

--------------------------- 
 
Step #12: LOGON to R-Supply and GoTo: Log>Material Requirements>Internal 

Request (non-maintenance related only). ‘Material Request - Search’ 
window should display. 
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Step #13: Enter the target NIIN. Select the appropriate ‘Stores Type’. Select the ‘Post 
Transaction’ checkbox. Select the target Dept and Div. 

 
Note: If the ‘Post Transaction’ checkbox was not selected, the issue must 

be completed at the ‘Issuing’ function. Menu Path: 
Log>Issuing>Storeroom Issues. 

 
Step #14: Select “OK” button to continue. ‘Material Request’ window will be 

displayed. 
 
Step #15: Enter ‘Quantity’ issued. All other required data should be default. 
 
Step #16: Select “Apply” icon to continue. ‘Document Number Assignment’ window 

should be displayed. 
 
Step #17: Select the appropriate ‘Radio’ button. ‘Allow system to generate Document 

Number’ is the default (Highly recommended).  ‘User entered Document 
Number’ radio button must be selected if a ‘Document Number’ was 
assigned when the material was issued to the customer. 

 
Step #18: Select “OK” button to continue. ‘Assigned Document Number’ pop-up 

window will be displayed with the assigned document number. 
 
Step #19: Select “OK” button to continue. ‘Storeroom Issue’ window will be displayed. 
 
Step #20: Enter the ‘Quantity’ issued. 
 
Step #21: Select “Apply” icon to post and complete the process. You can process the 

next transaction or click ‘Cancel’ button to go back to the main menu. 
 
Step #22: Verify transaction. Perform ‘Transaction Ledgers’ query to ensure 

transaction was posted. 
 
 
Situation #2: Backfit maintenance related requirements into OMMS-NG and R-Supply. 
 

Note: Maintenance related requirement backfit is performed by the joint 
effort of 3M Coordinator, Work Center Supervisor, Stock Control 
Supervisor or Supply Customer Service Supervisor.  

OMMS-NG 
 
Step #1: LOGON to OMMS-NG to process ‘Backfit’. 
 
Step #2: Set the ‘Process Backfit’ checkbox. Menu Path: Management>System 

Administration>Site Parameters… select ‘Process Backfits (Order Parts)’ 
checkbox. 
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Step #3: Add or create the ‘Work Candidate’. 3M Coordinator or Work Center 

Supervisor will establish or add and approve the ‘Work Candidate’ in 
OMMS-NG. 

 
Step #4: Open the ‘Work Candidate’ and process backfit. GoTo: OMMS: File>New 

List or simply select the ‘New List’ icon (3rd icon from the left). ‘New List’ 
window should be displayed. (Note: Once the ‘Work Candidate’ is established and 
approved in OMMS-NG, anyone that has 3M Access Level and R-Supply FAS and Stock 
Control access level should be able to backfit OMMS-NG and RSUPPLY.) 

 
Step #5: Select the ‘Work Candidate’ action button to continue. ‘Work Candidate 

List’ window should be displayed with all the ‘Work Center’ (under the 
“Organization” tab) selected or highlighted. 

 
Step #6: Select ‘Clear All’ action button to clear or de-select the Work Centers. 
 
Step #7: Select the target Work Center.  
 
Step #8: Select ‘Create List’ action button to display all the jobs for the selected 

work center. 
 
Step #9: Select the target JSN (Job Sequence Number).  
 
Step #10: Select ‘Go To’ action button to display the “Work Candidate” window 

displaying the complete JCN (Job Control Number). 
 
Step #11: Select ‘Parts’ tab to order the required maintenance parts. 
 
Step #12: Select ‘Order/Submit Parts’ action button to display all the parts within 

that component. This action button should is located at the bottom of the 
window. 

 
Step #13: Locate and select the target NIIN or Part Number required for 

maintenance by scrolling up or down. You can also put the NIIN or Part 
Number or other columns in ascending or descending order for easy locate 
of the target NIIN or Part Number by clicking on the column title. 

 
Step #14: Double click the selected or target NIIN to display the ‘Order Form’. Red 

check mark indicates mandatory data. 
 
Step #15: Enter the required quantity, urgency of need and other required data 

(Depending the type of part ordered i.e. DLR). Two action buttons will 
become active when the order form is completed … they are: ‘Queue’ and 
‘Clear’. If you want to clear the data on the order form, click on the ‘Clear’ 
action button and the order form will be cleared or become inactive. To pull 

 
Sheet 4 of  7 

 
Prepared by: Lonnie Auza – SPAWAR Norfolk 

http://www.force-rsupplyViking.com or www.force-rsupply.com  
28



DRAFT 

up the order form, double click the target NIIN to display the order form 
back in the order window. 

 
Step #16: Select ‘Queue’ action button to queue-in the part for ordering. The ‘Apply’ 

action button at the bottom of the screen will become active and the 
‘Queue’ action button will change to ‘Re-Queue’. 

 
Step #17:  Select ‘Apply’ action button to continue. An alert prompt will be displayed 

prompting you if you want to backfit this request. This prompt will show-up 
only if the ‘Process Backfit Parts’ checkbox is activated at the “Site 
Parameters”. 

 
Step #18: Select “Yes” to continue. The alert prompt should disappear. 
 
Step #19: Select ‘Backfit’ action button to continue. ‘Assign Request Number’ 

window should be displayed… parts requested is displayed at the top 
portion of the pop-up window. 

 
Step #20: Enter the ‘Document Number’. This is the document number that was 

used to submit the requisition to the supply source or the document 
number used to issue the part to the customer. Document Number format 
is: UIC-JD-Ser Number (No dashes or Service Code preffix). 

 
Note: If the backfit is:  
 
  (1) For ‘Stock Issue’, GoTo Step #26… 
 

(2) For ‘Requisition’, proceed to Step #21. 
 
Step #21: Select ‘Total Requisition’ radio button. 
 
Step #22: Select or click ‘OK’ button to continue. 
 
Step #23: Select ‘Apply’ action button to submit the transaction to Supply. An alert 

prompt will be displayed to confirm submission. 
 
Step #24: Select “Yes” button to confirm. At this time, the transaction is passed to R-

Supply for action. You can order more parts for this APL or close the 
window by clicking the ‘Close’ action button.  

 
Note: At this point two things could happen:  
 

(1) If the requested item is carried onboard… (Meaning: Supply 
maintains stock records however at time of request the item was 
NIS (Not-in-Stock). If this is the case, the requisition is now 
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posted in R-Supply database. No further action required. Verify 
the transaction (See Step #25). 

 
(2) If the requested item is NC (Not-Carried), the requisition is 
suspended for further action by the Supply personnel. For 
suspended transaction, GoTo: RSUPPLY: Log>Suspense… 
then select the ‘Function’ dropdown menu and select 
‘Requisition’. Supply personnel will process the suspended 
transaction in accordance with the procedures associated with 
‘Suspense’ processing procedures. 

 
Step #25: Verify the transaction. LOGON to R-Supply and GoTo: Qry>Transaction 

Ledgers>Material... enter the target NIIN and select “OK” button to display 
the transactions. You may select the ‘Descend’ radio button at the upper 
right-hand corner of the screen to display the current transaction on top. 
Transaction is identified as “DTO Batch Rqn” under ‘Type’ transaction. 
Also, verify Requisition. GoTo: Qry>Requisitions>Stock/DTO rqns… enter 
the target document number and click ‘OK’ button to display the requisition 
record. 

 
Note: If the target transaction is not found in either database table, the 

transaction may have been suspended. GoTo: Step #24, Note (2), 
for instructions. 

 
------------------------------ 

 
Step #26: Select ‘Issued’ radio button (Normally default.). 
 
Step #27: Enter the ‘Location’ of the material that was issued. If the material has 

multiple locations assigned, ensure the location entered is where the 
material was pulled from for issue to the customer. 

 
Step #28: Enter the ‘Quantity’ issued and tab out of the data field. The ‘OK” button 

should be active after you tab out of the data field. 
 
Step #29: Select “OK” button to continue.  
 
Step #30: Select ‘Apply’ action button at the bottom of the screen to process and 

post the issue document in R-Supply database. At this point, the backfit 
‘stock issue’ is completed. No further action required. 

 
Step #31: Verify the transaction. LOGON to R-Supply and GoTo: Qry>Transaction 

Ledgers>Material... enter the target NIIN and select “OK” button to display 
the transactions. You may select the ‘Descend’ radio button at the upper 
right-hand corner of the screen to display the current transaction on top. 
Transaction is identified as “OMMS Issue” under ‘Type’ transaction. 
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Step #32: Turn-off the ‘Process Backfit’ checkbox. GoTo: OMMS: Management> 

System Administration>Site Parameters… deselect ‘Process Backfit’ 
checkbox. This is critical action to avoid erroneous submission of 
maintenance requirement by RPPOs. 

 
 

======== End-of-Backfit ======== 
 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to use the Batch Job Scheduler …  
 
Background Knowledge: 
 
Batch Job Scheduler is a convenient feature in R-Supply to schedule Batch Jobs to run 
in future dates. Use this feature to your advantage. To use the scheduler, the “Allow 
Scheduling” checkbox at the Control Parameter Update window must be selected. If the 
Clock icon is not displayed on the toolbar when you pull-up a Batch Job for submission, 
the “Allow Scheduling” checkbox is not selected (Make sure this feature is activated at 
the Control Parameter Update screen by selecting the “Allow Scheduling” checkbox). To 
set Batch Job indicators, refer to: “Setting Batch Job Control Parameter Indicator at the 
Control Parameter Update Screen or GoTo: Site>Management>Site Internal>Batch Job 
Scheduling>Control Parameter Update. Select the Subsystem then click “OK” button to 
display the Batch Jobs available within the Subsystem selected. Locate and select the 
Batch Job then set the appropriate control indicators by selecting the corresponding 
checkbox. 
 
The following R-Supply Batch Jobs are normally scheduled to run at a specified date 
and time or in a daily basis at regular time. (1) ‘Stock Control Review’ report is an 
example of a Batch Job that can be scheduled and run daily at time of your choosing 
(i.e. daily @ 0500 hrs) so the report is ready for you when you report to work every 
morning. (2) Another Batch Job that is scheduled in a daily basis is ‘Force Inventory 
Drawdown’ (Applies only to Viking Release with AUTOFITS interface activated). (3) 
‘Suspense Listing’ is another Batch Job that you should schedule to run in a daily 
basis. SUPPO and Stock Control Officer/Supervisor should closely monitor the above 
reports. Ensure all suspended transactions that affect your OPTAR and Inventory are 
cleared in a daily basis. (4) ‘Issue Pending’ listing is another Batch Job that is 
scheduled daily for Stock Control Officer/Supervisor. Issues should be posted whenever 
the material is pulled from the location and delivered or picked-up by the customer. 
 
There are two ways to schedule a Batch Job to run at specified date and time. (1) You 
can set the “run time” of a specific Batch Job during the initial submission of the Batch 
Job or (2) you may set the “run time” to any Batch Job while the Batch Job is still on the 
approval queue just prior to approving the Batch Job.  
 
 
Procedures: 
 
To use the ‘Batch Job Scheduler’, follow the steps listed below: 
 
 Note: Before you can schedule a Batch Job to run at the specified time, 

the ‘Allow Scheduling’ indicator must be selected. (Refer to: ‘Setting the Batch Job 
Control Parameter Indicators’. Menu Path: Site>Management>Site Internal>Batch Job Scheduling>Control 
Parameter Update) 
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(1) Setting the Batch Job scheduler during the initial submission of the Batch Job: 
 

Step #1:  Logon to R-Supply and prepare to submit a Batch Job request.  
 

For demonstration purposes, submit the Batch Job for the “Force 
Inventory Drawdown” to run daily at 0100hrs.  

 
Step $2:  Submit the ‘Force Inventory Drawdown’ Batch Job to run daily at 

0100hrs… GoTo: Inventory> Management>Inventory Action>Force 
Inventory Drawdown. The Batch Job “Request Screen” will display. 
Do not select the ‘Do you wish to create a new baseline file?’ 
checkbox… not unless you are running the initial run of FITSDL and 
during the quarterly submission (Jan, Apr, Jul and Oct). 

 
Step #3:  Click the ‘Clock’ icon on the toolbar. If the “Clock” icon is not shown 

on the toolbar, the ‘Allow Scheduling’ indicator is not set. 
 
Step #4:  Click the ‘Run Frequency’ dropdown menu and select the 

appropriate run frequency (i.e. One Shot, Daily, Weekly, Monthly, 
etc.). If ‘One Shot’ option is selected, make sure to select a date 
when you want to run the Batch Job. If ‘Weekly’ option is selected, 
make sure to select the ‘Day’ of the week to run the Batch Job, etc. 

 
Note: If the Batch Job is to be scheduled to run for several 

months/years, click the “right” arrow on the ‘month’ to 
advance for the desired number of months/year. 

 
Step #5:  Set the ‘Run’ time (Configure in 24hrs clock-hour). 
 
Step #6:  Click the ‘Save’ button to save the settings. 
 

Note: Scheduled ‘frequency’ and ‘run time’ should be 
displayed on the “Schedule Entries” display box. 

 
Step #7:  Click ‘OK’ button to save the Batch Job parameters. 
 
Step #8: Click “Apply” icon on the toolbar to submit the Batch Job and 

continue. 
 

Note: “Batch Job Request Confirmation” alert window should 
display with the Batch Job Number (write down the 
Batch Job Number for future reference). 

 
Step #9: Click the “OK” button to submit the Batch Job. Steps #10 through 

#12 applies only if the “Approval Required” indicator is set at the 
‘Control Parameter Update’ window. 
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Step #10:  If the ‘Approval Required’ indicator is set at the Control Parameter 
window, you must Approve the Batch Job. GoTo: Site> 
Management>Site Internal>Batch Job Scheduling>Approval to 
approve the Batch Job. Approve the Batch Job by typing “R” on the 
‘Status’ column. 

 
Note: If the Batch Job is not on the Approval Queue, it 

means the “Approval Required” checkbox is activated 
at the Control Parameter Update screen. In this case, 
the Batch Job has been automatically approved and 
will be released to NTCSS for processing at the 
specified scheduled date and time.  

  
Step #11: Click the “Apply” icon on the toolbar to complete the Batch Job 

submission. 
 
 Step #12: Close the “Approval” window. 

 
Step #13:  Verify the scheduled batch job at the NTCSS 

TOOLBAR>System>Batch Job Queue. On the “Select Application”, 
click the dropdown menu and select “RSUPPLY” then Select the 
“Scheduled Job” radio button. The Batch Job should be listed on 
the display window. 

 
  Note: NTCSS TOOLBAR>System>Batch Job Queue 

                                                                                                    System is the three cascading squares 
on top of the NTCSS Toolbar next to 
the “right” arrow and before ‘Help’ icon. 

 
(2) Setting the Batch Job scheduler after the Batch Job have been submitted: 
 

There are situations that the Batch Job has been submitted and you (the 
FAS) would like to schedule the Batch Job to run at later date & time. You 
can set the Batch Job Scheduler so it will run at the specified date and 
time. To set the batch job scheduler, follow the steps listed below: 
 

Step #1:  GoTo: Site>Management>Site Internal>Batch Job 
Scheduling>Approval. 

 
Step #2:  Select the Batch Job to be scheduled. 
 
Step #3: Select the ‘Schd Ind’ checkbox to indicate that the Batch Job is 

scheduled to run at certain frequency and time. 
 
Step #4: Click the ‘Clock’ icon on the toolbar. 
 
Step #5:  Follow Steps #4 through #13 above. 
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Editing a Scheduled Batch Job: 
 

GoTo: NTCSS TOOLBAR>System>Batch Job Queue. On the “Select 
Application”, click the dropdown menu and select “RSUPPLY” then Select the 
“Scheduled Job” radio button. The Batch Job should be listed on the display 
window. 

  
 Select the Batch Job to be edited then select the “Schedule” button below. Modify 

the required entries and save the changes. 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to “View Input Transactions, Electronic Output Files or Reports” 
that are saved in Input File, Output File or Report directories … 
 
Background Knowledge: 
 
There are situations that you may run Batch Jobs but you do not want to print the hard 
copy output. An example of this situation is running SAMMA/SAL. You just want to view 
or take a quick glance at the number of RAB, RAO or Def-to-RO and other management 
data items (i.e. number of items carried onboard, summary of LMC or ARRC Codes tied 
to items in the database, etc.). Situation like these you do not have to spend time, 
money and other related expense as a result of printing the hard copy output. Run the 
Batch Job and save the output into the ‘report’ directory then view the report or output 
after completion of the Batch Job.  
 
To turn-off the hard copy save the output or report into the intended directories, refer to: 
“Setting the Batch Job Control Parameter Indicators”. 
 
Input Files - are saved input files (after the input file is uploaded via ‘File Transfer’) at this 

directory: /h/data/local/SUP1BT/tape_in.  
 
Output Files - are saved output files at this directory: /h/data/local/SUP1BT/tape_out.  
 
Reports - are saved Batch Job reports at this directory: /h/data/local/SUP1BT/reports.  
 
If you are the FAS with full ADMIN rights, you can quickly remove all files in any of the 
above directories. 
 
 
Procedures: 
 
To view the saved input file, output file or report, follow the steps listed below: 
 
Step #1: LOGON to R-Supply. GoTo: File>Utilities>Batch Review. 
 
Step #2: Select the appropriate “Radio Button” (i.e. Input File, Output File or 

Reports). Once a radio button is selected, ‘Select Server File’ window will 
display. The Input, Output or Report batch job numbers or process 
numbers will be displayed. (Note: If the ‘Select Server File’ display window 
is not displayed, its either no file is available for viewing or you do not have 
Admin permission to view the file or files on the system you are on.) 

 
Step #3: Select the Batch Job or Process Number… then Click “OK” button or 

simply double click the Batch Job or Process Number to display the input, 
output or report.  
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Step #4: View the input, output or report. You may click the ‘Cancel’ button at the 
lower right hand corner of the screen to select another ‘Radio Button’ or 
you can close or exit the window. 

 
 
If you have internet access and would like to navigate through the actual procedures, 
click here. Follow the steps listed above. Try all three radio buttons. 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to process ‘Bearer Pick-up’ …  
 
Background Knowledge: 
 
Bearer Pick-up is simply just that… the customer hand-carry the request for material to 
the supply source and carry the material with him/her back to the work site. However, 
some supply source may have different policies how they want the request submitted. 
Some supply source wants you to FAX, email or phone-in the MILSTRIP information 
prior to picking up the material to give the supply source time to break-out the material 
and be ready for the customer pick-up.  
 
Before making a bearer pick-up, make sure to call the Supply Center or supply source 
for the latest policy involving bearer pick-up. Normally, bearer pick-up is done when high 
priority request for spare part is either NIS or NC and the required material is available at 
the supporting FISC or Supply Support Center. 
 
 
Procedures: 
 
To process Bearer Pick-up, follow the steps listed below: 
 

Note: Display the icon descriptions for easy identification of the displayed icons. To display the 
description, point and right click on any of the displayed icon and select “Show Text”. 

 
Step #1: LOGON to R-Supply and GoTo: Log>Issuing>Storeroom Issues. 

 
Note: The customer’s material request must have been submitted 

through the MRI indicating high priority requirement and will 
down the equipment/system if material is not provided within 
24 hours (CASREP). Stock Control customer service must 
confirm the availability of the material at the supporting 
Supply Center or FISC. The request must be outstanding in 
material request queue to perform the Bearer Pick-up 
process.  

 
If the material has been picked –up from the supply source 
without going through the MRI process, the customer must 
perform OMMS NG Backfit procedures (maintenance-related 
item). If the material was for non-maintenance related 
(consumable), the document can be processed through the 
“Initiate Requisition” option and process as ‘Bearer Pick-
up/Post-post’. See how to process ‘Backfit’ (Maintenance and non-
Maintenance). 

 
Step #2: Enter the document number to be processed as ‘Bearer Pick-up” and click 

“OK” button to display the request or you may click the “All” radio button 
under ‘Search by’ block to display all outstanding request. Select the 
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document number to be processed as ‘Bearer Pick-up’ and click “OK” 
button or simply double click the document to display the request. 

 
Step #3: Once the request is displayed, enter “0” on the ‘Qty Issd’ field or you may 

leave it blank. Click “Apply” button to continue the process.  
 

Notes:  (1) If the ‘Total O/H QTY’ is not zero(0), the ‘Storeroom Issue 
Message’ prompt will be displayed indicating that ‘Sufficient 
quantity exist to process issue. Do you want to set this NIIN 
under Spot Inventory?’. Click ‘Yes’ to set the spot inventory 
flag or indicator. The “Storeroom Issue – Process Remainder” 
alert window will be displayed with four buttons (‘Order’, 
‘Subs’, ‘Canx Rem’ and ‘Cancel’). 

 
 (2) If the ‘Total O/H QTY’ is zero(0), the “Storeroom Issue – 

Process Remainder” alert window will be displayed with four 
buttons (‘Order’, ‘Subs’, ‘Canx Rem’ and ‘Cancel’). 

 
Step #4: Click “Order” button to prepare the MILSTRIP for submission to the supply 

system. The ‘Build Requisition’ screen should be displayed. 
 
Step #5: Verify the MILSTRIP data for completeness. Enter remaining MILSTRIP 

data as required. 
 
Step #6: Select the “Bearer Pick-up” checkbox. This checkbox is located above the 

“Document Nbr” block. 
 
Step #7: Click “Apply” icon on the toolbar to continue the process. Build Requisition 

Message alert window will display informing the user that the transaction is 
completed. Bearer Pick-up document (DD Form 1348-1A) should be 
printed and labeled as “Bearer Pick-up” on top of the form.  

 
Step #8: Extract the MILSTRIP from the Bearer Pick-up document and send it to 

FISC. Call the local FISC for the current policy concerning Bearer Pick-up. 
Some FISC will let you phone-in or email or FAX the MILSTRIP information 
to them ahead of time to ensure the material is ready for pick up before the 
person making the bearer pick-up gets there. 

 
Step #9: Upon return from FISC, the person making the Bearer Pick-up should 

hand-in a copy of the receipt to Stock Control customer service for 
receipt processing. 

 
Step #10: Process the receipt. LOGON to R-Supply and GoTo: Log>Receipts> 

Receipt Processing. This completes the Bearer Pick-up process. 
  
  Note: If the requirement was DLR, complete the NRFI turn-in process. 
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Step #11: Verify transactions. Perform ‘Transaction Ledgers’ query to verify the 

transaction. Check the requisition database table by performing 
‘Requisition Stock/DTO’ query to make sure document is completed 
properly. 

 
 
Important Notice: If the requirement is for consumable item, ‘Bearer Pick-up’ can be 

processed at the ‘Initiate Requisitions’ option. However, the material 
request must exist through the MRI process. The document number 
must exist in ‘Issuing’ queue. 

 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 

40

mailto:absalon.auza@navy.mil


DRAFT 

How to process “Monthly Change Notice and Annual Price Change” …  
 
Background Knowledge: 
 
What is Monthly Change Notice or Annual Price Change? Monthly Change Notice is a 
batch process in R-Supply that effect changes to data elements (i.e. COG, NSN, UI, UP, 
MCC, etc.) of existing stock item records. Whereas Annual Price Change is an annual 
change that effect only the Unit Price of an item in the stock records. It is so critical that 
all Navy Activities process their monthly change notices regularly and on time. Monthly 
Change Notice is normally processed at the end of the month after completion of the 
monthly financial closeout or first of the month before processing any transactions for the 
month. Annual Price Change is processed annually at the end of Fiscal Year (September 
30th), after the Fiscal Year closeout. It is critical to process the Annual Price Change 
notice to prevent unnecessary below threshold transactions in your monthly SFOEDL. 
You may ask, what is the relationship between Change Notices and SFOEDL (Summary 
Filled Order Expenditure Listing)? Okay, here’s why… when you process issues (NWCF 
Activities) or obligate your outstanding material requirements (NIS/NC), the charge or 
obligation was taken from the existing unit price of the item from the item table. If the unit 
price in your item table does not match with the unit price of other supply activities, there 
is a possibility that the billing and the obligated amount you submitted to DFAS will not 
match for that particular document. Therefore, that particular document will appear in the 
SFOEDL. As much as possible, keep your database aligned with the other databases. 
The only way to have it aligned is to process the change notices regularly and on time. 
 
Procedures: 
 
To process the Monthly Change Notice or Annual Price Change, follow the steps listed 
below: 
 
Step #1: Download the Change Notice from NAVICP Change Notice site. The web 

address is: https://dataxfer.navicp.navy.mil/files/pub/mrt/nsf  or download 
from WINSALTS. 

 
Note: Must have PKI certification to download from website. 

 
Step #2: Prepare the downloaded file for input. Unzip the file (if zipped) and should 

be readable in text format. 
 
Step #3: Logon to R-Supply and perform ‘File Transfer’. Upload file to Server. 

(Refer to ‘File Transfer’ Procedures). GoTo: File>Utilities>File 
Transfer>Batch File Transfer. 

 
Step #4: Verify input. GoTo: File>Utilities>Batch Review then Select ‘Input’ radio 

button. Uploaded file input should be displayed under the Batch Job 
number selected. 
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Step #5: Submit the Change Notice Batch Job. Menu path: Site>Management>Site 
Internal>Batch Job Scheduling>Predefined Jobs then Select the 
appropriate Batch Job Process (In this case, Change Notice, JSS140 or 
JSS130 for Annual Price Change). 

 
Step #6: Approve or release the Batch Job to NTCSS for processing. Menu path: 

Site>Management>Site Internal>Batch Job Scheduling>Approval. Select 
the Batch Job, type-in “R” in the ‘Status’ block then click “Apply”. 

 
Step #7: Verify or check the status of the Batch Job to ensure it processes to its 

completion. GoTo: NTCSS TOOLBAR>System>Batch Job 
Queue>RSUPPLY… then select the appropriate Job Status radio button. If 
the Batch Job was completed successfully, the ‘Completed’ status will 
indicate ‘Normal Exit’. 

 
Step #8: Process the output. This is a critical Step and must be dealt with seriously. 

There will be output after the completion of the Batch Job process (i.e. UI 
Changes, MCC Changes, COG Changes, etc.) Output distribution includes 
Supply Quality Assurance Division, Storage personnel and Stock Control 
Officer/Supervisor. The output must be processed and monitored closely 
by the Stock Control Officer/Supervisor. Like Unit-of-Issue changes, items 
have to be repacked and relabeled. Stock Control Supervisor should be the 
person responsible to ensure the actions have been completed. Supply 
Quality Assurance Division must recheck and follow-up the accuracy of the 
process. The person conducting the appropriate action or actions must 
sign the working copy and submit the annotated copy to Stock Control 
Supervisor for retention. 

 
Step #9: File and retain the worked listings for future reference and audit trail or for 

Supply Management Certification (SMC). Refer to TYCOM Instruction for 
current policy concerning retention of worked listings. 

 
 
   Congratulations… you have completed the project. 
 
 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to change or switch ‘Role Name’ in R-Supply … 
 
Background Knowledge: 
 
What is User Role Name? User Role Name is the name given to a selected function or a 
group of functions the user is authorized to access in R-Supply (i.e. receipt processing, 
inventory adjustment, post issue, etc. maybe given a ‘Role Name’ of Supply-1). A role 
name must contain at least one function. The functions included in the Role Name 
“Supply-1” are the only function or functions the user can access and perform R-Supply 
processes. 
 
There are situations when User is assigned multiple tasks (i.e. receipt processing, 
inventory processing, release outgoing transactions, MRI, posting issues, etc.). If “Role 
Names” are already created for the preceding functions (i.e. Supply-1 role name is 
assigned to include receipt processing and inventory processing and Supply-2 role name 
is assigned to include release outgoing transactions, MRI, and posting issues), a “Role 
Name” for the User that perform all the preceding functions may not be created. But 
instead, Supply-1 and Supply-2 role names will be assigned to the User that perform all 
the functions mention above. In this situation, the User must change or switch role name 
when performing a function that is under Supply-1 or Supply-2. The first role name on the 
list is the default when the User login to R-Supply. If the User has to perform a process 
that belongs to the second or third assigned role name, the User has to switch role name 
before accessing the function that the User intends to perform. 
 
Procedures: 
 
To change or switch ‘Role Name’, follow the steps listed below: 
 

Note: Display the icon descriptions for easy identification of the displayed icons. To display the 
description, point and right click on any of the displayed icon and select “Show Text”. 

 
Step #1: Logon to R-Supply and Select “Actions” on the menu bar. 
 

Note: When you click “Actions” on the menu bar, ‘Change Role’ 
option will display only if the User has a multiple ‘Role Name’ 
assigned. A blank means only one Role Name is assigned. 

 
Step #2: Select “Change Role”. ‘Available Roles’ pop-up screen will display. 
 
Step #3: Select the “Role Name” that contains the function. 
 
Step #4: Click “OK” button to switch role.  
 
Step #5: Verify the “Role Name” to make sure the switch was made. The “Role 

Name” is located on the lower right hand corner of the screen at the ‘Status 
Bar’. 

 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to view or update data on the “Constants” data tables … 
 
Background Knowledge: 
 
What are constants data tables? Constants data tables are database tables that carries 
most of the constants data that will be passed to various processes in R-Supply. These 
data must be reviewed and updated (as applicable) by the FAS at least monthly to ensure 
validity of the constants data. There are four constants data tables. They are: 
Allowance/Loads, Requisition/Offload Values, Printer Identification and Miscellaneous 
Values. 
 
Procedures: 
 
To view or change the Constants on the data tables, follow the steps listed below: 
 
Step #1: LOGON to R-Supply. GoTo: Site>Activity Controls>Constants. Constants 

tables will be displayed. 
 
Step #2: Select one of the ‘Constants’ table and refer to the notes below for brief 

explanations. Verify and understand the ‘Constants’ data in relations to the 
processes. 

 
 Notes:  
 

(1) Allowance/Load: 
 

The Allowance/Load window is used to designate Allowance/Loads 
(formerly referred to as COSAL Types) carried by the Activity. The 
‘Allowance/Load’ category must be “Active” before the Allowance/Load 
category is assigned to items to be carried in stock_item table. If the 
‘Allowance/Load’ category is not used or no longer applicable to the Activity, 
it must be inactivated by de-selecting the allowance/load category. 

 
HME and DBI allowances are indicated as active for all activities and cannot 
be deactivated. All other allowances and loads, except OSI, are available for 
activation or deactivation at the Supply Officer's discretion. 

 
The capability exists to indicate whether deficient NIIN from ASI processing 
should be automatically ordered. You may set this option if applicable. This 
is accomplished by selecting or de-selecting ASI Reorder checkbox for the 
allowance or load category. If the ASI Reorder checkbox is set, deficient ASI 
NIIN is ordered. If not set, a reorder is not generated for the deficient ASI 
NIIN. JSI208 (Reorder Review) must be processed to order deficient items. 

 
If the Activity has LOGREP functionality, the Supply Officer can also 
designate allowances and loads as protected during LOGREP processing. 
The sum of these protected allowance and load quantities are taken into 
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consideration when computing the quantity available for issue during 
LOGREP events. The capability also exists to designate default project 
codes for Stock, DTO, NAVSEA, and NAVAIR by allowance and load. 

 
Business Rules: 

 
• An allowance cannot be designated as inactive if the allowance/load 

is currently attached to an item or NSN with that allowance (which 
can be found in the COSAL List table). 

 
• An allowance cannot be designated as a LOGREP Protected 

Allowance if the allowance is inactive. 
 

• If an allowance is deactivated, the LOGREP Protected Allowance, if 
set, is also deactivated. 

 
• If the activity is not operating under LOGREP functionality, the 

Protect LOGREP Allowance check box is disabled. 
 

• Project Codes cannot be entered for an allowance if the allowance is 
inactive. If the allowance is deactivated, any Project Codes that are 
entered for that allowance will be cleared. 

 
• Operating Space Item (OSI) allowance is not available for activation 

at any activity and will not be displayed on the Allowance/Loads 
window. 

 
• If ASI Reorder is not selected for an allowance or load, deficient 

NIINs with that allowance that processes through ASI will not be an 
order/reorder candidates. 

 
 

(2) Requisition/Offload Values: 
 

 
Requisition Values 
The Requisition Default window tab enables the Supply Officer to update 
requisition information needed to process outgoing transactions. For 
example, if a ship is stationed overseas, the displayed fields can be preset 
in accordance with overseas requisitioning procedures. 

 
Routing Identifiers 

 
The Routing Identifiers area holds all Routing Identifiers to be used in 
MILSTRIP documents when ordering specific material types. 
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Project Codes 
 

The Project Codes area holds all assigned Project Codes to be used 
during material replenishment and when processing shipment and 
inventory losses. 

 
Distribution Codes 

 
The Distribution Codes area holds the code to be used in conjunction 
with the Service Designator Code to designate the activity or service 
point to receive additional supply status on a requisition. 

 
Urgency of Need 

 
The Urgency of Need area, along with the Force/Activity Designators 
(FAD), is utilized to determine the designated priority to be assigned 
on outgoing requisitions. 

 
NAVAIR APN6 

 
The NAVAIR APN6 area designates attribute values to be used on 
NAVAIR requisitions. 

 
NAVSEA 

 
The NAVSEA area designates attribute values to be used on 
NAVSEA requisitions. 

 
Standard 

 
The Standard area designates attribute values to be used on 
standard requisitions. 

 
 

Offload default values: 
 

The Offload default window tab enables the Supply Officer to update current 
values used on Offload documents. 

 
Receiving Activity 

 
The Receiving Activity area holds the UIC of the activity receiving the 
discarded material and the Extended Money Value range of the 
material. Material being offloaded cannot exceed this dollar amount. 
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DRMO 
 

The DRMO area contains the UIC of the DRMO activity and the 
Maximum Extended Money Value of material for each NIIN being 
discarded. 

 
Project Codes 

  
The Project Codes area contains all assigned Project Codes to be 
used during the offload process. 

 
Business Rules: 

 
a. "Ship To" UIC must exist on RSupply tables before it may be 

added to this window. Entry point is: Site>Activity Controls>Other 
Activities. 

 
b. "Supp Add" UIC must already exist on RSupply tables before it 

may be added to this window.  
Entry point is: Site>Activity Controls>Other Activities. 

 
c. ‘Receiving Activity’ UIC must already exist on RSupply tables 

before it may be added to this window. Entry point is: Site>Activity 
Controls>Other Activities. 

 
d. "DRMO" UIC must already exist on RSupply tables before it may 

be added to this window.  
Entry point is: Site>Activity Controls>Other Activities. 

 
e. "Routing Identifiers" RIs must already exist on RSupply tables 

before they may be added to this window. Entry point is: 
Site>Validation Tables. From the dropdown, select Routing 
Identifiers. 

 
f. The New Construction tab only appears if the New Construction 

option is selected on the Activity Control Information Window. 
 
 

(3) Printer Identification: 
 

The Printer Identification window relates printer identification names to 
printer/location codes. 
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To verify printer configuration, follow the path below: 

 
Site>Activity Controls>Constants>Printer Identification… then select the 
appropriate radio button. 

 
• Storeroom Issues – normally, the program defaults to this radio 

button. Make sure the “Priority” radio button is selected on the 
‘Routed by:’ block. On the ‘Print Configuration’ block, select the 
correct printer and the number of copies of Picking Tickets you want 
printed. If you select “1” on the ‘Number of Laser Copies, this means 
you have two copies of picking tickets. Two copies per page. 

 
If you select the “Location” radio button, make sure to select the 
correct printer.  

 
• Material Transfers – Select the correct printer type. 

 
• Carcass Turn-ins – Select the correct printer type.  

 
 

(4) Miscellaneous Values: 
 

SEAMART/PEB Review Parameters 
 

The Miscellaneous Values window is used to build or modify 
SEAMART/PEB pricing and frequency information that is used in 
creating the SEAMART/PEB Review Report. The report is an 
Inventory Management report used to review items that are 
candidates for addition or deletion from SEAMART or PEB 
classification. 

 
Dynamic Levels Checkbox 

 
The Dynamic Level Checkbox is used to indicate whether Dynamic 
Levels should be on or off, which has an impact on the setting of the 
Requisitioning Objective (RO) and the Reorder Point (RP). To run 
Dynamic Levels, refer to: How to run dynamic levels procedures. 
(Note: Dynamic Levels checkbox must be activated only when 
running the Dynamic Levels and must be turned-off after running the 
dynamic levels.) 

 
 
Step #3: Make it a habit to view and verify the constant data for currency (At least 

quarterly). 
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If you are login to the internet, you may perform the demonstration, click here to LOGON 
to R-Supply then follow the menu path indicated in Step #1. 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to transfer COSAL Quantity and/or Requisition to QCOSAL 
(Restricted) Quantity and/or Requisition or vise versa … 
 
Background Knowledge: 
 
This functionality is for Nuclear Ships or Activity Only. COSAL Quantity and/or COSAL 
Requisition transfer to QCOSAL (Restricted) is available for dual items only (items with 
COSAL/QCOSAL Allowance Quantities). It is a policy that QCOSAL (Restricted) 
Allowance must be onboard or on order (100%) at any given time. QCOSAL 
discrepancies occurs when QCOSAL (Restricted) O/H QTY plus Stock due-in is less 
than the Allowance QTY. If this situation happens, COSAL QTY or Requisition can be 
transfer to QCOSAL (Restricted) to fill the deficiency. 
 
Procedures: 
 
To transfer COSAL QTY or COSAL Requisition to QCOSAL (Restricted) category, follow 
the steps listed below: 
 

Note: Display the icon descriptions for easy identification of the displayed icons. To display the 
description, point and right click on any of the displayed icon and select “Show Text”. 

 
Step #1: LOGON to R-Supply and GoTo: Inv>Stock Item>COSAL Transfers. 
 
Step #2: Enter the ‘NIIN’ on the space provided on the COSAL Transfer – Search 

window. 
 
Step #3: Click the dropdown menu and select the appropriate Store Type to 

transfer. If transferring requisition, proceed as stated below otherwise, 
continue to Step #4. 

 
Note: If transferring requisition, check the Requisition checkbox 

then follow the steps listed below: 
 
Substep 3a. Click “OK” to continue. The “RQN COSAL Transfers” 

window is displayed with all available requisitions 
displayed for selection. 

 
Substep 3b. Select the appropriate COSAL on the “Select a 

COSAL” dropdown menu. 
 
Substep 3c. Double click on a specific Requisition to transfer to 

the selected COSAL or if all requisitions are to be 
transferred, select the ‘Transfer all requisitions’ 
checkbox. 
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Substep 3d. Click “Apply” icon on the toolbar to complete the 
transfer. “RQN COSAL Transfers Message” alert 
window will display to confirm that the transaction is 
completed successfully. 

 
Substep 3e. Click “OK” to confirm and exit the process. 
 
Substep 3f. Perform “Stock Item Query” to verify the transaction. 

 
 
Step #4: Click “OK” button to continue. “COSAL Transfers” window will be displayed 

with storeroom location quantities indicated. If multiple locations are 
assigned, select the location of the COSAL where you take it out from and 
enter the quantity to the location where you want it located for the type 
COSAL you transferred it to (multiple locations only). 

 
Step #5: Enter the ‘Quantity’ that is supposed to be the Total O/H QTY for the type 

COSAL, not the quantity to be transferred. You may add new QCOSAL 
Location if required. Whatever quantity you enter on the Quantity field, this 
quantity becomes the total quantity for the type COSAL. 

 
Step #6: Click “Apply” icon to save the data and complete the transfer. 
 
Step #7: Perform “Stock Item Query” to verify the transaction. 
 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to create or delete ‘Customize Menu’ in R-Supply … 
 
Background Knowledge: 
 
What is Customize Menu? Customize menu is a quick way of accessing R-Supply 
function rather than going through a series of menus. It is very helpful to create a 
customize menu for functions that you normally access most often (i.e. Query, Receipt 
Processing, Inventory Posting, etc.). Creating customize menus for functions used 
often will speed up the process. 
 
 
 
Procedures: 
 
To create or delete ‘Customize Menu’, follow the steps listed below: 
 

Note: Display the icon descriptions for easy identification of the displayed icons. To display the 
description, point and right click on any of the displayed icon and select “Show Text” or 
Select ‘Toolbars…’ under File menu and select “Show Text”. 

 
 
A. To create ‘Customize Menu’, follow the steps listed below: 
 
Step #1: LOGON to R-Supply and Select “Custom” on the menu bar. 
 
Step #2: Select ‘Setup Custom Menu’. “Assign Custom Menu Items” window will 

display containing two display boxes. The left hand display box contains 
the menu item list and the right hand display box displays the selected 
menu items. 

 
Step #3: Double click the desired menu item under the ‘Menu Items List’ display 

box. The menu item selected should be displayed at the right hand 
display box.  

 
Step #4: Click “Save” button to save the customize menu. Customize menu item is 

indicated by a square with number at the center of the square on the icon 
toolbar. 

 
Step #5: Verify the customize menu to ensure the correct function was selected. 
 
 
 
 
B. To delete a ‘Customize Menu’, follow the steps listed below: 
 
Step #1: LOGON to R-Supply and Select “Custom” on the menu bar. 
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Step #2: Select ‘Setup Custom Menu’. “Assign Custom Menu Items” window will 
display. 

 
Step #3: Double click the desired “Customize Menu” item at the right hand display 

box. 
 
Step #4: Click “Save” button to save the edited customize menu.  
 
 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to create the ‘User Role Name’ in R-Supply … 
 
Background Knowledge: 
 
What is User Role Name? User Role Name is the name given to a selected function 
or a group of functions the user is authorized access in R-Supply (i.e. receipt 
processing, inventory adjustment, post issue, etc. maybe given a ‘Role Name’ of 
Supply-1). The functions included in the ‘Role Name’ are the only function or 
functions the user should be able to access and perform R-Supply processes. 
 
Procedures: 
 
To create a ‘Role Name’, follow the steps listed below: 
 

Note: Display the icon descriptions for easy identification of the displayed icons. To display 
the description, point and right click on any of the displayed icon and select “Show 
Text”. 

 
Step #1: LOGON to R-Supply and GoTo: Site>Activity Controls>Users Access. 
 
Step #2: Select anyone of the active username to access the ‘Users Access’ 

window. 
 
Step #3: Click “OK” button or simply double click the username to display the 

“Users Access” window. 
 
Step #4: Click the “Add User…” icon (Two red arrows in circle form) to display 

the ‘Other Menus’ screen. 
 
Step #5: Select one of the ‘Role Name’ as template. 
 
Step #6: Click the “Modify Role” icon to display the ‘Edit Menu Options’ 

window. 
 
Step #7: Select the appropriate function or functions to be included in the ‘Role 

Name’. Functions are preceded or indicated with a letter “R”. Click on 
the function to select or deselect. Selected function(s) is highlighted in 
‘Blue’ background. 

 
Step #8: Click “Save As” icon to assign name of the newly created ‘Role Name’. 

Type-in the new ‘Role Name’ on the “Enter new Menu” data field. 
 
Step #9: Click “OK” button to save the ‘Role Name’. The ‘Role Name’ is now 

ready to be assigned to a User. 
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Step #10: Close the window. The newly created ‘Role Name’ should display on 
the ‘Role Name’ display box ready for assignment to any authorize 
user. 

 
Step #11: Verification. Add the new Role Name to the Assistant FAS ‘User Role 

Name’ and let the Assistant FAS LOGIN and let him/her change ‘user 
role name’ to the newly created role name for verification of assigned 
functions. 

 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to add or delete cross-reference data to existing stock item 
records …  
 
Background Knowledge: 
 
Adding cross-reference data to existing stock item is critical for research process. Cross-
reference processing function is used to add or delete ‘Part Number to Stock Numbers’ 
or ‘Deleted Superseded NIIN’ or ‘Substitute/Interchangeable NIIN’ cross-reference data. 
 
Part Number to Stock Number cross-reference data (part_number table) is used when 
Supply Customer Service received a part numbered requirement. Part Number Query 
option will be a handy tool for this requirement. 
 
Deleted Superseded NIIN cross-reference data (superseded_item table) is very helpful 
when doing wall-to-wall inventory. Personnel doing the inventory may find frustrated 
items in the storeroom… meaning, you have an item in location however, the item is not 
listed in the current stock_item table. This is a result of not processing the output of the 
‘Monthly Change Notice’. After the ‘Monthly Change Notice’, the output labeled 
“Superseded NIIN’ must be processed by the storage personnel to re-label those item 
affected. Deleted Superseded NIIN cross-reference data is automatically updated during 
the ‘Monthly Change Notice’ processing. 
 
Substitute/Interchangeable NIIN cross-reference data (alternate_item table) is updated 
when a receipt is processed with a substitute item or during the ‘Stock Item 
Maintenance’ processing or during the ‘Substitute/Interchangeable NIIN’ Batch 
Processing. It is critical to update the alternate_item table regularly. Substitute/ 
Interchangeable data is available for download from the NAVICP designated site. 
 
 
Procedures: 
 
To add cross-reference data, follow the steps listed below: 
 

Note: Display the icon descriptions for easy identification of the displayed icons. To display the 
description, point and right click on any of the displayed icon and select “Show Text”. 

 
 
A. To add ‘Part Number to Stock Number’ cross-reference data, follow the steps 
listed below: 
 
Step #1: LOGON to R-Supply and GoTo: Inv>Stock Item>Cross-Reference 

Processing.  
 
Step #2: Enter the target NIIN or Part Number on the space provided on the ‘Stock 

Item Search’ window… then Click ‘OK” to continue. The ‘Cross-Reference 
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Processing’ window should have three tabs (Part Number to Stock 
Number, Deleted Superseded NIIN, and Substitute/Interchangeable NIIN). 

 
Step #3: Click the ‘Part Number to Stock Numbers’ tab (Normally, is the default 

tab). 
 
Step #4: Click “Insert” icon on the toolbar. 
 
Step #5: Enter the CAGE and the Part Number data. 
 
Step #6: Click “Apply” icon to save the cross-reference data. Information alert 

window will display with the message that ‘Transaction Completed 
Successfully’. 

 
 
 
 
 
B. To add ‘Deleted/Superseded NIIN’ cross-reference data, follow the steps listed 
below: 
 
Step #1: LOGON to R-Supply and GoTo: Inv>Stock Item>Cross-Reference 

Processing.  
 
Step #2: Enter the target NIIN or Part Number on the space provided on the ‘Stock 

Item Search’ window… then Click “OK” to continue. The ‘Cross-Reference 
Processing’ window should have three tabs (Part Number to Stock 
Number, Deleted Superseded NIIN, and Substitute/Interchangeable NIIN). 

 
Step #3: Click the ‘Deleted Superseded NIIN’ tab. 
 
Step #4: Click “Insert” icon on the toolbar. 
 
Step #5: Enter the ‘Superseded NIIN’ and the ‘Superseding NIIN’ (Superseded 

NIIN and the Superseding NIIN must be in “item” table to process the 
cross-reference data. ‘Date of Last Action’ should be default to current 
system date. If not a default, enter the current date. 

 
Step #6: Click “Apply” icon to save the cross-reference data. Information alert 

window will display with the message that ‘Transaction Completed 
Successfully’. 
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C. To add ‘Substitute/Interchangeable NIIN’ cross-reference data, follow the steps 
listed below: 
 
Step #1: LOGON to R-Supply and GoTo: Inv>Stock Item>Cross-Reference 

Processing.  
 
Step #2: Enter the target NIIN or Part Number on the space provided on the ‘Stock 

Item Search’ window… then Click “OK” to continue. The ‘Cross-Reference 
Processing’ window should have three tabs (Part Number to Stock 
Number, Deleted Superseded NIIN, and Substitute/Interchangeable NIIN). 

 
Step #3: Click the ‘Substitute/Interchangeable NIIN’ tab. 
 
Step #4: Click “Insert” icon on the toolbar. 
 
Step #5: Enter the ‘Substitute/Interchangeable NIIN’ (Substitute/Interchangeable 

NIIN must be in “item” table to process the cross-reference data.  
 
Step #6: Click “Apply” icon to save the cross-reference data. Information alert 

window will display with the message that ‘Transaction Completed 
Successfully’. 

 
 
To delete cross-reference data, follow the steps listed below: 
 
Step #1: LOGON to R-Supply and GoTo: Inv>Stock Item>Cross-Reference 

Processing.  
 
Step #2: Enter the target NIIN or Part Number on the space provided on the ‘Stock 

Item Search’ window… then Click “OK” to continue. The ‘Cross-Reference 
Processing’ window should have three tabs (Part Number to Stock 
Number, Deleted Superseded NIIN, and Substitute/Interchangeable NIIN). 

 
Step #3: Click the ‘applicable’ tab. 
 
Step #4: Select the target cross-reference data to be deleted. 
 
Step #5: Click “Delete” icon on the toolbar. 
 
Step #6: Click “OK” button on the alert prompt to continue.  
 
Step #7: Click “Apply” icon to save the changes.  
 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to delete ‘User Role Name’ in R-Supply … 
 
Background Knowledge: 
 
What is User Role Name? User Role Name is the name given to a selected function 
or a group of functions the user is/are authorized to access in R-Supply (i.e. receipt 
processing, inventory adjustment, post issue, etc. maybe given a ‘Role Name’ of  
Supply-1). The functions included in the ‘Role Name’ are the only function or 
functions the user should be able to access and perform R-Supply processes. 
 
Deleting “User Role Name” is sometimes necessary vise editing the “Role Name”. 
 
 
Procedures: 
 
To delete ‘User Role Name’, follow the steps listed below: 
 

Note: Display the icon descriptions for easy identification of the displayed icons. To display 
the description, point and right click on any of the displayed icon and select “Show 
Text”. 

 
Step #1: LOGON to R-Supply and GoTo: Site>Activity Controls>Users Access. 
 
Step #2: Select one of the active username and click “OK” button or simply 

double click the user to display the “Users Access” window. 
 
Step #3: Click the “Add User…” icon (Two red arrows in circle form) to display 

the ‘Other Menus’ screen. 
 
Step #4: Select the ‘Role Name’ to be deleted. 
 
Step #5: Select ‘Modify Role’ icon. ‘Edit Menu Options’ window will be 

displayed. 
 
Step #6: Click the “Delete” icon to delete the “Role Name”. 
 

Note: Role Name cannot be deleted if the role name is 
assigned to active User. 

 
 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to reverse ‘Demand Data’ in R-Supply …  
 
Background Knowledge: 
 
Demand data is normally created when an item is requested or demanded by the 
customer. When the requirement is submitted through R-Supply functions (MRI or 
Initiate Requisitions Option), demand data is normally recorded if the demand code is 
equal to “R” (default) on the ‘demand code’ data element. “R” on the ‘demand code’ data 
element (Card position 44 on the MILSTRIP format) means, demand is recorded into the 
‘demand’ table. If the demand code is changed to “N”, demand data will not be recorded 
on the ‘demand’ table. Demand code “N”… meaning, the requested item is not 
reoccurring demand or simply called one-time requirement or seasonal item (i.e. 
Christmas Lights, etc.). 
 
Demand data records are the basis whether the item becomes “Demand Based Item”. 
Demand based items are identified in the ‘stock_item’ table as Allowance Type Code 
(ATC) “4” or DBI indicator for ATC 1, 2 and 3. ATC “4” items are previously ATC “8”, “6” 
or “7” that accumulate the required number of demands within the specified time period 
from the “Level Setting” parameters. Automated review of demand records are 
accomplish by running the “Level Setting” program each month or as directed by the 
Type Commander (TYCOM). During the “Level Setting”, when ATC ‘8’, ‘6’ or ‘7’ items 
accumulated “2” hits (demand frequency) within six months period, these items becomes 
ATC “4”… and will remain ATC “4” as long as the item maintains “1” hit (demand 
frequency) within the next “24” months (Depending on the TYCOM). If the item will not 
experience a hit within the next 24 months, the item will turn into ATC “6” (if the EMV of 
the item is equal to or greater than the “Economic Retention Value (ERV)” set on the 
Level Setting parameters (currently $100.00) or ATC “7” (if the EMV of the item is less 
than the ERV ($100.00). For ATC “8” that did not experience any additional hit within the 
“Level Setting” base period (normally 24 months), the item will be deleted from the 
“stock_item” table and becomes inactive NIIN on the item table. 
 
Reversing Demand Data 
 
Reversing an erroneous demand data will prevent an item from becoming Demand 
Based Item (ATC 4). What constitute erroneous demand record? Erroneous demand is 
recorded when a requested item is supposed to be a non-recurring demand. However, 
when the request was processed, the demand code was not changed to “N”. 
(Remember, the default demand code is equal to “R”.) Seasonal items (such as: 
Christmas Lights, etc.) are good examples of these type items. Always set the demand 
code to “N” when requesting seasonal items to prevent the demand data recorded into 
the demand table. If it happens that you were not able to change the demand code to 
“N”, you can always reverse the erroneous demand data. 
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Procedures: 
 
To reverse demand data, follow the steps listed below: 
 
Step #1: LOGON to R-Supply and GoTo: Inv>Stock Item>Demand Reversal. 
 
Step #2: Type-in the NIIN of the item and click the “OK” button. Demand data from 

demand table will be displayed. Also, you notice that the upper portion of 
the screen is the demand data elements darken out. (Pay special attention 
to “Frequency” and “Quantity” data field.) On the lower portion of the 
screen is the “Selection” area where all demand records are displayed. 

 
Step #3: Select and double click on the demand record that needs to be reversed. 

You notice that the “Frequency” and “Quantity” data element at the upper 
portion of the screen becomes active and the number of frequency and 
quantity are displayed on their respective spaces or data fields.  

 
Step #4: Enter the number of frequency and quantity to be reversed on the 

“Frequency” and “Quantity” data fields. If all demands for the month are to 
be reversed, do not change the frequency and quantity data. 

 
Step #5: Click “Apply” icon to reverse the demand data. You notice the reversed 

frequency and quantity are displayed under “Credit Freq” and “Credit Qty” 
columns. Also, you notice that the “Debit Freq” and “Debit Qty” was not 
decremented. Don’t worry, this is normal. “Level Setting” program will 
perform the computation. The number of frequencies and quantities on the 
“Credit” columns will be decremented from the “Debit” columns during the 
actual Level Setting Batch Job run. If the quantities on the “Debit” columns 
equal to the “Credit” columns for the month, this means all demands for 
the month were reversed. 

 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to process DLR Transactions (from start to finish) …  
 
Background Knowledge: 
 
DLR (Depot Level Repairable) is probably one of the most important processes in R-
Supply. Everyone involved in the process must pay very close attention to what is the 
next step of the process from start to finish. Every step of the process is considered 
critical towards achieving a perfect DLR records keeping. Having charges for Carcass in 
SFOEDL is a signed of bad record keeping. The Activity’s goal should be zero Carcass 
charges and 100% accounting of their NRFI DLR Components. The Activity must adhere 
to the policy of one-for-one as far as issuing or requisitioning DLR. No NRFI available 
during issue means no RFI issue to the customer unless the repairable item is a valid 
RIP (Remain-In-Place).  
 
The person tasked with DLR management must pay very close attention to the step-by-
step procedures listed below.  
 
Procedures: 
 
To achieve a perfect DLR records keeping, follow the steps listed below: 
 

Note: The procedures listed below start just prior to posting DLR issues or preparation of 
requisition for submission to Supply source. 

 
Step #1: Requirement Verification. Before you process the issue or process the 

requisition, make sure to verify the Advice Code. If the Advice Code is 
‘5G’, the customer must have the NRFI Component ready for turn-in (one-
for-one). If the Advice Code is ‘5S’, validate the requirement to ensure the 
item is listed on the current Component Remain-in-Place Listing or 
database. These items (remain-in-place items) are properly identified in 
your system COSAL. No issue should be made until verification is 
completed. 

 
Step #2: After verification and the requirement is found to be valid, post the issue or 

if the item is not available for issue, prepare the requisition for submission 
to Supply source. 

 
   Notes below applies only to End-Use Activity Viking Release 

without P1 upgrade. If you are NWCF Activity, proceed to Step # 3. 
 

Notes: (1) If the item was issued, click ‘No’ to the prompt “Do you 
want to reorder item for stock?” clicking “Yes” will cause 
problems during processing of NRFI Turn-in. This process will 
continue until the problem is fixed. Fix will be included next software 
update. At that point, you may click “Yes” to the prompt to reorder stock 
replenishment and turn-in can be processed under stock replenishment 
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document (End-Use Activity Only). Select “Continue without turn-
in” radio button and click “OK” button to continue. 

 
 (2) End-Use Activity: For consistency, NRFI will be turned-in 

under the ‘Stock Replenishment’ document or requisition 
document if not issued from stock. 

 
 (3) If the item was issued, generate a replenishment 

document using “Initiate Requisition” option. The 
replenishment document number should be used as “Turn-in” 
document (See Steps #4 and #5). Do not select ‘Post-post’ 
checkbox. Let R-Supply assigned the replenishment 
document. This document should reside in “Outgoing 
Transaction Release – Requisition” for release to the supply 
system. Requisition must be release to complete the process. 

 
(4) For End-Use Activity: When processing NRFI Turn-in, the 
issue document should be processed with Response Code of 
“B” and the “Stock Replenishment Document (see note (3) 
above)” should be used as the “Turned-in” document.  
 
(5) If the request was NIS and the Requisition was passed to 
the supply system, the NRFI Turn-in document should be the 
original requisition document number. 

  
Step # 3: Perform repairable query: GoTo: Qry>Requisition>Repairable.  Enter the 

target document and click the “OK” button to continue. The document you 
issued or passed as DTO should be displayed on the output query screen 
with X31 record (if issued) or A0A record (if passed as DTO). If the 
document is displayed, you are ready to perform Step #4.  

 
Step #4: LOGON to eRMS on the internet to process the NRFI Turn-in and make 

sure to print the BC2 to be attached to the NRFI component for turn-in to 
the hub or DLR Agent. 

 
Step #5: Process the NRFI Turn-in into R-Supply: Make sure the turn-in NSN 

reflects the correct NSN of the NRFI Component. Normally, NSN is the 
same as the issued NSN. Additionally, you need the CAGE and Ref 
Number or Part Number to process the turn-in document. 

 
Substep 5a: GoTo: Log>Carcass Tracking. ‘Carcass Tracking – 

Search’ window will display. 
 

Substep 5b: Select “Carcass Turn-in” option from the dropdown 
menu, then select the ‘Process Carcass Turn-in’ 

 
Sheet 2 of  4 

 
Prepared by: Lonnie Auza – SPAWAR Norfolk 

http://www.force-rsupplyViking.com or www.force-rsupply.com  
63



DRAFT 

radio button. Documents requiring turn-in (the issue 
document number) should be displayed. 

 
Substep 5c: Select the Document to be processed… then click 

“OK” button. Carcass Turn-in tab should be displayed. 
 

Substep 5d: Click on the Response Code dropdown menu and 
select ‘B’ – turn-in document is other than the issue 
document. Turn-in document data field should be 
displayed. Enter the ‘Stock Replenishment’ document 
number (see Note (3) of Step #2). 

 
Substep 5e: Select Condition Code “F”. 

 
Substep 5f: Enter the CAGE, Ref Number (P/N) and Component 

Serial Number.  
 

Substep 5g: Click “Apply” icon on the icon toolbar. An alert prompt 
‘Do you wish to create a 1349-1A at this time?’ Click 
“Yes” button to create the BC1 document. “IRRD” 
screen should be displayed. Complete the form and 
click “OK” button to print the BC1 document. ‘Carcass 
Tracking – Search’ screen will be redisplayed for the 
next substep. 

 
Note: This document must be attached to the 

NRFI Component and a signed copy 
should be obtained for your record 
(should be signed by the receiving 
personnel where you turned-in the NRFI 
Component) 

 
Substep 5h: Click the dropdown menu and select the ‘Prepare 

Shipment’ option. Select “ATAC Direct Delivery” 
radio button to display the subset radio buttons. Select 
“Process Shipment” radio button. “ATAC Direct 
Delivery” window will be displayed. The document 
currently in process should be displayed on the left-
hand display window. 

 
Substep 5i: Select the document number and click ‘Add’ button or 

simply double click the document number and it should 
moved to the right-hand display window. 
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Substep 5j: Click “OK” button to get back to the “Carcass Tracking 
– Search” window with only the ‘Process Shipment’ 
radio button selected. 

 
Substep 5k: Click “OK” button to display the ‘Carcass Shipment’ 

tab. Complete the form. 
 

Substep 5l: Click “Apply” icon to save data. An alert message 
should be displayed informing the user that the 
transaction has processed successfully. 

 
Substep 5m: Click “OK” button on the prompt to get back to the 

‘Carcass Tracking – Search’ window to continue 
processing the next document (if applicable) or you 
may click “Cancel” button to get back to the R-
Supply main menu.. 

 
Step #5: Perform repairable query: GoTo: Qry>Requisition>Repairable. The query 

output should consist of three tabs: ‘Carcass Status’ tab should consist of 
X22, DTI, BC1 and D6R transactions. ‘Carcass Turn-in’ tab should display 
the turn-in data and ‘Carcass Shipment’ tab should display the shipment 
data. 

 
        Notes: (1) Turn-in information is sent to NAVICP through eRMS 

transmission. If you are on the Submarine, this process is performed 
by the supporting NSSC or TRF Activity. 

 
 (2) Batch Job JSS294 (Carcass Shipment Download) is run 

only upon TYCOM or DLR Agent request for reconciliations 
purposes. 

 
Step #6: Physical Turn-in of NRFI Component to DLR Agent or for Submarine 

Activity, to the supporting NSSC or TRF Activity. Make sure to attach the 
signed BC1 or BC2 document to the NRFI component for shipment or 
delivery to the turn-in site. Make sure the Supply Officer or his/her 
designate signed the BC1/BC2 document before attaching it to the NRFI 
Component. Ensure to obtain a signed copy of the BC1 or BC2 document 
for your file/record (This is very important- it’s your OPTAR money in 
jeopardy). For Surface ships, make sure to attach the BC2 document 
(produce from eRMS process) to the NRFI component. 

 
Step #7: File the signed BC1/BC2 document in a safe location. You might need to 

back track this NRFI DLR document someday. This file is maintained for 
three Fiscal Years. 

 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to process “DRF/DRB” supply status …  
 
Background Knowledge: 
 
What is DRF & DRB? DRF (Follow-up to Material Shipment) is an incoming supply 
status received from supply source due to non-receipt of Material Receipt 
Acknowledgement (DRA) document from the customer. DRB is the response to DRF. 
 
Why are you (the Activity/Customer) receiving DRF? The most common reason why you 
received DRF is entering erroneous Routing Identifier (RI) on the receipt document 
during receipt processing. R-Supply will automatically create DRA (Receipt 
Acknowledgement) each time you process material receipt into R-Supply receipt function 
and post into “rqn_status_out” table. DRA is an outgoing supply status as 
acknowledgement to receipt of material shipment. DRB is automatically created when 
DRF is processed either interactively or during incoming supply status batch processing 
when receipt sub-record is present. It is released to the intended recipient in a daily 
basis through “Release Outgoing Transactions” function (JSL319 Batch Job). DRA/DRB 
document is a way of telling the supply source (where you received the material from) 
that you received the shipment.  
 
It is critical that the receiving Activity processed the material receipt properly paying 
special attention to the Routing Identifier (RI) where the material was received. If 
creating dummy receipt, make sure to perform research to obtain the correct Routing 
Identifier of the supply source that shipped the material. Otherwise, if you put an 
erroneous RI on the receipt processing, the DRA will be sent to the wrong supply source 
or may not be submitted at all due to RI is not in the DAAS routing address. Therefore, 
the DRA is undeliverable or delivered to the wrong recipient. The result, you (your 
Activity) will receive a DRF from the supply source asking for confirmation whether you 
(the Activity) received the material shipment.  
 
DRF transactions are normally included in the “Incoming Supply Status (Batch Job 
JSS220)” that is processed in a daily basis. It is highly recommended to process or reply 
DRF inquiries in a daily basis to avoid transactions appearing in Supply Discrepancy 
Report (SDR). 
 
Procedures: 
 
To process DRF, follow the steps listed below: 
 
Step #1: LOGON to R-Supply. GoTo: Log>Status>Supply. Select the “DRF/DRB” 

radio button on the ‘Type’ selection block. All DRF transactions will be 
displayed. 

 
Step #2: “Double click” on the transaction to display the ‘Status Supply’ screen. 

Display is in three sections: Doc Nbr section, Status Entry section, and 
Status Subrecords display from the “rqn_status_in” table.  
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Step #3: Verify and type-in the following information: RI, QTY (if applicable), 

Transaction Date, and select Shipment Discrepancy code on the ‘Status 
Entry’ section. 

 
Note: RI and QTY are critical data for DRB. The information must 

be extracted from the original receipt. 
 
Step #4: Click “Apply” icon to create and save the DRB transaction. 
 

Notes: (1) The following actions occur automatically as a result of 
processing DRF: 

 
• If a receipt is on file that matches the DRF on the 

document number (including suffix code) and quantity, 
but no DRA exists, a DRB is generated, duplicating 
data from the DRF. 

 
• If a DRA is already on file that matches the DRF on 

the document number (including suffix code) and 
quantity, a DRB is generated duplicating data from the 
DRA, except for the routing identifier in CC 4-6 of the 
DRB; the routing identifier on the outgoing DRB is the 
same as the one on the incoming DI DRF. 

 
• If no receipt or DRA is on file, a DRB is generated 

duplicating data from the DRF. In addition, a 
Discrepancy Indicator Code "F" is written in CC 63 of 
the DRB. 

 
• If none of the above conditions exists, the DRF is 

written to the "rqn_status_in" table, and the user will 
have to manually input a DRB. 

 
• If the requisition number is not on file, the DRF is 

suspended with suspense code 02031, if the status 
was input through a batch job (JSS220). 

 
(2) The interactive window will not allow the input of a DRF if 

the requisition is not on file; however, you can input a DI 
DRF against a completed requisition. 

 
Step #5: Release the ‘DRB’. GoTo: Log>Release Outgoing Transaction>Status. 

Select ‘Receipt Acknowledgment (DRA/DRB)’ radio button. 
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Step #6: Click “OK” button. The DRB transactions will be displayed (if the “Review” 
checkbox from the previous screen (Release Status) was selected). 

 
Step #7: Click on the “Red checkmark" icon to select all transactions for release. 
 
Step #8: Click “Apply” icon to submit the Batch Job (JSL319). 
 
Step #9: Approve the Batch Job (Applies only if the “Required Approval” checkbox 

on the Control Parameter Update is selected). 
 
Step #10: Perform “File Transfer” to download the DRB output for transmission to 

supply system. (Note: May not apply when DAAS Interface becomes 
available and activated.) 

 
Step #11: Transmit the DRB transactions via SALTS/DAAS. 
 
 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 

68

mailto:absalon.auza@navy.mil


DRAFT 

 
Sheet 1 of  2 

 
Prepared by: Lonnie Auza – SPAWAR Norfolk 

http://www.force-rsupplyViking.com or www.force-rsupply.com  

How to generate ‘Dynamic Levels’ …  
 
Background Knowledge: 
 
Dynamic Level option is provided to set levels for individual line item. Type Commanders 
no longer required the Activity to run the Global Level Settings program in a monthly 
basis. Each Command or Activity is responsible for monitoring those not carried items to 
make sure items that may qualify to be carried onboard as demand based items are 
migrated to ATC 4 by running the Dynamic Levels program. Dynamic Levels can be run 
anytime without restrictions. 
 
Procedures: 
 
To generate Dynamic Levels, follow the steps listed below: 
 

Note: Display the icon descriptions for easy identification of the displayed icons. To display the 
description, point and right click on any of the displayed icon and select “Show Text”. 

 
Step #1: LOGON to R-Supply and GoTo: Site>Activity Controls>Constants> 

Miscellaneous Values. 
 
Step #2: Click on the Dynamic Levels checkbox to activate the program. 
 
Step #3: Click “Apply” icon on the toolbar to save the change. 
 
Step #4: GoTo: Inv>Stock Item>Maintain Stock Items 
 
Step #5: Enter the target NIIN on the space provided on the Stock Item Search 

window. 
 
Step #6: Click “OK” to continue the process. The information from item and 

stock_item tables is displayed. Verify all data to ensure information are 
correct and valid. 

 
Step #7: Click “Apply” to run the Dynamic Levels program. Information prompt will 

be displayed. Click ‘OK” to continue. 
 
Step #8: Close the screen and verify the status of the item. Check for changes that 

occurred depending on the previous status of the item. Perform item Query 
(Stock Item or Transaction Ledgers) to verify changes. ATC and/or RO 
maybe affected depending on the number of demand and frequency of the 
item. RP is computed RO minus 1. 

 
Step #9: GoTo: Site>Activity Controls>Constants>Miscellaneous Values. 
 
Step #10: Uncheck the Dynamic Level checkbox to deactivate the program. 
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Step #11: Click “Apply” icon on the toolbar to save the change. Make sure ‘Dynamic 
Level Checkbox’ is unchecked or turn-off at all times except during the 
actual process. 

 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to edit ‘User Role Name’ in R-Supply … 
 
Background Knowledge: 
 
What is User Role Name? User Role Name is the name given to a selected function or 
a group of functions the user is/are authorized to access in R-Supply (i.e. receipt 
processing, inventory adjustment, post issue, etc. maybe given a ‘Role Name’ of  
Supply-1). The functions included in the ‘Role Name’ are the only function or functions 
the user should be able to access and perform R-Supply processes. 
 
Editing the “User Role Name” is sometimes necessary to ensure integrity of the R-
Supply database. As FAS, you control the R-Supply users’ access to database tables 
and processes. 
 
Procedures: 
 
To edit ‘User Role Name’, follow the steps listed below: 
 

Note: Display the icon descriptions for easy identification of the displayed icons. To display the 
description, point and right click on any of the displayed icon and select “Show Text”. 

 
Step #1: LOGON to R-Supply and GoTo: Site>Activity Controls>Users Access. 
 
Step #2: Select anyone of the active username  
 
Step #3: Click “OK” button or simply double click the username to display the 

“Users Access” window. 
 
Step #4: Click the “Add User…” icon (Two red arrows in circle form) to display the 

‘Other Menus’ screen. 
 
Step #5: Select the target ‘Role Name’ to be modified or edited. 
 
Step #6: Click the “Modify Role” icon to display the ‘Edit Menu Options’ window. 
 
Step #7: Click ‘Enable Popup Menu’ icon to make changes to existing role name. 

“Popup Menus Enabled” notice should display on top of the screen. 
 
Step #8: Select or deselect the appropriate function or functions to be included or 

excluded in the ‘Role Name’. Selected functions are highlighted with 
‘Blue’ background. 

 
Note: Functions are preceded or indicated with a letter “R”. Click on the 
function to select or deselect (if the function is already selected). 
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Step #9: Click “Apply” icon to save changes to the ‘Role Name’. Close the 
windows then proceed to Step #10. 

 
Step #10: Verify the edited ‘Role Name’ to ensure changes were in effect. Menu 

path: Site>Activity Controls>Users Access… then repeat steps #2 
through #4. Close the windows after verification. 

 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to perform ‘File Transfer’ in R-Supply … 
 
Background Knowledge: 
 
What is ‘File Transfer’ in R-Supply? File Transfer in R-Supply is the process of moving or 
transferring file or files from/to NTCSS Server. Several R-Supply Batch Jobs requires 
input (i.e. Incoming Status for Supply/REQ/LOGREP, ASI Process, Monthly Change 
Notice, etc.). Input data or transactions are uploaded to the NTCSS Server when 
processing incoming Supply Status, LOGREP, or Change Notices, and other Batch Jobs 
that requires input. On the other hand, most R-Supply Batch Jobs produces electronic 
output and/or reports that need to be downloaded from the Server. Output files are 
downloaded from the Server to provide electronic copy of the output to the customer or 
send MILSTRIP data through SALTS/DAAS or attaching electronic copy of the output to 
an email. File Transfer process is almost done in a daily basis for most Activities. Follow 
the step-by-step procedures outlined below to perform ‘File Transfer’ in R-Supply. 
 
Procedures: 
 
To perform File Transfer (Upload or Download), follow the steps listed below: 
 
A. Uploading File to Server… the most common process that File Transfer is 
performed is processing ‘Incoming Status for Supply (Batch Job JSS220)’. For 
demonstration purposes, we will use this process “Incoming Status for 
Supply/Referral/REQ/RQN/LOGREP” Batch Job JSS220. 
 
Step #1: Prepare the Input File. Download supply status from SALTS or from email 

and save it into CD or in the Hard Drive. Make sure to verify or preview the 
format of the transactions to ensure validity of the input. Any invalid format 
or transactions that cannot be verified against the database will be 
suspended. There are many reasons why transactions are suspended. 
(See How to process suspended transactions.) 

 
Step #2: Logon to R-Supply. GoTo: File>Utilities>File Transfer>Batch File Transfer. 

In Batch File Transfer window, select ‘Transfer to Server’ radio button 
(default selection).  

 
  Note: You will see a checkbox ‘Append to existing file’ underneath 

the Transfer to Server radio button. This option is used when 
uploading additional transactions into an existing process 
input file… meaning that you have uploaded an input file for the 
process, however, you have not ran or started the Batch Job (in 
this case, JSS220). Two hours passed, you downloaded 
additional incoming supply status from SALTS and you want 
the additional incoming supply status included in the Batch 
Job JSS220. In this situation, upload the additional incoming 
supply status transactions to the same process (JSS220) by 
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activating or selecting the ‘Append to existing file’ checkbox. 
The additional inputs will be appended or added to the 
previous transactions that have been previously uploaded to 
process JSS220.  

 
If you did not activate the ‘Append to existing file’ checkbox, 
the previous transactions that were uploaded earlier will be 
overwritten and lost forever. So, be careful and mindful of 
what you are doing. 

 
Step #3: Click the ‘Process’ dropdown menu and select the process (In this case, 

JSS220). 
 
Step #4: Enter the path and filename of the source file (File to be uploaded) on the 

‘File Name’ data field or Click the ‘Browse’ button to look for the location of 
the source file (i.e. Drive E, then select the file). Select the Drive and 
filename of the file.  

 
Step #5: Click ‘Open’ button to continue. (Notice the data on the “Transfer to 

Server” block?). On the ‘Process’ data field, the name of the Process 
appears (In this case, ‘Incoming Status for Supply/Referral/…) and the 
filename of your source file on the ‘File Name’ data field. 

 
Step #6: Click ‘Apply’ icon on the icon toolbar to start the process of ‘File Transfer’. 

In a few seconds, you will see an ‘Alert’ window to display the alert 
message saying ‘File Transfer, Completed Successfully /h/data/local/SUP1BT/ 
tape_in/JSS220 created’. Click the ‘OK’ button to continue. At this point, the 
‘file’ has been uploaded for processing. 

 
Step #7: Close the ‘Batch File Transfer’ window. 
 
Step #8: Verify the input file. It is highly recommended to check your input 

transactions to ensure all transactions have been uploaded for input to the 
selected process (Batch Job). You should count the number of input from 
the source file and compare that count to the uploaded file. To check your 
input, GoTo: File>Utilities>Batch Review then Select ‘Input Files’ radio 
button. The ‘Select Server File’ pop-up window displays the available batch 
process. Select the batch process or file and click ‘OK’ button or simply 
double click the file or process to display the input transactions. Count the 
number of transactions and compare this to the count from your source file. 
The count should match… if not, you may repeat the ‘File Transfer’ from 
start to finish. It will not hurt by doing so. For some reason, sometimes the 
program will drop some of your transactions during the file transfer 
process.  
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Step #9: Close the input file display. Click ‘Cancel’ button to close the window 
and proceed to start the Batch Job whatever process you are currently 
doing.  

 
Step #10: Submit the target Batch Job (in this example, JSS220). Most of the R-

Supply Batch Jobs that requires input are started from the “Predefined 
Parameters” located at: Site>Management>Site Internal>Batch Job 
Scheduling> Predefined Parameters. (See “How to submit and approve Batch 
Jobs SOP...) 

 
 
B. Downloading File from Server… the most common process that you must perform 
download file from the Server is processing ‘Release Outgoing Transactions’ (i.e. 
Requisitions, Outgoing Status, DLR Tracking Responses, DRA/DRB, MFCS/TIR, etc.). 
For demonstration purposes, we will use ‘Requisitions’ download (Batch Job JSL319). 
After completion of “Requisition Release (Batch Job JSL319)”, an electronic copy of the 
Requisitions (A0A) were created and written in directory: /h/data/local/SUP1BT/tape_out. 
The file must be downloaded for submission to Supply system via SALTS or some other 
available means of transmission to supply source.  
 
To perform file download, follow the steps listed below: 
 
Step #1: Logon to R-Supply. GoTo: File>Utilities>File Transfer>Batch File Transfer. 

Select ‘Receive From Server’ radio button.  
 

  Note: You will see four checkboxes underneath the ‘Received 
From Server’ option. They are: ‘MFCS Download’, ‘Stars 
Download’, ‘SWMS’ and ‘Archive Purge’. The MFCS 
Download checkbox will be activated if you are downloading 
the daily MFCS TIR Report (Applies only to NWCF Activities). 
Stars Download checkbox is activated if you are 
downloading your weekly Transmittal (Obligations) to DFAS. 
SWMS checkbox (Applicable to T-AKE type ship only) will be 
activated if you are downloading the output from the 
“Outgoing SWMS (Batch Job JSS320). Archive/Purge 
checkbox will be activated if you are downloading archive or 
purging files. 

 
Step #2: Select ‘File’ radio button (default). 
 
Step #3: Type-in the Batch Job Number (In this case, JSL319-XXXX-XXX), the 

Batch Job Number that created the file. 
 
Step #4: Select the Drive radio button where you want to ‘save’ the file. Default is C: 

Drive at the ‘xfer’ folder. 
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Step #5: Click ‘Apply’ icon to start the download process. An ‘Alert’ pop-up window 
will display the message saying “File Transfer, Completed Successfully …” 
click “OK” to close the alert window. At this point, the file is written to the 
default folder.  

 
Step #6: Close the ‘Batch File Transfer’ window. 
 
Step #7: Verify the transactions on the file. It is highly recommended to verify the 

output and compare it to the downloaded file. The downloaded file is 
located at the following menu path: Start>My Computer>Local Disk ( C:)> 
Program Files>ntcss>sup1cl> data>xfer… then select the file. Compare 
the content of the file to the output from the directory: /h/data/local/ 
SUP1BT/tape_out, GoTo: File>Utilities>Batch Review and Select ‘Output 
Files’ radio button. Select the Batch Job Number and Click ‘OK’ button or 
simply double click the Batch Job to display the data. Count the 
transactions and compare this count to the downloaded transactions. It 
should match. If not, repeat the download process. 

 
Step #8: Review and Clean up the downloaded file (if applicable). If you save 

the file to a Diskette, the Batch Job number is written on the first line. Also, 
at the end of the file you may find some strange data. You must remove 
these entries before transmitting or sending the transactions through 
SALTS or other means of transmission to supply source. 

 
Step #9: Transmit data. It is highly recommended to monitor the return copy of the 

transmitted message to ensure the message was actually transmitted out 
of the Ship or Activity. 

 
 
If you are connected to the internet, click here and follow the menu path for sample 
demonstration. 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to generate Financial Reports (Daily, Monthly, or Yearly) …  
 
Background Knowledge: 
 
Financial reports are dollar value summaries of all transactions that affect the Ship’s or 
Activity’s OPTAR and other financial ledgers. It is the results of generating Batch Jobs 
JSF403 (Trial) or JSF404 (Live). It is highly recommended to run ‘Trial’ Financial update 
prior to running ‘Live’ to verify the totals and financial transactions are valid and correct. 
Any erroneous transactions must be corrected prior to running the ‘Live’ financial update. 
There are three options available when running financials: Daily, Monthly or Yearly. Daily 
option is selected when running the scheduled transmittal (Every 8th day). Monthly is 
selected when running the monthly financial closeout. Yearly is selected when running 
end-of-the-month financial in September. Selecting ‘Yearly’ option will produce the 
monthly reports for September and closeout the Fiscal Year.  
 
Procedures: 
 
To generate the financial reports from start to finish, follow the steps listed below: 
 

Note: Display the icon descriptions for easy identification of the displayed icons. To display the 
description, point and right click on any of the displayed icon and select “Show Text”. 

 
Step #1: Preparation. Process all suspended transactions that will impact your 

financial reports (i.e. MRI transactions, incoming supply status (DTO) with 
status code of ‘BQ’, ‘CJ’ or any supply status code that cancel or terminate 
the requisition, etc.) (Menu path: Log>Suspense… then select the function or 
suspense category). Release all outgoing requisitions (Menu path: Log> 
Release Outgoing Transactions>Requisitions). Process the current 
SFOEDL prior to running the end-of-the-month Financial. 

 
Step #2: Run ‘Trial’ Financial (Batch Job JSF403). It is highly recommended to run 

‘Trial’ option to ensure all financial reports are OK prior to running the 
‘Live’. ‘Trial’ radio button is selected by default. (Menu path: Fin> 
Management>Financial Actions>Financial Update … then select the 
required parameters, submit and approve the Batch Job. 

 
Step #3: Verify all report totals from the trial output (Step #2). Check points are: 

BOR TOTALS, TRANSMITTAL NUMBER, SUMMARY OF OBLIGATIONS 
BY FUND CODE, STARS-FL OBLIGATION TRANSACTIONS (ZOA/XOA), 
FUND CODE TOTALS, TOTAL OPTAR GRANTS FYTD, etc. 

 
Step #4: Run the ‘Live’ Financial (Batch Job JSF404). Menu path: Fin> 

Management>Financial Actions>Financial Update. Select ‘Live’ radio 
button, click ‘Yes’ on the “Live Financial Update Message” prompt. Select 
the appropriate Type option (Daily, Monthly or Yearly) parameters. Select 
‘Daily’ if running the scheduled TLs. Select ‘Monthly’ for end-of-the-month 
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closeout. Select ‘Yearly’ for the end of the Fiscal Year closeout (30 Sep). 
Select the appropriate reports. Verify all selected parameters… then Click 
the ‘Apply’ button to submit the Batch Job Request. Click ‘OK’ on the 
Batch Request Confirmation window. 

 
Step #5: Approve the Batch Job. Menu path: Site>Management>Site Internal>Batch 

Job Scheduling>Approval. Batch Job JSF404 should be listed on the 
‘Approval’ window. Select the Batch Job and click the ‘Key’ icon on the 
icon menu bar and verify all control parameter indicators. Make sure all 
appropriate indicators are set. 

 
Step #6: Verify the output (Both hard copy and electronic). For electronic copy: 

Menu path: File>Utilities>Batch Review… then select ‘Output Files’ radio 
button. The Batch Job Number should be displayed with extensions ‘VM’, 
VR’ and ‘VT’. The output totals should be identical to the ‘Trial’ output (see 
Step #3) unless new transactions were added after the ‘Trial’ run. At the 
same time, STARS (Standard Tracking and Reconciliation System) output 
was also created for submission to DFAS Norfolk. STARS output must be 
downloaded as part of your TL submission (see Step #8). 

 
Step #7: Submit monthly BOR report by extracting information from the hard copy 

output.  
 
Step #8: Download the STARS output for submission to DFAS Norfolk. Menu path: 

File>Utilities>File Transfer>Batch File Transfer. Select ‘Receive From 
Server’ radio button. Select ‘STARS Download’ checkbox. Select ‘STARS 
Data Available for Transfer’ dropdown menu. Select the appropriate 
output (Date)… then select the destination drive or folder radio button. (It is 
highly recommended to select ‘Transfer to Hard Drive’ radio button. When 
this option is selected, the output can be viewed at the file xfer folder 
(Menu path: Start>My Computer>C Drive>Program Files>ntcss>sup1cl> 
data>xfer then select the downloaded file. 

 
Step #9: The Commanding Officer must sign the reports before submission to DFAS 

and filing for your records. Hard copies are normally kept and maintained 
on file for three Fiscal Years. 

 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to grant ‘Access to R-Supply Users’… 
 
Background Knowledge: 
 
Understanding the access control within NTCSS environment: There are up to four 
components within NTCSS depending on type Ship/Activity. These components are: 
R-Supply, NALCOMIS, RADM and OMMS NG. CVN, LHA and LHD type ships are 
configured to have all the components installed and all except NALCOMIS are also 
available in all other type ships except USNS (Supply type Ships). Supply Ships is 
configured with R-Supply only. If you look at security access control, you may relate 
this to a secured compound with four buildings inside the perimeter and every 
building has its own security access control in addition to the main control at the 
NTCSS access. NTCSS is the secured compound and the four buildings (R-Supply, 
NALCOMIS, RADM and OMMS NG) have its own access control. All components 
are controlled by an individual who grant permission or access to that component. 
NTCSS is controlled by Systems Administrator (SA), R-Supply is controlled by R-
Supply Functional Area Supervisor (RSUPPLY FAS), OMMS NG is controlled by 
the 3M Coordinator, RADM is controlled by RADM FAS and NALCOMIS (Supply 
Applications) is controlled by NALCOMIS Supply Application Administrator (SAA) 
and the operation of NALCOMIS Applications is controlled by the NALCOMIS 
Database Administrator (DBA). 
 
Every R-Supply Users must be properly identified and granted specific access to a 
specific role or function within R-Supply applications. 
 
Procedures: 
 
To grant access to a prospective R-Supply User, follow the steps listed below: 
 

Note: Display the icon descriptions for easy identification of the displayed icons. To display 
the description, point and right click on any of the displayed icon and select “Show 
Text”. 

 
Step #1: The prospective R-Supply User must be registered in NTCSS by the 

NTCSS System Administrator. A registration form should be available 
from the NTCSS System Administrator (SA). The prospective user 
should fill out the form properly and submit the completed form to the 
System Administrator as the basis for granting system access. The 
completed form should be retained by the SA for the record. 

 
Step #2: The NTCSS registered R-Supply User can now be granted access to 

R-Supply function or functions by the Functional Area Supervisor 
(FAS). FAS should have a local form for control. The prospective User 
should fill out and complete the form for the record. FAS should retain 
the completed form until the R-Supply User is replaced or checked-out 
from the Command/Activity. 
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Sub-Step #2a. The FAS will LOGON to R-Supply and GoTo: Site> 
Activity Control>Users Access. Select the name of the registered R-
Supply User… then click ‘OK’ or simply double click on the username 
to open the ‘Users Access’ window. 
 
Sub-Step #2b. Fill out the data field with the following data: 
 

Prime Dept/Div/WC: Select the Dept., Div., or WC of the 
User whom you are granting access 
to R-Supply Applications.  

 
Note: If the User you are granting 
access to R-Supply is authorized to 
submit material request, you should 
use the Division for this block (i.e. 
CA for CA Division, CE for CE 
Division, etc.) since the Division 
code (CA, CE, etc.) is used as the 
first two digits of the Document 
Serial Number Ranges.  

 
Prime Job:  Select the prime job of the 

prospective User. (For Supply 
Personnel, Select ‘Supply User’ or 
WC Sup, etc.) 

 
Approval Money Value:  Indicate the money value limit 

that this User can submit material 
request. This value should be 
determined by and coming from the 
Department or Division Supervisors. 
If the money value assigned is 
$100.00, the User can submit 
material request with extended 
money value (EMV) of up to that 
amount. If the extended money value 
of the material request is above this 
amount, the transaction will be 
suspended for approval. 

 
  UIC:    Enter the Ship’s or Activity’s UIC 
 

IRC Override Type:  Select as appropriate (None should 
be selected for the regular R-Supply 
users. Option “All” should not be 
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assigned to any User except FAS or 
Assistant FAS. 

 
Authorized:  Should be blank for all R-Supply 

users. Stock Control and FAS 
checkboxes should be selected for 
FAS, Assistant FAS, Stock Control 
Officer or Supervisor only. Non-
Maintenance Customer checkbox 
should not be selected. This 
checkbox is for NAS R-Supply only. 

 
Authorized Stores Type: ‘General Stores’ option is 

default and granted to all users. Both 
‘Restricted’ and ‘General Stores’ 
should be granted to “QCOSAL” 
User. Both options should also be 
granted to FAS, Assistant FAS, 
Stock Control Officer or Supervisor. 

 
Step #3: Click “Apply” icon to save the data. Once the data were saved, it 

should default to ‘Other Menus’ window where you (FAS) select the 
role name of the User.  

 
Step #4: Select the ‘Role Name’ of the user. Double click or drag and drop or 

select and click the ‘Add’ button to select the role name. The ‘Role 
Name’ should move to the ‘User Role Name’ display box. (‘Role Name’ 
consists of the specific R-Supply Functions the User can access within 
the R-Supply Application.) If the job of the User is “Receipt” 
processing, only receipt processing function should be included in the 
‘Role Name’. R-Supply functions can be added or deleted from the 
‘Role Name’ at anytime. To create “Role Name”, refer to: How to 
create ‘Role Name’ document. 

 
Step #5: Click ‘Apply’ icon to save the role name of the User.  
 

Note: The screen will not go back to the ‘Users Access’ window or 
change to other window. However, it will indicate at the bottom left 
corner of the screen that the changes or data entered have been 
saved when you click ‘Apply’ icon. To exit, close the “Other Menus” 
and “Users Access” windows. 

 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to process ‘Incoming Supply Status’ in R-Supply (Batch Process)… 
 
Background Knowledge: 
 
Incoming Supply Status is probably one of the critical supply processes performed at 
least once or twice daily for some Activities (i.e. CVN, LHA, LHD, etc.). Supply status is 
provided to customers based on the M&S Code indicated on the original MILSTRIP 
Requisition. Logistic Specialists must understand the importance of the latest supply 
status for all maintenance and stock requirements… therefore must be processed in a 
daily bases. When supply statuses for maintenance requirements were successfully 
posted in R-Supply database, it is also reflected in the corresponding maintenance 
requirement record in OMMS-NG database. This concept provides the maintenance 
personnel with up-to-the-minute supply status of maintenance requirements without 
going to R-Supply database for the latest supply status. 
 
Below are the step-by-step procedures how to process ‘Incoming Supply Status’ in batch 
process mode. 
 
Procedures: 
 
To batch process incoming supply statuses into R-Supply, follow the steps listed below: 
 
Step #1: Prepare the Input File. Download the incoming supply status from SALTS 

or from email or from any other source. Preferably, save the file in ‘C’ 
Drive. Make sure to verify or preview the format of the transactions to 
ensure validity of the input. 

 
Step #2: Logon to R-Supply. GoTo: File>Utilities>File Transfer>Batch File Transfer. 

In Batch File Transfer window, select ‘Transfer to Server (Default)’ radio 
button.  

 
  Note: There is a checkbox ‘Append to existing file’ underneath the Transfer to 

Server radio button. This option is used when uploading additional 
transactions into an existing process input file… meaning that you have 
uploaded an input file for the process (JSS220), however, you have not 
ran or started the Batch Job (in this case, JSS220). Two hours passed, 
you downloaded additional supply status from SALTS and you want the 
additional incoming supply status included in the Batch Job JSS220. In 
this situation, upload the additional transactions to the same process 
(JSS220) by activating or selecting the ‘Append to existing file’ checkbox. 
The additional inputs will be appended to the previous transactions that 
have been previously uploaded to process JSS220.  

 
If the ‘Append to existing file’ checkbox was not selected, the previous 
transactions that were uploaded earlier will be overwritten and lost 
forever. So, be careful and mindful of what you are doing. Make sure to 
check and verify the previous transactions on the file and the added 
transactions to ensure accuracy (See note on Step #7). 
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Step #3: Click the ‘Process’ dropdown menu and select the process (In this case, 
JSS220). 

 
Step #4: Enter the path and filename of the source file (File to be uploaded) on the 

‘File Name’ data field or Click the ‘Browse’ button to look for the location of 
the source file (i.e. Drive C, then select the file). Select the Drive and 
filename of the source file.  

 
Step #5: Click ‘Open’ button to continue. (Notice the data on the “Transfer to 

Server” block). On the ‘Process’ data field, the name of the Process 
appears (In this case, ‘Incoming Status for Supply/Referral/…) and the 
filename of your source file on the ‘File Name’ data field. 

 
Step #6: Click ‘Apply’ icon on the toolbar to start the ‘File Transfer’ process. In a 

few seconds, you will see an ‘Alert’ window to display the alert message 
saying ‘File Transfer, Completed Successfully /h/data/local/SUP1BT/tape_in/JSS220 
created’. Click the ‘OK’ button to close the alert window. 

 
Step #7: Close the ‘Batch File Transfer’ window. At this point, the input 

transactions were written at the ‘Input’ queue directory: /h/data/local/SUP1BT 
/tape_in. 

 
  Note: It is highly recommended to check your input transactions to ensure all 

transactions have been uploaded for input to the selected process (Batch 
Job JSS220). You should count the number of input from the source file 
and compare that count to the uploaded file. To check your input, GoTo: 
File>Utilities>Batch Review then Select ‘Input Files’ radio button. The 
‘Select Server File’ pop-up window displays the available batch process. 
Select the batch process or file and click ‘OK’ button or simply double 
click the file or process to display the input transactions. Count the 
number of transactions and compare this to the count from your source 
file. The count should match… if not, you may repeat the ‘File Transfer’ 
from start to finish. It will not hurt by doing so. For some reason, the 
program drops some of your transactions during the file transfer process. 
Click ‘Cancel’ button to close the display screen and proceed to submit 
the Batch Job JSS220. 

   
Step #8: Submit the Batch Job JSS220. GoTo: Site>Management>Site Internal> 

Batch Job Scheduling> Predefined Parameters. Select Batch Job JSS220 
then click ‘Apply’ icon to submit the Batch Job. ‘Batch Request 
Confirmation’ window is displayed with the given Batch Job Number. Click 
‘OK’ button to confirm the submission of the Batch Job. 

 
Step #9: Verify the ‘Control Parameter Indicators’ to make sure correct indicators 

were set for this Batch Job. To verify: GoTo: Site>Management>Site 
Internal> Batch Job Scheduling>Approval. Select the target Batch Job and 
Click the ‘Key’ icon to display the Control Parameter Update screen. 
Indicators that must remain set are: ‘Approval Required’, ‘Print Output’, 
‘Saved Printed Output’, and ‘Default Printer’ (If default printer is set up). If 
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changes were made to the selected indicators, you must click ‘Apply’ icon 
to ‘Save’ the changes in indicator settings. 

 
Step #10: Approve the Batch Job (JSS220). Enter or type-in ‘R’ on the ‘Status’ field 

then Click ‘Apply’ icon to release the Batch Job to NTCSS for processing. 
At this point, an alert window will display if the ‘Default Printer’ indicator 
was not checked and you require a printed output, you are required to 
select a printer where you want your output printed. If the ‘Default Printer’ 
indicator is not checked and you do not require printed output, this alert 
window will not display. 

 
Step #11: Verify the status of the Batch Job to ensure it is running and/or completed 

the Batch Job successfully. GoTo: NTCSS TOOLBAR>System (Three 
cascading window icon)>Batch Job Queue. Select ‘Batch Job Manager’ tab 
(default). On the ‘Select Application’ dropdown, select RSUPPLY… then 
select ‘Approved’ radio button to display the active Batch Jobs that are 
currently running. Batch Job JSS220 should be displayed. If not, select 
‘Completed’ radio button. Batch Job JSS220 should be displayed and will 
indicate ‘Normal Exit’. If it indicates ‘Crashed/Aborted…’, you have to re-
run the Batch Job JSS220 by repeating Steps #1 through #10. 

 
Step #12: Random status check. To ensure the process was ran and successfully 

completed, randomly check a status documents from the input file and 
check if the status has been posted to the corresponding documents by 
performing ‘Requisition Query’. If not posted, check the suspended 
transaction or error listing from the process output… then continue to find a 
document where the status input has been successfully posted against the 
target document. 

 
Step #13: Review the hard copy output. Reports are self-explanatory. Make sure the 

matrix status (Miscellaneous Records Processing Statistics) indicated the correct 
number of transactions processed. Review all listing categories of the 
output. Review ‘Referral’ transactions (if present)… take action 
accordingly. Look for error or rejected transactions. 

 
Step #14: Print suspended transactions for incoming supply status for review. To print 

suspended transactions for incoming supply status: GoTo: 
Log>Management>Logistics Reports>Suspense Listing. Select ‘Status 
(Supply)’ checkbox… select a ‘Sort by’ option you preferred, and select 
‘Apply’ icon to display the Batch Job request screen. Complete the 
required parameters… submit and approve the Batch Job. 

 
Step #15: Review and/or process ‘Suspended’ transactions. There will be several 

transactions that will end up in suspense table. These transactions must be 
cleared prior to processing another JSS220. Transactions can be 
suspended due to various reasons and the reason for suspension is 

 
Sheet 3 of  4 

 
Prepared by: Lonnie Auza – SPAWAR Norfolk  

http://www.force-rsupplyViking.com or www.force-rsupply.com  
84



DRAFT 

 
Sheet 4 of  4 

 
Prepared by: Lonnie Auza – SPAWAR Norfolk  

http://www.force-rsupplyViking.com or www.force-rsupply.com  

indicated in every suspended transaction. To process suspended status 
transaction: GoTo: Log>Suspense… then select ‘Supply (Status)’ on the 
Function dropdown menu to display the suspended transactions. Select a 
document or item to process. Each transaction must be researched and 
process accordingly. 

 
Step #16: Check the ‘Stock Control Review Listing’ the next day to review all 

requisitions that received rejections or cancellations status (if any). 
 
 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to process ‘Inventory Adjustments’ (spot or predetermined) … 
 
Background Knowledge: 
 
Inventory adjustment is a process of realigning between the actual on-hand quantity in 
storeroom location and the on-hand quantity stated or posted in stock record 
(stock_item table) or item_loc table. However, inventory adjustment programs should 
not be used for convenience just because you (the Stock Control Supervisor) want to 
realign the current actual on-hand quantity vs. on-hand quantity on the stock record. 
Exhaustive researched must be conducted to find the possible cause of unmatched 
inventory. Use every means possible to realign the inventory without using the inventory 
adjustments functions. If you are missing actual quantity on-hand, somehow it has been 
issued or misplaced in some other locations. Perform location audit (LAP). Audit trail 
your issues and receipts to ensure quantities are accounted for. 
 
 There are several instances that cause the actual on-hand quantity not matching with 
the posted on-hand quantity on the stock record. The most common cause of mismatch 
inventory is attributed to receipt processing and misplaced material. Another situation 
that may cause unmatched inventory is issuing material without processing or posting 
the issue document or just handing it out to the customer without paperwork. Erroneous 
processing procedures mention above must be corrected to make sure all quantities are 
accounted for prior to processing inventory adjustment using the below procedures. 
 
Inventory adjustments can be accomplished in two functions in R-Supply: (1) Inventory 
Posting and (2) Inventory Adjustments.  Both functions can be used to accomplish the 
same results however, the user must be very careful of what is to be accomplished to 
produce the correct end-result using either one of the R-Supply inventory adjustment 
functions. Read the situations below to properly use the correct inventory adjustments 
function. 
 
Procedures: 
 
Situation #1: Total on-hand quantity on the stock record matches with the actual total 

on-hand quantity. However, quantities in multiple locations not matching 
(i.e. Location-1 has 5EA on the stock record but 7EA in actual location, Location-2 has 
10EA on the stock record but 8EA on the actual location. The total on-hand quantity for 
the item is 15EA.) As you notice, the actual on-hand quantity of the item 
matches with the total on-hand quantity on the stock record. However, 
actual quantities in locations are not matching up. 

 
To correct the discrepancies, the user must use the “Inventory Posting” function. The 
process will not result any inventory adjustments. It will only move/adjust quantities in the 
locations involved. 
 
Step #1: LOGON to R-Supply and GoTo: Inv>Inventory Control>Inventory Posting. 
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Step #2: Enter the correct actual quantity in each location. 
 
Step #3: Click “Apply” icon to post the correct location quantities. This process 

should not result any inventory adjustments. It will only realign the 
quantities in each location. Total on-hand quantity should be the same as 
before processing the quantity realignment. If the prompt or alert window is 
displayed informing the user that a quantity adjustment (Gain or Loss) will 
be posted, do not proceed with the process. Re-check the quantity you 
entered in each location. 

 
Step #4: Verify location quantities. GoTo: Qry>Stock>Stock Item…enter the NIIN 

and click “OK” button, then click location dropdown menu. Correct 
quantities should be indicated in each location (7EA & 8EA respectively). 

 
 
 
Situation #2: Actual total on-hand quantity in location(s) does not match with the total 

on-hand quantity posted on the stock record. After all exhaustive 
researched has been conducted with no positive results, you decided to 
make the inventory adjustments to realign the actual on-hand quantity to 
the recorded on-hand quantity on the stock record. 

 
To correct the discrepancies, the user can use either the “Inventory Posting” function or 
the “Inventory Adjustments” function. 
 
 
Using the “Inventory Posting” function: 
 
Step #1: LOGON to R-Supply and GoTo: Inv>Inventory Control>Inventory Posting. 
 
Step #2: Enter the target NIIN on the space provided in NIIN Search window and 

click ‘OK’ button to continue. Stock record information should be displayed. 
 
Step #2: Enter the correct actual quantity in each location (if multiple locations 

exist). 
 
Step #3: Click “Apply” icon to continue the process.  
 

Note: An alert window should pop-up indicating the value of 
financial adjustments. The quantity you enter in “Inventory 
Posting” function will become the total on-hand quantity for 
the stock item. This alert window will pop-up only if the 
“Gain/Loss Messages” checkbox is activated (Default) on the 
“Inventory Posting – Search” screen. 

 
Step #4: Click “OK” button to post the quantity entered. 
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Step #5: Verify quantity. GoTo: Qry>Stock>Stock Item…enter the target NIIN and 

click “OK” button. Adjusted quantity should be reflected in the “Total OH 
Qty” field… or you may check the ‘Transaction Ledgers’ to verify the 
transactions (Highly recommended). 

 
 
Using the “Inventory Adjustments” function: 
 
Step #1: LOGON to R-Supply and GoTo: Inv>Inventory Control>Inventory 

Adjustments. 
 
Step #2: Enter the target NIIN in the space provided in NIIN Search window.  
 
Step #3: Select the appropriate radio button on the ‘Selection’ block. 
 

Note: o GBI radio button will increment the on-hand quantity for the 
quantity entered. 

 
o LBI radio button will decrement the on-hand quantity for the 

quantity entered. 
 
o Lost, Damage or Stolen radio button will decrement the 

on-hand quantity for the quantity entered and cause to 
set the correct LBI code for the adjustments. 

 
o Major Disaster radio button will decrement the on-hand 

quantity for the quantity entered and cause to set the 
correct LBI code for the adjustments. 

 
Step #4: Click “OK” button to continue the process. Stock record information should 

be displayed. 
 
Step #5: Enter the actual quantity to be incremented or decremented from the 

current “Total OH Qty”. 
 
Step #6: Click “Apply” icon to post the quantity. Expenditure document will display. 

Click “OK” button to continue. Enter the target NIIN for the next item or 
Click ‘Cancel’ button to exit the process. 

 
Step #7: Verify quantity. GoTo: Qry>Stock>Stock Item…enter the target NIIN and 

click “OK” button to continue. Correct quantity should be reflected in the 
“Total OH Qty” field. You may check the ‘Transaction Ledgers’ to verify the 
transactions (Highly recommended). 

 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to reconcile “Issue Pending Quantity” …  
 
Background Knowledge: 
 
“Issue Pending Quantity Reconciliation” is another R-Supply database alignment 
program that reconciles quantity differences between the stock_item table iss_pndg_qty 
column and the actual total quantity of the outstanding issue transactions in the 
‘material_request’ table. When material is requested, the material request is written in 
‘material_request’ table waiting for further processing. If the material is carried with on-
hand quantity, the requested quantity will be posted on the ‘issue pending’ column (data 
element) in ‘stock_item’ table. This quantity will be updated once the material request is 
completed and issue was posted. For some reason, the quantity on the ‘issue pending’ 
column is not updated even if the material request is already completed… thereby 
indicating that you have issue pending for the item without outstanding material request. 
 
Procedures: 
 
To reconcile the issue pending quantity, follow the steps listed below: 
 
Step #1: LOGON to R-Supply and GoTo: File>Utilities>Issue Pending Qty 

Reconciliation. 
 
Step #2: Select the appropriate checkbox. 
 

Issue Pending Qty Recon (Pre-selected) - Generates a listing of all items 
affected and issue pending quantities updated. 

 
Report Only - If not selected, a report is still created, and the stock_item 

table iss_pndg_qty is updated. 
 
Step #3: Click “Apply” icon to initiate the Batch Job. 
 
Step #4: Click “Submit” button to submit the Batch Job. 
 
Step #5: Approve the Batch Job. GoTo: Site>Management>Site Internal>Batch Job 

Scheduling>Approval. Type-in “R” to release the Batch Job to NTCSS for 
processing. This Step applies only if the “Approval Required” checkbox is 
selected at the Control Parameter Update screen. 

 
Step #6: Verify output. No actions required. 
 
 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to process ‘Local Change Notice’ …  
 
Background Knowledge: 
 
Local Change Notice is an interactive process used to effect Stock Number changes 
without running the Change Notice Batch Job. There are times that NAVICP send out 
notice to the Fleet for stock number change or simply you (the User) found out an 
existing stock item in your ‘stock_item’ table with new superseding stock number.  
 
Procedures: 
 
To process ‘Local Change Notice’, follow the steps listed below: 
 

Note: Display the icon descriptions for easy identification of the displayed icons. To display the 
description, point and right click on any of the displayed icon and select “Show Text”. 

 
Step #1: LOGON to R-Supply and GoTo: Inv>Stock Item>Maintain Stock Item. 
 
Step #2: Enter the target NIIN in ‘NIIN data field’ provided in the ‘Stock Item Search’ 

window and click “OK” button to display the ‘Maintain Stock Item’ window. 
 
Step #3: On the ‘Maintain Stock Item’ window, click ‘Local Change Notice’ icon 

(icon with two red arrows pointing in circular motion). Note: The ‘New NIIN’ 
data field should be highlighted or activated. Also, a checkbox appears for 
option of keeping the old NIIN as a Substitute NIIN for the new Stock 
Number. Make sure the ‘Retain Old NIIN’ checkbox is blanked or 
unchecked. 

 
Step #4: Type-in the New NIIN on the new NIIN block. 
 
Step #5: Click ‘Apply’ icon to complete the process. 
 
Step #6: Verify the ‘Unit Price’. Normally, change in stock number also means 

change in ‘Unit Price’. If the unit price has changed, go back to Inv>Stock 
Item>Maintain Stock Items… then, enter the new NIIN. Click ‘OK’ button to 
continue. Change the ‘Unit Price’, then, click ‘Apply’ icon to effect the 
change. 

 
Step #7: Verify the new stock item. Perform ‘Transaction Ledger’ query of the new 

NIIN to ensure correctness of data. 
 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to process Logistics Replenishment (LOGREP) …  
 
Background Knowledge: 
 
LOGREP (Logistics Replenishment) application provides R-Supply (NWCF) Activities 
with the automated logistics capability to execute ‘at sea’ Logistics Replenishments 
(LOGREP) for forward deployed United States (U.S.) and North Atlantic Treaty 
Organization (NATO) ships and shore activities. Although primarily intended for combat 
stores ships (T-AKE/T-AFS), the capabilities is also extended to all NWCF Activities (i.e. 
CVN, LHA, LHD and AS type ships). LOGREP application is intended for processing of 
batch ‘Material Requirement External (MRE)’ transactions, (i.e. boat drops and other 
MRE batch processing requirements) grouped under the R-Supply replenishment 
module and as a part of the existing application functionality. This includes the ability to 
manage Navy Working Capital Fund (NWCF) and Defense Working Capital Fund 
(DWCF) transactions (dependent upon use).  
 
For CVN and LHA/LHD type ships, the most common use will be during cross-decks of 
material when relieving deployed CVN or LHA/LHD. The process is that the deploying 
CVN or LHA/LHD will screen the deployed CVN or LHA/LHD for material to fill the 
deficiencies (DEF-TO-RO) of the deploying CVN or LHA/LHD. Instead of individually 
processing MRE requirements, batch process through LOGREP application is provided 
for this process. 
 
 
Procedures 
 
To process a complete LOGREP cycle, follow the steps listed below: 
 
Step #1: Add or Update the Customer's UIC data on the 'Other Activities' Table. 

Menu Path: Site>Activity Controls>Other Activities. Update or Add the 
Ship's UIC to the "Other Activities" table prior to initiating the LOGREP 
events. Also, pay attention on Color Code. Make sure color codes are not 
duplicated. This table works about the same as SUADPS’ CIA and CID 
Tables. Customer's UIC must be loaded properly to avoid problems with 
financial reports.   

 
  NWCF/DWCF Activities:   
   T-AFS, T-AKE, and T-AOE, CVN, LHA and LHD 
 
  Cash Sales Activities: 
 MSC Contract Ships, U.S. Embassies, DOD activities, U.S. Coast 

Guards, Foreign Govt/ Navy, and USNS Ships (1Q Cog/APA items) 
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 Processing NWCF/LTL and End-Use requirements for T-AOE with one 
UIC: 

- Use Service Designator “V or R” for all NWCF/DWCF Load-To-
Load requirements. 

   
   - Use Service Designator “N” for all End-Use requirements  
 
 
Step #2: Initialization of LOGREP Cycle. Menu Path: Site>Activity Controls> 

LOGREP Cycle Numbers. Instead of having one cycle working at a time, 
the activity will have an active record of all LOGREP Cycles for the past 12 
months. In addition, future LOGREP Cycles can be loaded and prepared in 
advance if needed. One LOGREP Cycle can be assigned to multiple 
Customers in the event that several Customers submitted LOGREP 
Request at the same time (i.e. Battle Group customers). 

 
 
Step #3: File Transfer. Menu Path: File>Utilities>File Transfer>Batch File Transfer. 

Upload requirements to Server under Batch Job JSS220 – Incoming 
STS/RQN/REF/ LOGREP… After uploading the customer's requirements, 
input transactions should be verified by viewing the input file @ 
File>Utilities>Batch Review then Select the 'Input' radio button. Select the 
file and click OK or double click on file to display the input file.  

  
It is a good practice to count the number of line items in the input file 
(JSS220) before running the JSS220 Batch Job so you can compare the 
number of input that was read during the process. Verify the “Total records 
read” on the ‘Incoming Requisitions Summary Listing’ located almost to the 
end of the output. It is highly recommended not to include ‘incoming supply 
status input’ in any LOGREP Request update/run. 

  
Note: Make sure all 1Qcog (Ship’s Store) and 9M cog (Provisions) 

requirements have 5K advice code to avoid referrals. However, it is 
normal that LOGREP Requirements will have 5K advice codes. 
(Consult TYCOM for current policy). 

 
 
Step #4: Process customer requirements (Batch) - Batch Job Number: JSS220. 

Menu Path: Site>Management>Site Internal>Batch Job 
Scheduling>Predefined Parameters>Incoming STS/RQN/REF/LOGREP. 
Incoming requisitions (in MILSTRIP format) are fed into a batch process - 
Batch Job number JSS220. The incoming LOGREP Requests were 
uploaded in Step #3. 

  
Report ID JSS220A & JSS220AR are produce after completion of Batch 
Job JSS220. Report JSS220A will be in three headings: ‘INCOMING 
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STATUS FOR SUPPLY, CARCASS AND MOV’, ‘INCOMING REFERRAL 
REQUESTS AND LOGREP/REFERRAL STATUS’, and ‘INCOMING 
PREVIOUSLY SUBMITTED SUPPLY AF/AT/AM/AC/AK’.  

Report JSS220AR “INCOMING REQUISTIONS SUMMARY LISTING” 
lists all incoming LOGREP Requests. This portion of the report (Report ID 
JSS220AR) must be included in the customer’s LOGREP Package so the 
customer can verify what they have sent to the Supply Ship. Note: Prepare 
envelop and label it with the customer’s UIC. This envelop will contain all 
documents that will be handed to the customer during the UNREP. 

 
Step #4a:  (As Required) Process customer requirements (Interactive). Menu Path: 

Logistics>LOGREP Requirements>New LOGREP Requests 
(Interactive). If additional LOGREP Request comes in at this 
point of the process, you can enter these requests through the 
interactive process. Ensure these requests are tied in with the 
same LOGREP Cycle number that is currently in progress. 

 
 
Step #5: Process Suspended Transactions. Menu Path: Log>Suspense. This step 

is critical and must be performed. Go to: Log>Suspense then select 
LOGREP Requests function. Any suspended transactions must be 
processed before you proceed to the next step (Activate Customer 
Requirements). Otherwise, these requests will not be included in the 
expenditures listing for the particular LOGREP Cycle. In the event that the 
suspended transactions were not processed, you may delete the 
transactions from the suspense module (take notes of the reason for 
suspension so you can make the corrections) and use ‘Material 
Requirements – External’ function to process these transactions or refer to 
Step #13a or if the reason for suspension is “Not Carried”, you may 
manually prepare and send an “AE8” with “CA” status to the customer. The 
status can be included in Step #6b or Step #15. 

 
 
Step #6: Activate customer requirements (Batch) - Batch Job Number: JSI302. 

Menu Path: Inventory>Management>Inventory Actions>LOGREP 
Processing>Activate Requirements. This Batch Job will match all LOGREP 
Requests in the queue to the 'stock_item' table and set the items for "Hatch 
Sheets" and printing of "Picking Tickets". Statuses (AE8/A41) will be 
created for transmission to the customers (See Step #6b).  

  Notes:  
(1) You must generate the ‘Activate Requirements’ twice if you are 

processing requirements from USNS ships using Service 
Designator of “N” with UIC.  Transferring End-use requirements 
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to another USNS Ship that consists of 1Q cog (“XP” fund code) 
and other FILL/HULL/9M cog items 

First Run: Generate the ‘Activate Requirements’ selecting the 
LOGREP Cycle Number and UIC. (Make sure the Service Code 
of this UIC at the ‘Other Activities’ table is equal to “N”. DO NOT 
set the Cash Sales indicator.) The first run should set the 
‘Activate Date’ for LOGREP Requirements with non-XP fund 
code. After completion of the first run, perform query of a 
LOGREP Requirement with an “XP” fund code. The ‘Activate 
Date’ should be blank.  

Second Run: Generate the ‘Activate Requirements’ for the 
second time. Make sure to set the “Cash Sales” indicator (Both 
the Cash Sales checkbox and the Cash Sales Non-local radio 
button on the ‘Cash Sale' option block.) After completion of the 
second run, perform queries to some of the LOGREP 
requirements (Both XP and non-XP fund code on this LOGREP 
Cycle Number to ensure all LOGREP transactions have an 
‘Activate Date’ set. If everything is OK, proceed to the next Step 
(Either Step #6b or Step #7).  

(2) Set Cash Sale Indicator. This indicator must be set if the 
transactions you are processing are Cash Sales either cash 
collected locally or not. 

(3) Set Load-to-Load (LTL) Indicator. (This is required only for CLF 
Activities with Service Designator of “V or R”- NWCF/DWCF 
units). This indicator must be set when transferring 
NWCF/DWCF material between CLF units.  Ensure Color Code 
is different from UIC with service designator of “N” (End-use 
account). 

(4) Batch Job JSI302 (Activate Requirements) will produce Report 
ID JSI302AR in various headers. Review the report. If the 
LOGREP Cycle consists of two or more customers, pay attention 
of the report header that says “ACTIVATE REQUIREMENTS 
RATION CANDIDATES REPORT”. If Ration Candidates are 
present, you must run Step #6c to ration the quantity to various 
customers. This happens when you (the Supply Ship) do not 
have enough onhand to fill each customer's request requesting 
the same item in any given LOGREP Cycle process. 

 
 
Step #6a (As Required) Pre-Edit Report. Menu Path: Inventory>Management>Inventory 

Reports>LOGREP Reports>Pre-Edit. This is a management 
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tool which provides a snapshot of customer requirements per 
UIC. This step is highly recommended when multiple UIC's are 
present in any given LOGREP Cycle process. 

 
 
Step #6b (As Required) Release Initial Status - Batch Job Number: JSL319. Menu Path: 

Logistics>Release Outgoing Transaction>Status. This process 
can be deferred and can be consolidated in Step #15. Supply 
status BA, CA, or BM (DI: AE8/A41) are produced after the 
batch process (JSI302) and are written in 'logrep_status_out' 
table.  

After completion of the Batch Process (JSL319), you must 
perform 'File Transfer' to download the status file from the Server 
to create a file for transmission to the customer. Open the 
downloaded file with 'NotePad' program and edit/(clean-up) the 
file before transmitting the data to the customer. The edited file 
can be transmitted through SALTS/DAAS or attached to an email 
whichever is convenient.  Ensure NO 1Q/9M cog requisitions 
will be referred (A41) to shore supplying (POE) activities. 

 
 
Step #6c (As Required) Ration Requirements. Menu Path: Inventory>Management> 

Inventory Actions>LOGREP Processing>Ration Requirements. 
This batch job must be run if “ACTIVATE REQUIREMENTS 
RATION CANDIDATES REPORT” has items on it for rationing. 
See note from Step #6. 

 
 
Step #6d (As Required) Reorder - Batch Job Number: JSI208. Menu Path: Inventory> 

Management> Inventory Actions>Reorders. This application 
uses the regular reorder window with added functionality for 
LOGREP. It is highly recommended to avoid delay of Load 
replenishment. 

 
 
Step #7: Hatch Sheets - Batch Job Number: JSI301. Menu Path: Inventory> 

Management> Inventory Actions>LOGREP Processing>Print Hatch 
Sheets. Now able to print 'Hatch Sheets' separate from 'Picking Tickets 
(DD 1348-A’s). Batch Job JSI 301 will produce Report ID SI2600AR (Hatch 
Sheets). Recommend 3 copies, 1 copy for YNSK, 1 for Q.A., 1 copy 
retained in Stock Control as back-up copy. 

 
 

 
Sheet 5 of  8 

 
Prepared by: Lonnie Auza – SPAWAR Norfolk  

http://www.force-rsupplyViking.com or www.force-rsupply.com  
95



DRAFT 

Step #8: Print DD 1348-1As - Batch Job Number: JSI310. Menu Path: Inventory> 
Management> Inventory Actions>LOGREP Processing>Print DD 1348-1A. 
Printing the Picking Tickets (DD 1348A’s) 

 
Note: Ensure the “Radio Button – ‘Priority’” is selected at this screen: 

Site>Activity Controls>Constants>Printer Identification. Ensure to 
click on “Apply” button to save the changes.  Ensure number of 
picking tickets equals to number of requisitions indicated on the 
hatch sheets. 

 
 
Step #9:  (QA) VERIFY QUANTITIES ON THE HATCH SHEET and/or DD 1348As 

AGAINST THE ACTUAL QUANTITY PULLED. 
 
 
Step #10: Update changes in quantities or issue substitute (if applicable). Menu 

Path: Logistics>LOGREP Requirements>Edit LOGREP Requests. This 
process is critical for the accuracy of your invoice/billing process. Ensure 
all changes to the Q.A. smooth hatch sheets and picking tickets are 
processed, otherwise your billing will not reflect the correct expenditures. 

 
 
Step #11: Stage requirements. Menu Path: Inventory>Management>Inventory 

Actions>LOGREP Processing>Stage Requirements. Added functionality is 
provided allowing the activity to stage requirements for delivery and lock-in 
requirements. Transactions cannot be modified after completion of the 
'Stage Requirements' process. This batch job will not produce any output. 
It will only set the 'Staged' date and have the items ready for delivery.  To 
correct erroneous LOGREP transactions, run “Clear Stage Requirements” 
batch job, correct erroneous transaction, and run “Stage Requirements” to 
lock-in rqmnts. 

 
 
Step #11a (As required) Pallet Count Report. Menu Path: Inventory>Management> 

Inventory Reports>LOGREP Reports>Pallet Count Report. 
This report may be generated for management. It will give the 
user a good estimate of how many pallets will be transferred 
during the UNREP. Pallet count is an estimate figure based on 
the cube data of the items in your database. 

 
 
Step #12: Produce Invoice/ Billing Package - Batch Job Number: JSI285. Menu 

Path: Inventory>Management>Inventory Actions>LOGREP Processing> 
Produce Invoice/Billing Package. This process will generate billings for all 
transactions processed in Step #11.  Ensure DD 1348-1A (1Q Cog) and 
DD 1149 documents (Cash Sales Report) were generated and included in 
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customer’s billing package.  Recommend 2 copies, 1 copy for customer 
billing package and 1 copy retained in customer’s completed LOGREP 
folder.   

  
Notes:  

(1) Batch Job JSI285 will produce hard copy output (Report ID: 
SL3530AR) and generate electronic X71 transactions. Copy of 
this report will be included in the customer’s LOGREP Package. 

  
(2) X71 transactions (located at h/data/local/SUP1BT/tape_out) … 

menu path: File>Utilities>Batch Review>Output File) must be 
downloaded (Using File Transfer) into CD for inclusion to the 
customer’s LOGREP Package. These X71 transactions can be 
used by the customer to automate the receipt processing. If File 
Transfer does not work, select and open the file then highlight 
the transactions to copy (Ctrl + C) and paste into ‘Notepad’ (Ctrl 
+ V).  

 
Print a hard copy of the file and include it (with CD) in the 
customer's LOGREP Package. 

 
(3) If batch job number JSI285 didn't produce the actual 

invoice/billing package listing on the first run (Step 12), 
run/process another batch job to print "Duplicate Invoice/Billing 
Package" listing for subject customer/UIC." -  
Path: Inventory>Management>Inventory Actions>LOGREP 
Processing>Produce Invoice/Billing Package  

 
Step #13: LOGREP Summary Report - Batch Job: JSI327. Menu Path: Inventory> 

Management>Inventory Reports>LOGREP Reports>LOGREP Summary 
Report. Generate the LOGREP summary report. It is highly recommended 
to generate this report for the management. 

 
 
Step #13a (As required) Process supplemental requirements (Interactive). Menu Path: 

Logistics>LOGREP Requirements>New LOGREP Requests 
(Interactive). Supplemental LOGREP requirements can be 
added at this point. If it happens, follow Steps #3 through 
#11).  

Note: Supplemental LOGREP Requirements are defined as 
additional requirements from the customers included in 
this current LOGREP Cycle Number. 
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Step #14: Process Expenditures - Batch Job Number: JSI280. Menu Path: 
Inventory>Management>Inventory Actions>LOGREP Processing>Process 
Expenditures. This Batch Job (JSI280) completes the LOGREP cycle 
process. Shipment statuses are generated at this point and are written in 
'logrep_status_out' table. This batch job generates a hard copy output 
(Report ID: SL3530AR). 

 
 
Step #15: Release Final Status - Batch Job Number: JSL319. Menu Path: 

Logistics>Release Outgoing Transaction>Status. This will consist of AS8 
and may contain AE8 if you deferred your initial "Status Release" from 
Step 6b. 

  
After completion of the Batch Process (JSL319), you must perform 'File 
Transfer' to download the status file from the Server to create a file for 
transmission to the customer. Open the downloaded file with 'Notepad' 
program and edit/(clean-up) the file before transmitting the data to the 
customer. The edited file can be transmitted through SALTS/DAAS or can 
be attached to an email, whichever is convenient. This completes the 
LOGREP Cycle.  Ensure NO 1Q/9M cog requisitions will be referred 
(A41) to shore supplying (POE) activities. 

 
 
Step #16: Generate reports. It is highly recommended to generate the following 

reports: 
 

(1) LOGREP Supply Effectiveness Report. Menu Path: Inventory> 
Management>Inventory Reports>LOGREP Reports>LOGREP 
Supply Effectiveness Report 

 
(2) LOGREP Depth Effectiveness Report. Menu Path: Inventory> 

Management>Inventory Reports>LOGREP Reports>LOGREP 
Depth Effectiveness Report 

 
(3) Summary of Replenishments Report. Menu Path: Inventory> 

Management>Inventory Reports>LOGREP Reports>Summary 
of Replenishments Report 

 
(4) Assets Report. Menu Path: Inventory>Management>Inventory 

Reports>LOGREP Reports>Assets Report 
 
 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to process ‘Management Data Element Reconciliation (E-38 
Processing) 
 
Background Knowledge:  
 
Your ‘Relational Supply (R-Supply) Database’ is the most critical data file when it comes 
to Supply management. Stock Control personnel or anyone (with proper access and 
permission to R-Supply) interacts with the database daily, either adding new item or 
changing data element to existing items in database. It is critical that every piece of 
information is accurate. To ensure accuracy of information in Supply database, at least 
yearly, each Activity will reconcile its stock item records with the Navy Management Data 
File (otherwise known as E-38 processing) maintained by NAVSISA. Instructions for 
scheduling the reconciliation are contained in NAVSISAINST 4410.2 (series) which 
must be followed carefully to ensure that the process is accomplished in a timely 
manner.  
 
 
Procedures:  
 
To perform ‘Management Data Element Reconciliation’, follow the steps listed below: 
 

Step #1: Produce the E-38 reconciliation record for NAVSISA. An E-38 
reconciliation record is extracted or produced from the item table and 
submitted to Commanding Officer, NAVSISA (Code 99211), 
Mechanicsburg, PA 17055.  

 
 
   Instructions for extracting/producing the E-38 media: 
 

(1) LOGON to RSUPPLY and GoTo: Site>Management>Site 
Internal>Batch Job Scheduling>Predefined Parameters… then 
Select Batch Job ‘JSS131’ (Management Data Element 
Reconciliation). 

 
(2) Click ‘Apply’ icon to submit the Batch Job. 
 
(3) Click ‘OK’ button to continue. 
 
(4) Approve the Batch Job. GoTo: Site>Management>Site 

Internal>Batch Job Scheduling>Approval. After completion of the 
Batch Job, one page hard copy out will be generated to indicate 
the number of records written to the electronic media. Electronic 
media output includes all active NIINs except Local Stock 
Numbered items in item table. 
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(5) Verify the electronic output. GoTo: File>Utilities>Batch Review… 
then Select the ‘Output’ radio button to display the Batch Jobs. 

 
(6) Select ‘JSS131’ then click ‘OK’ button to display the output or 

you may double click the Batch Job to display the output. 
 
(7) Download the electronic output. GoTo: File>Utilities>File 

Transfer>Batch File Transfer…  
 
(8) Select ‘Receive From Server’ radio button. On the “Receive 

From Server” block, Select ‘File’ radio button then type or enter 
the Batch Job number on the space provided on the “Receive 
From Server” block.  

 
(9) Select ‘Transfer to Hard Drive’ (Default) radio button. 
 
(10) Click ‘Apply’ icon to continue the process. When file 

download is completed, an “Alert Notice” will be displayed 
informing the user that the file is created at the transfer (xfer) 
folder. 

 
(11) Verify the downloaded file at the xfer folder. GoTo: Start>My 

Computer>Local Disk (C)>Program 
Files>ntcss>sup1cl>data>xfer then Select the Filename 
(Normally, filename will default to JSS131). You may rename the 
file for easy identification when uploading the file to NAVSISA. 

 
(12) Submit the data to NAVSISA (Refer to NAVSISAINST 4410.2 

(series) for complete instructions. 
 

Step #2: Once the E-38 Data is received by NAVSISA, the activity's item data 
elements will be matched against the Navy Management Data File and 
generate or create ‘Change Notice’ records for data elements requiring 
correction. The change notice records will be returned to the activity for 
processing. (Note: In most cases, exception listing will be provided to the Activity 
for research. Exception listing contains all stock items that are in the Activity’s 
database and not matching to the Navy Management Data File. Items that do not 
match from the Navy Management Data file maybe items unique to Army or Air Force 
or deleted items. Manual and physical review of these items is a must.) 

 
Step #3: The ‘Change Notice’ records will be processed into R-Supply database 

in the same manner as ‘Monthly Change Notice’ processing.  
 

Step #4: Perform actions to the ‘Change Notice’ output. Expected output is 
identical to the monthly change notice processing… therefore, actions 
to be performed is also identical. Output must be reviewed and 
processed accordingly. Supply QA Division/Stock Control Supervisor 
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must keep track of the progress and actions taken to the ‘Change 
Notice’ output to ensure accuracy of actions taken and completed in 
timely manner. 

 
Very Important Notice: SUBMARINE and SUBMARINE TENDERS. The above 
reconciliation procedures are not applicable to these platforms. Arrangements must be 
made with the Strategic Systems Project Office (SSPO) Code SP-206 for database 
reconciliation. 
 
 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to process material “Offload” …  
 
Background Knowledge: 
 
You may ask, how are excess material accumulated onboard your ship? Accumulation of 
excess material can be attributed to several situations. Some of the major causes that 
generates material excess are: Monthly ASI process, Gain-by-inventory (GBI), Erroneous 
Reorder process, Material turn-in to stock (MTIS), Re-COSAL/Re-AVCAL or Allowance 
changes or deletions just to name a few. Level Settings (when generated) will generate 
excess material due to demand fluctuations. An Allowance Type Code (ATC) of “4” may 
turn into excess (ATC 6/7, depending of EMV) when required demand for retention is not 
met during the specified ‘base period’ on the Level Setting parameters. Whatever situation 
drives your excess material onboard your ship, it is a ‘black mark’ on your SAMMA/SAL. 
Your goal is to keep excess material to the minimum. There are R-Supply programs that 
you can generate to prevent excess material from accumulating onboard your ship. 
Programs like: Excess Stock Due Cancellation. This program should be generated in a 
monthly basis. Run Ad Hoc to identify ATC 6 with unit price greater than (you specify). 
Once these items are identified, you can selectively offload these items using the MRE 
program. Be proactive in managing your excess material. 
 
Automated Offload is normally conducted after deployment, depending on your 
operational commitment. Follow the procedures below to conduct an automated Material 
Offload. 
 
Procedures: 
 
To perform automated material Offload, follow the steps listed below: 
 
Step #1: Preparation: Know how much excess material to be offloaded. Run or 

process R-Supply transactions or programs in the following sequence: (1) 
Process all receipts. (2) Process pending issues. (3) Process all suspended 
transactions that affect the inventory or O/H QTY.  (4) Run “Stock Item 
Maintenance” program with only “Change Allowance Type Codes” checkbox 
is activated. This Batch Job when run will realign the alternate_niin table 
against the stock_item table by changing from ATC 6, 7, and 8 to 9 if the 
NIIN is currently in the alterna_niin table with PSIN indicator of “S”. (5) Run 
Level Settings to establish a baseline for Offload. Refer to TYCOM Level 
Settings’ recommended parameters. (6) Run a true Asset SAMMA/SAL with 
‘RAB’ checkbox activated. This will generate a complete listing of all 
redistributable assets onboard (Excess material). 

 
Develop the Offload POA&M. Offload is a major event that requires major 
planning (i.e. man hours (number of personnel required to complete the 
project), timing (ensure to select a good window of opportunity in completing 
the project), make arrangements with the receiving Activity (normally FISC) 
of what is needed or required in offloading your excess material, consult 
your TYCOM for the current policy, and conduct training for the personnel 

102



DRAFT 

 
Sheet 2 of  7 

 
Prepared by: Lonnie Auza – SPAWAR Norfolk 

http://www.force-rsupplyViking.com or www.force-rsupply.com  

who will be doing the job. It is not as simple as you think. Everyone knows 
how to pull material from the storeroom location, however, not everyone 
understand the impact if not done properly and correctly.  
 
Prepare for the Offload. Major preparation is to LAP (Location Audit 
Program) the storeroom. LAP is an ongoing process that should be part of 
your inventory Team tasking. Another major preparation prior to conducting 
Offload is to run a “Live” Level Setting program. This will allow the Activity to 
establish a current baseline for offload. 

 
Step #2: Set the ‘Offload’ constants: Logon to R-Supply. GoTo: Site>Activity 

Controls>Constants>Requisition/Offload Values. Select “Offload Defaults” 
tab and set the correct UIC of the receiving Activity and other offload default 
data. 

 
Step #3: Select the offload candidates: Select is the actual generation of the batch 

job to select the offload candidates. This process populates the offload 
table. GoTo: Inv>Management>Inventory Actions>Offload 
Processing>Offload. Select and assign the correct offload parameters. 

 
At the minimum, select the following: 

 
   Type of Offload: The following Options are available: 
 

Regular: Regular option is the most common. This 
option when selected will screen all items in the 
stock_item table based on O/H QTY against 
the RO of the item. If the O/H QTY minus RO is 
positive, the item is in excess condition. Make 
sure to consider substitute items by checking 
the substitute checkbox on the other options 
block. 

 
DRMO: This option is selected when offloading material 

to DRMO (i.e. Expired Shelf Life items, etc.). 
 

Total: This option when selected will generate offload 
documents to every line item in stock_item 
table that has O/H QTY. Total offload option is 
selected when decommissioning a ship only or 
directed by the Activity’s TYCOM. 

 
   Other options: 
 

Stores Type: Select either ‘General Stores’ or 
‘Restricted’. Restricted item includes QCOSAL. 
Normally, “General Stores” is selected. If no 
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selection was specified, both stores type will be 
screened or considered for offload. 

 
Designate Material: Select the type of material to be 

considered for offload. 
 

Specify: You can further tailor your output by selecting 
the applicable item. 

 
Include Substitutes: This option must be selected to 

have substitute O/H QTY considered during the 
computation process. 

 
DBI Retention Factor: Select the appropriate number 

of months. Consult TYCOM recommendation. 
 
Output: Report by Extended Money Value (EMV). 
 
Optional Block: Select options as applicable to further 

tailor the output. 
 
 Submit and approve the Batch Job. Do not forget to set the correct 

indicators on the ‘Control Parameter Update’ screen. 
 

Note: After successful completion of the Batch Job, offload table is 
populated with offload candidates. You can check the offload 
table by running “Ad Hoc”. GoTo: File>Utilities>Ad hoc 
Query>Expert. Click “Tables” on the Ad Hoc Query Checklist. 
Select the “offload” table. Run the Query. All offload 
candidates should be displayed. 

 
Step #4: Print the Offload Picking Tickets (DD Form 1348-1A). . GoTo: 

Inv>Management>Inventory Actions>Offload Processing>Print Offload 
Documents… then select “Offload Picking Tickets” radio button. After 
completion of the select phase (Batch Job JSI209), print the official offload 
documents (Picking Tickets - Batch Job JSI230) to be used to physically pull 
the material from various storeroom locations. 

 
Step #5: Distribute the Offload Picking Tickets. This is a critical management 

action. Picking Tickets must be closely monitored and controlled by the 
Offload manager or Stock Control Supervisor. Remember that a copy of all 
Picking Tickets must be returned to who ever control the offload project (i.e. 
Stock Control Supervisor) to ensure accuracy of the process and accurately 
perform Step #7 (Update) of the offload project. 

 
Suggestions how to control the Offload Picking Tickets: Picking 

Tickets should be matched against the Offload Listing that was 

104



DRAFT 

 
Sheet 4 of  7 

 
Prepared by: Lonnie Auza – SPAWAR Norfolk 

http://www.force-rsupplyViking.com or www.force-rsupply.com  

produced or created in Step #4. Checked-off or bracket the 
items on the listing and have the person sign-out the picking 
tickets by setting his/her signature on the Offload Listing. Hand 
them out about ten or twenty at a time. By letting the person 
signed out those picking tickets, the person is obligated to do a 
good job and returned a copy of the picking tickets to the 
Offload project manager. 

 
Step #6: The hard and long hours of physical work: The person conducting the 

pulling of excess material should be trained and instructed to perform the 
following actions: (Very Important Note: Annotations are very critical to the person 
performing the update process (Step #7). This is the only way to communicate between the 
person pulling the excess material and the Stock Control personnel performing the Update 
phase.) Remember that this is your chance to have an accurate inventory of 
your actual quantity on-hand… so, pay close attention what you are doing.  

 
The following is a must to understand by the personnel pulling the material 
from storeroom locations: 

 
• Pay attention to “retain quantity” on the picking ticket. 

Retain quantity is equal to the High Limit or RO of the 
item. The reason why offload document was generated 
to this particular item is that the O/H QTY is greater 
than the RO. 

 
• Count the actual O/H QTY of the material to see if the 

actual O/H QTY total count is equal to “Retain Quantity” 
plus the “Offload Quantity”. If the count is equal to the 
total of “Retain Quantity” and “Offload” quantity, no 
correction is required. Pull the excess material from the 
location and circle the “Offload” quantity on the offload 
picking ticket. Pull a copy of the offload Picking Ticket 
for return to the controlling custodian. Attach the 
remaining copy or copies of the offload picking ticket to 
the material. 

 
• If the total count of the actual O/H QTY is more than 

the total of “Retain Quantity” plus the “Offload 
Quantity”, cross-out the “Offload Quantity” and change 
it to whatever the excess quantity after the “Retain 
Quantity” is placed back to its proper location. 

 
• If the total count of the actual O/H QTY is equal to or 

less than the “Retain Quantity”, cross-out the “Offload 
Quantity” and change it to “0” (Zero Offloaded) and 
indicate the actual inventory count of the material on 
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the picking ticket. This is critical to the person 
performing the “Update” phase (Step #7). 

 
Note: Material to be offloaded that has 
changes in quantity to be offloaded on 
the Picking Ticket must be separated from 
the ones that do not have changes (the 
good ones). The reason is that you will get 
back to these packages to reattach the 
final documents. (See Step #8). 

 
Step #7: Perform update: GoTo: Inv>Inventory Control>Offload>Updates. Update is 

the process of making corrections to offload documents (Picking Tickets - 
DD 1348-1A) in offload table (i.e. Offload quantity changes, deletion of 
offload documents, etc.). This is a critical step and must be processed as 
indicated notations on the Picking Tickets by the person pulling the excess 
material. The individual who control the project and will perform the update 
should perform the following actions: 

 
• Match the returned offload picking tickets against the ‘Offload 

Listing’ that was used to distribute and control the picking 
tickets. Ensure the person who signed-out those picking tickets 
returned the same number of offload picking tickets with 
annotations. 

 
• Sort the returned offload picking tickets. Set aside those 

picking tickets that do not require updates. No corrections 
required. (The actual O/H QTY count must have equal to the total of 
“Retain Quantity plus Offload Quantity”). No changes required in 
offload table. 

 
• If the offload quantity was changed, this means that the actual 

O/H QTY count is either less than or greater than the total of 
“Retain Quantity” plus the “Offload Quantity”. In this case, you 
must update the “Offload Quantity” to reflect what was 
annotated and set aside this document for further research. 
Whatever the results of the audit trail, process inventory 
adjustments before or after the Offload project is completed. 
You can either use the “Inventory Posting” option or the 
“Inventory Adjustment” option. Pay attention of exact 
storeroom location, specially, if you have a multiple locations 
assigned. Consolidate into one location and delete other 
locations if possible. 

 
• For those offload documents that do not have O/H QTY to be 

offloaded due to O/H QTY was equal to or less than the 
“Retain Quantity”, will be deleted from the ‘offload’ table. 
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Again, inventory adjustment must be performed to adjust the 
actual O/H QTY count. 

 
Note. The person performing the update 
process must separate the offload 
documents that have changes in quantity 
to be offloaded. The reason for doing this 
is that you must reprint the offload 
documents so it matches the offload 
quantity. This is important because the 
receiving Activity (FISC) may use IBS to 
process receipt. If the old document 
(cross-out & annotated copy) is used to 
scan the receipt, the quantity scanned will 
be the original quantity (not the corrected 
quantity). Remember, when you cross-out 
the offload quantity, the barcode is not 
changed. See Step #9. This event must 
be accomplished after Step #8 (Release).  

 
Step #8: Release: GoTo: Inv>Management>Inventory Actions>Offload 

Processing>Release/Cancel… then select the appropriate options. Release 
is the process of releasing the offload documents from the offload table to 
update the stock_item table and other related financial tables. Select the 
“Release” radio button. Submit and approve the batch job. During this Batch 
Job process, all offload documents in the offload table are processed and 
posted to various database tables. All records involved are updated (on-
hand quantity adjustments) and transactions are posted to CTL and other 
related database tables to include financials (MFCS TIR (NWCF Activity 
Only)). These documents will be match against the receipt TIR from the 
receiving Activity. Any transactions that do not have a matching receipt TIR 
from the receiving Activity will become SIT and become a bill-back to you. 

 
Note: After completion of the “Release” process, do not forget to go 

back and process inventory adjustments for the items that 
require inventory adjustments posting from Step #6.  

 
Step #9: Print the final offload documents for ‘Offload Picking Tickets that has 

Changes in Offload Quantity’. GoTo: Inv>Management>Inventory 
Actions> Offload Processing>Print Offload Documents… then select “Print 
Duplicate Released Documents” radio button. Controlling these “final 
released offload documents” is critical. The newly printed offload 
documents must be signed-out (refer to Step #5) and attached to the 
material. The original offload documents (that has changes in quantity 
offloaded) must be returned to the controlling custodian to ensure the event 
was accomplished.  
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Step #10: Material delivery: Make arrangements with receiving Activity for delivery of 
material. Make sure someone will sign the paper-works and accept the 
material. Remember, you are still on the hook until the receiving Activity 
process the receipt and submit their TIR report to NAVICP to match your 
TIR transmittal. 

 
Note: Make sure to call and double check the receiving Activity 

exactly what is required with delivery of the material. 
 
Step #11: Run a Sample SQA Random inventory: List a few items from the ‘Offload’ 

listing and pass it to the Supply Quality Assurance Division for random spot 
inventory to ensure offload accuracy. 

 
Step #12: Lessons learned: Discuss lessons learned during course of the project. 

Rewards the Offload Project Team Members for the job well done based on 
the results of Step #11. 

 
 
 

‘End of Project Offload’ 
 
 

Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to set-up ‘Printer in R-Supply’ … 
 
Background Knowledge: 
 
Picking Tickets and R-Supply Batch Jobs hard copy output are required to be printed. 
However, it all depends how you set the Control Parameters of that particular Batch 
Job and other documents that requires printing. In order for these hard copy output to 
be printed, the printer must be set-up in R-Supply in addition to NTCSS printer mapping 
(adding printer to the NTCSS Network). Printers has to be set-up in NTCSS for initial 
application set-up (Menu Path: NTCSS TOOLBAR>System>App Print Config) and in 
R-Supply ‘Site’ subsystem (Menu Path: Site>Activity Controls>Constants>Printer 
Identification).  
 
Procedures: 
 
A. To set-up the printer in NTCSS, follow the steps listed below: 
 
Step #1: Verify printers in the network. Launch NTCSS and GoTo: NTCSS 

TOOLBAR>System>App Print Config>. ‘Application Print Config’ window 
should display. 

 
Step #2: Select RSUPPLY on the “Application List” block. “Network Printer List” 

block should be populated with the available printer on the network. If no 
printer is displayed, printer mapping is not completed yet. You must have 
the SA add or establish printer connection in the NTCSS network. If this is 
the initial printer set-up, “Output Type List” block should be blank. 

 
Step #3: Set-up printer connections. Add the printer where R-Supply Reports are 

to be printed. Select ‘Output Type’ on the ‘menu bar’ then, Select ‘Add’. 
‘ADD OUTPUT TYPE’ pop-up window should be displayed. 

 
Step #4: Enter or type-in ‘reports’ on the “NAME” data field.  
 
Step #5: Enter or type-in ‘General Printing’ on the “DESCRIPTION” data field. 
 
Step #6: Select a ‘Printer’ that is displayed on the “NETWORK PRINTER LIST” 

display window.  
 
Step #7: Select the dropdown menu on the “DEFAULT PRINTER” data field then 

select the printer. 
 
Step #8: Select the ‘BATCH PRINT’ checkbox. 
 
Step #9: Click “OK” action button to continue. 
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Step #10: Select ‘Apply’ action button to save the printer connection. Printer 
connection should be displayed on the “Output Type List” block or display 
window. 

 
Step #11: Add the printer where the issue ‘Picking Tickets’ (X31Laser1) are to be 

printed. Select ‘Output Type’ on the ‘menu bar’ then, Select ‘Add’. ‘ADD 
OUTPUT TYPE’ pop-up window will be displayed. 

 
Step #12: Enter or type-in ‘X31Laser1’ on the “NAME” data field. 
 
Step #13: Enter or type-in ‘Picking Tickets’ on the “DESCRIPTION” data field. 
 
Step #14: Select a ‘Printer’ that is displayed on the “NETWORK PRINTER LIST” 

display window. 
 
Step #15: Select the dropdown menu on the “DEFAULT PRINTER” data field then 

select the printer. 
 
Step #16: Select the ‘BATCH PRINT’ checkbox. 
 
Step #17: Click “OK” action button to continue. 
 
Step #18: Select ‘Apply’ action button to save the printer connection. Printer 

connection should be displayed on the “Output Type List” block or display 
window. 

 
Step #19: Add the printer where the End-Use Transfer ‘Picking Tickets’ (X34Laser1) 

are to be printed. Select ‘Output Type’ on the ‘menu bar’ then, Select 
‘Add’. ‘ADD OUTPUT TYPE’ pop-up window will be displayed. 

 
Step #20: Enter or type-in ‘X34Laser1’ on the “NAME” data field. 
 
Step #21: Enter or type-in ‘Picking Tickets’ on the “DESCRIPTION” data field. 
 
Step #22: Select a ‘Printer’ that is displayed on the “NETWORK PRINTER LIST” 

display window. 
 
Step #23: Select the dropdown menu on the “DEFAULT PRINTER” data field then 

select the printer. 
 
Step #24: Select the ‘BATCH PRINT’ checkbox. 
 
Step #25: Click “OK” action button to continue. 
 
Step #26: Select ‘Apply’ action button to save the printer connection. Printer 

connection should be displayed on the “Output Type List” block or display 
window. 
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Step #27: Add the printer where the Cash Sales ‘Picking Tickets’ (X35Laser1) are to 

be printed. Select ‘Output Type’ on the ‘menu bar’ then, Select ‘Add’. 
‘ADD OUTPUT TYPE’ pop-up window will be displayed. 

 
Step #28: Enter or type-in ‘X35Laser1’ on the “NAME” data field. 
 
Step #29: Enter or type-in ‘Picking Tickets’ on the “DESCRIPTION” data field. 
 
Step #30: Select a ‘Printer’ that is displayed on the “NETWORK PRINTER LIST” 

display window. 
 
Step #31: Select the dropdown menu on the “DEFAULT PRINTER” data field then 

select the printer. 
 
Step #32: Select the ‘BATCH PRINT’ checkbox. 
 
Step #33: Click “OK” action button to continue. 
 
Step #34: Select ‘Apply’ action button to save the printer connection. Printer 

connection should be displayed on the “Output Type List” block or display 
window. 

 
Step #35: Add the printer where the OSO Transfer ‘Picking Tickets’ (X37Laser1) are 

to be printed. Select ‘Output Type’ on the ‘menu bar’ then, Select ‘Add’. 
‘ADD OUTPUT TYPE’ pop-up window will be displayed. 

 
Step #36: Enter or type-in ‘X37Laser1’ on the “NAME” data field. 
 
Step #37: Enter or type-in ‘Picking Tickets’ on the “DESCRIPTION” data field. 
 
Step #38: Select a ‘Printer’ that is displayed on the “NETWORK PRINTER LIST” 

display window. 
 
Step #39: Select the dropdown menu on the “DEFAULT PRINTER” data field then 

select the printer. 
 
Step #40: Select the ‘BATCH PRINT’ checkbox. 
 
Step #41: Click “OK” action button to continue. 
 
Step #42: Select ‘Apply’ action button to save the printer connection. Printer 

connection should be displayed on the “Output Type List” block or display 
window. 
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Step #43: Add the printer where the NRFI Turn-in ‘Picking Tickets’ (BC1Laser1) are 
to be printed. Select ‘Output Type’ on the ‘menu bar’ then, Select ‘Add’. 
‘ADD OUTPUT TYPE’ pop-up window will be displayed. 

 
Step #44: Enter or type-in ‘BC1Laser1’ on the “NAME” data field. 
 
Step #45: Enter or type-in ‘Picking Tickets’ on the “DESCRIPTION” data field. 
 
Step #46: Select a ‘Printer’ that is displayed on the “NETWORK PRINTER LIST” 

display window. 
 
Step #47: Select the dropdown menu on the “DEFAULT PRINTER” data field then 

select the printer. 
 
Step #48: Select the ‘BATCH PRINT’ checkbox. 
 
Step #49: Click “OK” action button to continue. 
 
Step #50: Select ‘Apply’ action button to save the printer connection. Printer 

connection should be displayed on the “Output Type List” block or display 
window. 

 
Step #51: Select ‘Quit’ action button when all designated printer connections are 

established.  
 
 
 
B. To set-up the printer in RSUPPLY, follow the steps listed below: 
 
Step #1: Launch R-Supply Application and GoTo: Site>Activity 

Controls>Constants>Printer Identification. ‘Printer Identification’ pop-up 
menu will display. 

 
Step #2: Establish printer connection for material issues. Select ‘Storeroom 

Issues’ radio button (Default). 
 
Step #3: Select ‘OK’ button to continue. ‘Printer Identification – Storeroom Issues’ 

window will display. 
 
Step #4: Select ‘Priority’ radio button (Default). This selection is highly 

recommended. 
 

Note: If ‘Location’ radio button is selected, you must add the storeroom 
location number to designate the printer in the location. Only add 
the first two digits of the storeroom location number (i.e. AA, AB, 
CC, DD, etc.). 
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Step #5: Select the ‘Printer Type’ you have established in NTCSS for this 
process. This has to match with the established printer. 

 
Step #6: Adjust the number of copies you want. One means ‘Two’ copies since 

there are two Picking Tickets printed in one page. If you need four copies, 
set the number of copies to ‘2’. 

 
Step #7: Click ‘Apply’ icon to save the set-up or changes. 
 
Step #8: Establish printer connection to material transfers. Select ‘Material 

Transfers’ radio button. 
 
Step #9: Select ‘OK’ button to continue. ‘Printer Identification – Material Transfers’ 

window will display. 
 
Step #10: Select the ‘Printer Type’ you have established in NTCSS for this 

process. This has to match with the established printer. 
 
Step #11: Adjust the number of copies you want. One means ‘Two’ copies since 

there are two Picking Tickets printed in one page. If you need four copies, 
set the number of copies to ‘2’. 

 
Step #12: Click ‘Apply’ icon to save the set-up or changes. 
 
Step #13: Establish printer connection for Carcass Turn-ins. Select ‘Carcass Turn-

ins’ radio button. 
 
Step #14: Select ‘OK’ button to continue. ‘Printer Identification – Carcass Turn-ins’ 

window will display. 
 
Step #15: Select the ‘Printer Type’ you have established in NTCSS for this 

process. This has to match with the established printer. 
 
Step #16: Adjust the number of copies you want. One means ‘Two’ copies since 

there are two Picking Tickets printed in one page. If you need four copies, 
set the number of copies to ‘2’. 

 
Step #17: Click ‘Apply’ icon to save the set-up or changes. 
 
 
 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to Release Outgoing Requisitions …  
 
Background Knowledge: 
 
‘Release Requisitions’ function provides the opportunity to review and then release 
transactions into the supply system (except for the 'Post Only' option). The user must 
select from requisitions created from Automatic Reorder or those created by Initiate 
Requisition and other processes. The user may choose to release all the requisitions or 
can narrow the number of requisitions to be released by selecting a specific document 
number, cog, or HI PRI requisitions. 
 
The user is given the option to review the records before releasing them. The default is 
to review the record, so if user does not want to review them, then the Review checkbox 
option should not be selected. 
 
There is also an option at the bottom of the window for Batch Job Number "BJN 
(Recovery Only)"; this provides a means of recovering the job if the batch job was 
interrupted and the job did not run to completion. The user can enter the BJN to recover 
the Batch Job. 
 
On the Requisition Review window, the user is given the opportunity to ‘Release’, 
‘Change Document Number’, ‘Post Only’, or ‘Cancel’ requisitions. Basic information on 
the requisition, such as the document number, priority, fund code, NIIN, Cog, unit of 
issue, quantity and the extended money value are displayed. If the user desires to 
change quantity or other data elements on the MILSTRIP may do so by double clicking 
the target requisition. The detailed view of the MILSTRIP is displayed and the user will 
be able to change data element by changing the target information such as: quantity, 
supplementary address, etc. can be modified. If changing quantity, the user must tab out 
of the quantity field before clicking ‘Apply’ button in order for the ‘Extended Money 
Value’ field to change. The user may also change the COSAL Type at this window. 
However, the user will only be able to change to a COSAL Type within the same Stores 
Type; e.g., if the requisition is a General Stores type requisition, then the user will only 
be able to select a new COSAL Type that is a General Stores Type COSAL. The user 
will not be able to change the COSAL Type when a partial issue is involved. If the user 
changes the COSAL Type or any other data, the new data will overwrite the original data 
in the 'material_request' table. 
 
There are also icons on the toolbar that allow the user to "Release All," "Cancel All," 
"Post All," or "Change All" the requisitions listed on the requisition review display. 
 

Notes: 1. If the Change Document Number option is selected, the Release option 
will automatically be selected. The reason for this is that the user 
cannot manually assign a new date and serial number -- the program 
will assign the next date and serial number available during the actual 
requisition release batch run process. 
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2. If the Post Only option is selected, the Release option is automatically 
selected. This will only post the requisition to the ‘active_rqn_tbl’ and its 
related database tables without causing the requisition to be released 
into the supply system. 

 
3. The 'NOTICE OF RELEASED REQUISITION TRANSACTIONS' Report 

will show the new document number as the one being released. In 
addition, the 'Old Document Number' that was changed during 
'Requisition Release' will be shown on the same line under ‘PREV 
DOCUMENT’ column for informational purposes. 

 
4. The 'NOTICE OF RELEASED REQUISITION TRANSACTIONS' report 

will identify which document numbers were a 'Post Only' selection. They 
will be identified by an asterisk (*) under the ‘Post Only’ column. 

 
5. The 'Chg Doc Nbr' checkbox will not be available for requisitions that 

originated in NALCOMIS. Requisitions originating in NALCOMIS are not 
authorized to have their document numbers changed during the 
‘Release Outgoing Transaction’ process. 

 
On the Requisition Review window, there is a column titled "QR". If the requisition has 
asterisk (*) on the checkbox, this indicate that the requisition was previously selected for 
release but the Batch Job has not been run or the Batch Job has been cancelled at the 
‘Approval’ queue. Verify the ‘Approval’ queue (Menu Path: Site>Management>Site 
Internal>Batch Job Scheduling>Approval) to ensure no outstanding JSL319 batch job 
pending approval. If no JSL319 batch job pending approval, the user may choose to 
release these records again under new batch job submission or may choose to skip 
them for inclusion in later release. If the user cancels a requisition or group of 
requisitions in ‘Requisition Review’ window, the cancellation occurs online after "Apply" 
icon is selected. It does not require a batch job to cancel requisitions at the ‘Requisition 
Review’ window. Requisition that was deleted/cancelled from the ‘Requisition Review’ 
window will be indicated ‘Cancelled in Requisition Release’ in the ‘Remarks’ block when 
queried. 
 
 
Procedures: 
 
To release requisitions to supply system, follow the procedures below: 
 

Note: Display the icon descriptions for easy identification of the displayed icons. To display the 
description, point and right click on any of the displayed icon and select “Show Text”. 

 
Step #1: LOGON to R-Supply and GoTo: Log>Release Outgoing 

Transactions>Requisitions. “Release Requisitions” window should be 
displayed. 
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Step #2: Select the appropriate ‘Radio’ button for the type of requisitions to be 
released on the ‘Selection’ option block. The following radio buttons are 
available for selection: 

 
- From Automatic Reorder Designates for Review/Release only 

transactions created via automatic reorder process. 
 

- Not From Reorder Designates for Review/Release only 
transactions created via requisitioning or the MRI 
process. 

 
- BP28 Selects all Budget Project 28 stock requisitions for 

released. Apply to NWCF Activities only. 
 

- Records on Hold Records on Hold are requisitions that have had 
multiple picking tickets created; i.e., one for the 
requested NIIN, and one or more for substitutes. The 
requisition remains on hold until all portions of the 
requests are completed. (Note: This situation happens 
only if the Process MRI based on OH QTY checkbox 
is selected. Refer to: Activity Control Info.) For 
example: If a user requests quantity of ten and three 
are available for the requested NIIN and two are 
available from a substitutes NIIN, which leaves a 
quantity of five to be ordered. The original_rqn is 
created for five and two picking tickets were created. 
One Picking Ticket is for the requested NIIN with 
quantity of 3EA and one for the substitute NIIN with 
the quantity of 2EA. The requisition for five is on hold 
until the two picking tickets are processed.  

 
Step #3: Select the appropriate ‘Radio’ button for the run criteria on the ‘Specify’ 

option block. The following radio buttons are available for selection: 
 

- All  Selects all requisitions for release. 
 

- Cog Enter a Cog. All outstanding requisitions for the Cog 
entered will be selected for release. 

 
- Doc Nbr Only document number entered is released. 

 
 
 

- Date/Srl Nbr Rng Enter the beginning and ending date and serial 
range. Only transactions within the entered range are 
selected for release. 
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- NAVSEA Only transactions with an applicable NAVSEA fund 

code is selected for release. 
 

- CASREP Only transactions with CASREP serial numbers are 
selected for release. 

 
- HI PRI Only requisitions with priorities of 1 through 10 are 

selected for release. 
 

- Routine Only requisitions with priorities of 11 through 15 are 
selected for release. 

 
- UIC Only transactions with the entered UIC are selected for 

release. (Force Level, NAS and MALS only) 
 

- Dept Enter a specific department code. Only transactions 
for the department entered are selected for release. 

 
Step #4: Verify to ensure “Review” checkbox is selected. This checkbox is selected 

by default. If you do not want to review the selected requisitions, deselect 
this checkbox. See notes below: 

 
Note: (1) If the Review checkbox is selected, all transactions meeting the 

criteria of the selection made in the Specify area will be 
displayed. If this option is not selected, records meeting the 
selection and specify criteria are selected for released. 

 
(2) BJN (Recovery Only) – select this checkbox to recover 

aborted/canceled jobs. Enter Batch Job Number.  
 
Step #5: Click “OK” button to continue. Requisition Review window should be 

displayed if ‘Review’ checkbox have been selected. If the “Review” 
checkbox was not selected, the ‘Requisition Review Message’ alert window 
will be displayed with the following message “Please wait while selected 
records are scheduled for release.” Click the “OK” button to continue. The 
‘Batch Request Confirmation’ window will be displayed with the Batch Job 
Number. Take note of the Batch Job Number. 

 
Step #6: Click “OK” button to submit the Batch Job. 
 
Step #7: Approve the Batch Job. GoTo: Site>Management>Site internal>Batch Job 

Scheduling>Approval. (Refer to: How to approve Batch Job document.) 
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Step #8: Verify the output. Compare hard copy output to the electronic output by 
going to: File>Utilities>Batch Review>Output File then select the Batch Job 
number and click ‘OK’ button to display the transactions. 

 
Step #9: Download the file by going to: File>Utilities>File Transfer. (Refer to: File 

Transfer Document.) 
 
Step #10: Transmit the transactions to the supply system via WinSALTS or any other 

means of transmission to the supply source. 
 
Step #11: Keep a copy of the outgoing message as proof of transmission to supply 

system. 
 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to set Batch Job ‘Control Parameter Indicators’ … 
 
Background Knowledge: 
 
Most R-Supply Batch Jobs required hard copy output or saved electronic copy of the 
output into the output or report directory (/h/data/local/SUP1BT/tape_out or 
/h/data/local/SUP1BT/reports). However, it all depends how you set the Control 
Parameters of that particular Batch Job. Control parameters or indicators can be set 
just before approving the Batch Job at the ‘Batch Job Approval’ queue, provided that 
the “Approval Required” indicator checkbox is set for the particular Batch Job 
(normally, this indicator is set during implementation). 
 
Procedures: 
 
To set the Batch Job control parameter indicators, follow the steps listed below: 
 
Step #1: Logon to R-Supply and GoTo: Site>Management>Site Internal>Batch 

Job Scheduling>Control Parameter Update. 
 
Step #2: Select the corresponding radio button for the target Subsystem. All 

available Batch Jobs for the selected subsystem will be displayed.  
 

Note: If you do not select any of the radio buttons, and close the ‘Control 
Parameter Update – Search’ window using the “Red X” on the upper 
right hand corner, all Batch Jobs will be displayed. However, the scroll 
bar will not appear to scroll up or down to see all the Batch Jobs. To 
scroll up or down to see all the Batch Jobs within R-Supply, use the 
wheel of your mouse or the “up” or “down” arrow on the Keyboard. If you 
have made any changes to the ‘Indicators’ to any Batch Jobs, make 
sure to click the “Apply” icon to save the changes. 

 
Step #3: Select a Batch Job and click “OK” button to display the ‘Control 

Parameter Update’ window.  
 
Step #4: Set or unset the applicable indicators exactly how you want the system 

handle the Batch Job request (i.e. Do you want a hard copy output? Do 
you want to save an electronic copy of the output? Do you want to 
schedule the Batch Job to run in a later time/date? Do you want to 
intercept all Batch Jobs that were submitted from other authorize users? 
Do you wish to have a restart capability? Do you want your output printed 
to a default printer?, etc.) All the preceding questions can be answered by 
setting the correct indicators by checking or un-checking the 
corresponding “Checkboxes”. 

 
Control Parameter indicators are listed below: 

 
Approval Required: It is highly recommended to set this 

checkbox to every Batch Job, so you (the 
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FAS) can intercept all Batch Job requests for 
your approval. Another important reason for 
setting this indicator is to verify the control 
parameter of the Batch Job just prior to 
approving the Batch Job to ensure proper 
indicators were set. To perform this 
verification, select the “Key” icon on the 
approval screen to display the ‘Control 
Parameter Update’ window. 

 
Allow Scheduling: This indicator when set, will allow the 

user to schedule a Batch Job to run in a later 
or specific date. 

 
Allow Restart: This indicator when set, will allow the user 

to restart the Batch Job where it left off if the 
Batch Job was interrupted or stopped during 
the process. There are some Batch Jobs 
that runs for 30 minutes or more. For 
example: You (the FAS) is printing the 
MSSLL and the Batch Job was running for 
15 minutes and suddenly a power surge, 
and the job was terminated. Instead of re-
running the Batch Job, you can just restart 
the Batch Job and the system picks up 
where it was terminated. 

 
Needs NTCSS Approval: Do not set this indicator unless 

necessary. There are currently no Batch 
Jobs in R-Supply that requires NTCSS 
Administrator approval. 

 
Debug: Do not set this indicator. This indicator is set buy 

the NTCSS Administrator when debugging 
the program. 

 
Print Output: Set this indicator when hard copy output is 

required. 
 

Save Printed Output: Set this indicator if you want the 
output saved into the report directory 
(/h/data/local/SUP1BT/reports). It is highly 
recommended to always set this indicator. 

 
Needs Device: You may not have permission to this 

indicator. 
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General Access Printer: You may not have permission to 
this option. 

 
Default Printer: Set this indicator if you want your output 

printed at the default printer. If not set, the 
program will display the available printer 
for selection. 

 
Step #5: Click the “Apply” icon to save the changes. The “Control Parameter 

Update – Search” window is displayed for another selection. 
 
 
Step #6: Click the “Cancel” button to exit from the ‘Control Parameter Update – 

Search’ window. 
 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to process SFOEDL through Batch Posting by Code…  
 
Background Knowledge: 
 
Summary Filled Order Expenditure Difference Listing (SFOEDL) is a monthly listing of 
unmatched billing transactions from DFAS. Transactions included in monthly SFOEDL are 
assumed charges or credits to your OPTAR dollars. It can financially ruin an Activity if 
transactions are not monitored regularly. But first, let’s understand why SFOEDL charges 
or credits were created? Understanding the process of how you get there will tremendously 
help the Activity minimize the number of SFOEDL charges or credits. So, how did it start? It 
all started from you (the Activity) of not understanding what transactions may become 
potential SFOEDL charges or credits. 
 
Here are some of the most common causes of SFOEDL: 
 

- Sending offline DTO requisition to the supply system or supply source without 
obligating the total money value of the cost of the material or services. 

 
- Unit price in the item table does not match with the unit price of the item at the 

supply sources. This is caused by not processing the monthly change notice and 
annual price change notice. Remember, when you process DTO requisitions (with 
NSN), the system will take the unit price from the item table as the value of your 
obligation. These obligations are sent to DFAS every 8th days (Weekly Transmittal) 
to match with the billings from the supply sources. If the obligated money value does 
not equal to the billing from the supply source, then the transaction becomes 
SFOEDL charge or credit. 

 
- Carcass charges. Ensure to monitor DLR processes in a daily basis to avoid 

potential carcass charges. Make sure you reply to all BK1s and other NRFI inquiries 
from NAVICPs. Also, ensure to review ‘Net Unit Price’ in item table. If ‘Net Unit 
Prices’ is not correct compared to FEDLOG, then the possibility of additional billing 
exist. 

 
- Monitor the RPPOs (Repair Part Petty Officers) for ‘Walk-through’ and ‘Bearer Pick-

up’. Make sure RPPOs understand the consequences of not letting Supply know of 
everything they order to other supply sources (i.e. FISC, Open purchase, Credit 
Card charges, etc.). 

 
- and others... 

 
 
Well, of course it is almost impossible to match all billings from the supply sources due to 
price variations. However, it can be minimized by training all participants (i.e. RPPO, Stock 
Control personnel, etc.).  
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Procedures: 
 
To post SFOEDL Differences by Find Code (Batch Posting), follow the steps listed below: 
 

Note: The below procedures are applicable to Submarine Force and other 
Activities that do not utilize SMARTS procedures in posting SFOEDL 
Differences.  

 
Step #1: Download your SFOEDL in timely manner. Dates are specified when the 

Activities can download their respective SFOEDL from the specified site. 
SFOEDL Listing for Activities that are not supported to these procedures will 
be mailed to the Activity on the second week of each month. 

 
  Note: Summary of differences by Fund Code should be listed towards 

  the end of the listing. 
 
Step #2: Logon to R-Supply. Menu Path: Fin>Reconciliation> SFOEDL Individual 

Requisition Fund Code Differences. 
 
Step #3: Enter the ‘Listing Month/Year’ of the SFOEDL (in this Format: Jul 2010)… 

then enter a new document number with Julian Date that falls within the 
SFOEDL month for the Fiscal Year. (Note: You may use the document series 
assigned to Supply or you may use any document series (i.e. SF01 through 
SF99). If you use a series that is not within the ‘Activity Organization Info’ 
table, the SFOEDL value will display in 7X Div. or ZX Div. for AOM). If you are 
using a document series that are not on the ‘Activity Organization Info’ table, 
you will be prompted with an ‘Alert’ window.  Click ‘Yes’ to continue. 

 
Step #4: Enter the target ‘Fund Code’… then enter the value of the fund code 

difference. Select the correct radio button to effect ‘Debit’ or ‘Credit’. If you 
select ‘Debit’, this will decrement your OPTAR balance and ‘Credit’ will add 
this amount to the OPTAR balance. 

 
Step #5: Click ‘OK’ button to continue. 
 
Step #6: Click ‘Apply’ icon to process the adjustment. 
 
Step #7: Verify the values of the target Fund Codes or Dept/Div at the ‘Budget 

Management’ window. 
 
 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to process SFOEDL into ‘SMARTS’ program …  
 
Background Knowledge: 
 
Summary Filled Order Expenditure Difference Listing (SFOEDL) is a monthly listing of 
unmatched billing transactions from DFAS. Transactions included in monthly SFOEDL are 
assumed charges or credits to your OPTAR dollars. It can financially ruin an Activity if 
transactions are not monitored regularly. But first, let’s understand why SFOEDL charges 
or credits were created? Understanding the process of how you get there will tremendously 
help the Activity minimize the number of SFOEDL charges or credits. So, how did it start? It 
all started from you (the Activity) of not understanding what transactions may become 
potential SFOEDL charges or credits. 
 
Here are some of the most common causes of SFOEDL: 
 

- Sending offline DTO requisition to the supply system or supply source without 
obligating the total money value of the cost of the material or services. 

 
- Unit price in the item table does not match with the unit price of the item at the 

supply sources. This is caused by not processing the monthly change notice and 
annual price change notice. Remember, when you process DTO requisitions (with 
NSN), the system will take the unit price from the item table as the value of your 
obligation. These obligations are sent to DFAS every 8th days (Weekly Transmittal) 
to match with the billings from the supply sources. If the obligated money value does 
not equal to the billing from the supply source, then the transaction becomes 
SFOEDL charge or credit. 

 
- Carcass charges. Ensure to monitor DLR processes in a daily basis to avoid 

potential carcass charges. Make sure you reply to all BK1s and other NRFI inquiries 
from NAVICPs. Also, ensure to review ‘Net Unit Price’ in item table. If ‘Net Unit 
Prices’ is not correct compared to FEDLOG, the possibility of additional billing exist. 

 
- Monitor the RPPOs (Repair Part Petty Officers) for ‘Walk-through’ and ‘Bearer Pick-

up’. Make sure RPPOs understand the consequences of not letting Supply know of 
everything they order to other supply sources (i.e. FISC, Open purchase, Credit 
Card charges, etc.). 

 
- and others... 

 
Well, of course it is almost impossible to match all billings from the supply sources due to 
price variations. However, it can be minimized by training all participants (i.e. RPPO, Stock 
Control personnel, etc.).  
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Procedures: 
 
To process SFOEDL through SMARTS Program, follow the steps listed below: 
 

Note: The below procedures are not applicable to Submarine Force. 
Submarine Force is utilizing the ‘Batch Posting’ by fund code 
procedures. Document Number Series used in posting SFOEDL 
values will be configured as follows: UIC – (Julian Date of SFOEDL) – 
SFxx… xx is 01 through 99.  Menu Path: Fin>Reconciliation> 
SFOEDL Individual Requisition Fund Code Differences. 

 
Step #1: Download your SFOEDL in timely manner. Dates are specified when the 

Activities can download their respective SFOEDL from the specified site. The 
downloaded file must end with .sfo to be valid for processing into SMARTS 
(Ships and MALS Automated Reconciliation Tracking System). 

 
Step #2: Logon to R-Supply and perform ‘File Transfer’ (Refer to: ‘File Transfer’ 

procedures) of the SFOEDL input file (the file name must end with .sfo to be 
valid) to process JSS275. 

 
Step #3: Verify the “Input File”. GoTo: File>Utilities>Batch Review. Select the ‘Input 

File’ radio button. Select the process JSS275 and click the ‘OK’ button or you 
may double click the process JSS275 to display the input transactions. Spot 
check documents to ensure all transactions in SFOEDL were uploaded. If not, 
delete the file (JSS275) then reprocess the ‘File Transfer’. 

 
Step #4: Submit and run the Batch Job (JSS275). GoTo: Site>Management>Site 

Internal>Batch Job Scheduling>Predefined Parameters. Select process 
JSS275 - SMARTS SFOEDL Transfers.  JSS275 is used to batch in the 
SFOEDL images for the SMARTS interface process.  

 
Step #5: You may produce SFOEDL Reports at this point prior to processing the 

JSS280. GoTo: Fin>Management>Financial Reports>SMARTS Reports. 
Select the required reports. (See SMART report options on page 4 & 5) 

 
Step #6: Verify and take notes of the current ending value of your OPTAR. This value 

may change, due to value of charges and credits after processing JSS280. 
 
Step #7: Submit and run the Batch Job (JSS280). GoTo: Site>Management>Site 

Internal>Batch Job Scheduling>Predefined Parameters. Batch Job JSS280 
will process and post all S76 Financial Adjustments (Charges and credits). 
After completion of Batch Job JSS280, all charges and credits to your OPTAR 
should have been posted.  

 
  
 
 

125



DRAFT 

 
Sheet 3 of  5 

 
Prepared by: Lonnie Auza – SPAWAR Norfolk  

Alison Williams – NAVSUP  
http://www.force-rsupplyViking.com or www.force-rsupply.com  

 

Notes:  
  
(1) All charges to OPTAR with document series that do not exist in 

document serial numbers use by Activity will display under '7X' 
for S&E and 'ZX' for AOM Division. This includes stock 
requisitions (For End-Use Activities Only). 

  
(2) SFOEDL adjustments are identified as DI X76 on the 

financial_adjustment table. 
 
Step #8: Again, you may produce SFOEDL Reports at this point after processing the 

JSS280 for verification. GoTo: Fin>Management>Financial Reports> 
SMARTS Reports. Select the required reports. (See SMART report options on 
page 4 & 5) 

 
Step #9: Verify the ending value of your OPTAR. After successful completion of the 

Batch Job JSS280, charges and credits were applied to your financial 
ledgers. Compare this value to the value from Step #6. The difference of the 
ending value of your OPTAR should equal to the value of ‘charges and 
credits’ summary of the current SFOEDL.  

 
Note: After completion of Batch Job JSS280, all SFOEDL transactions 

should have been posted to the Financial Adjustment and TL 
Queue Fin table. The adjustment and processed date is also 
posted to the Financial Adjustment table. In addition, JSS280 
deletes all Auto-worked records from the SMARTS Data table. 
The only records in SMARTS Data table after the completion of 
JSS280 are those transactions set to Not-worked. These are the 
transactions whose values are equal to or greater than the set 
threshold located in ‘Controls’ tab of the Activity Control Info 
window. 

 
Step #10: Process your challenges. GoTo: Fin>Reconciliations>SMARTS. Select 

OPTAR Category to be processed. Select the applicable S&E type and 
category (not worked is default). Documents with money value equal to or 
greater than the threshold dollar value will be displayed. Review and conduct 
research for documents that need to be challenged. 

 
Note: Do Not Run “LIVE MONTHLY FINANCIAL” prior to completion of 

SFOEDL Challenges. Review and you may challenge above 
threshold dollar value transactions. Remember that your Activity 
have been charged or credited with all these charges/credits. 
Your job is to persuade DFAS that the charges/credits therein 
were invalid hoping that DFAS will reverse the charges (if you 
can prove it to them) or credits as applicable. So, you better 
have proof that the charges were invalid when challenging 
invalid charges. 
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Step #11: Submit the Challenge Report to DFAS. Print a copy of the Challenge Report 

for your record.  
 

Note: If DFAS accept your challenges, it will be included on the next 
SFOEDL as Credits. So make sure you keep track of all the 
challenged documents. It’s your money. 

 
Step #12: “LIVE MONTHLY FINANCIAL” maybe run at this point in time. (Note: Live 
Monthly Financial should be run as close as possible to the end of the current month to 
capture all the expenses incurred for the current month.) 
 
 
 
Very Important Notice:  
 
DO NOT PROCESS ‘LIVE MONTHLY FINANCIAL’ BEFORE PROCESSING THE 
CHALLENGES.  
 
If you process a LIVE MONTHLY FINANCIAL prior to processing challenges and try to 
post challenges, you will receive the following database error: "This financial adjustment 
was transmitted (trnsmtl_no = xx, fiscal_yr = xxxx) trnsmtl_dt = xx/xx/xxxx!  Further 
changes to data are not allowed!" These transactions will purge off the ‘smarts_data’ table 
based on the ‘smarts_data.purge_dt’ plus the number of days set for purge on Activity 
Control Info ‘Controls’ tab. When you run the next SFOEDL Transfer (JSS275), 
transactions that are "HANG" up in ‘smarts_data’ table will be purged.  If the activity did 
not post SFOEDL challenges and the transaction needs to be challenged, you will need to 
do it manually. 
 
Currently, do not load or process UOL transactions through SMARTS/RSupply. UOL 
transactions need to be processed manually at the following menu path: 
Fin>Reconciliations>UOL. 
 
SMART Report Options 
 
The Parameters area contains a series of options to customize reports. The following 
parameter options are available: 
 
Detail   Pulls reports from the SMARTS data table 
 
Summary  Pulls reports from the financial adjustment table 
 
Outstanding Used for the SFOEDL Challenge report and Aged SFOEDL Challenge 

report 
 
Completed  Used with SFOEDL Challenge report 
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Error Report Used with SFOEDL to print a report of all transactions that error out 
during the JSS280 batch job 

 
The SFOEDL area provides various options for printing SFOEDL reports. The following 
SFOEDL options are available: 
 
Differences Identifies all credit and debits received by SMARTS with a "DI" field 

containing S76 
 
Credits All rows identified in the SMARTS data table with a "DI" field containing 

S76 and the "amt" field containing a negative (credit) amount 
 
Services  All rows identified with a service Fund Code 
 
Carcass Carcass transaction is recognized by the word CARCASS in the 

remarks column of the SMARTS data table 
 
Partial Order Established A Partial Order Established is recognized by the words PT ORD 

EST in the remarks column 
 
Challenge Report This printed Report is a list of all Challenges awaiting response from 

the units Authorized Accounting Activity 
 
Current This report lists transactions challenged for the current processing 

month awaiting response from the units Authorized Accounting Activity 
or Type Commander 

 
Aged Challenge Report This Report is a list of transactions that have been previously 

challenged, but no response has been received from the units 
Authorized Accounting Activity and/or Type Commander 

 
Above Threshold This Report lists all SFOEDL above Threshold Dollar Values from 

SFOEDL reports. The value set for this report is found in Activity 
Controls tab within R-Supply (Site>Activity Controls>Activity Control Info). 

 
Below Threshold This Report lists all SFOEDL ‘Below Threshold Dollar Values’ from 

SFOEDL reports. The value set for this report is found in Activity 
Controls tab within R-Supply (Site>Activity Controls>Activity Control Info). 

 
 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to find Source, Maintenance & Recoverability Code in OMMS NG …  
 
Background Knowledge: 
 
As a supply support person, it is important to know how and where to find SM&R Code for 
a particular item/NIIN. Since not all items in your stock_item table do not have an 
APL/SM&R Code cross-reference, you need to know how and where to find the SM&R 
Code in OMMS NG.  
 
To access the SM&R Code, follow the steps listed below for the following situations: 
 

• If NIIN is available, follow procedures in paragraph A.  
• If the APL/AEL is available, follow procedures in paragraph B.  

 
Procedures: 
 

Note: Display the icon descriptions for easy identification of the displayed icons. To display the 
description, point and right click on any of the displayed icon and select “Show Text”. 

 
A. If NIIN is available, follow the steps listed below: 

 
Step #1: LOGON to OMMS NG and GoTo: File>New List or select the 3rd icon on the 

icon toolbar to display the ‘New List’ window. 
 
Step #2: Select the “Parts” button on the ‘New List’ window to continue. 
 
Step #2: Enter the target “NIIN” on the ‘NIIN’ data field. 
 
Step #4: Click the “Create List” button or press ‘Enter Key’ on the keyboard. 
 
Step #5: Write down the available APL/AEL. 
 
Step #6: Click the “Cancel” button. 
 
Step #7: Click the “Yes” to cancel changes. 
 
Step #8: Click “Close” button to close window.  
 
Step #9: GoTo: File>New List or Click the 3rd icon from the left.  
 
Step #10: Click the “Configuration Item” button.  
 
Step #11: On the APL/AEL block, select the “Specific” radio button and enter one of the 

APL/AEL from Step #5. 
 
Step #12: Click the “Create List” button or press “Enter Key” on the keyboard. If ‘Error’ 

prompt says “No data meets selected criteria”, verify the APL/AEL to ensure 
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the APL/AEL is correct. If the APL/AEL is correct, this means the component 
is not installed onboard. In-depth research is required for this APL/AEL. 

 
Step #13: Click the “GoTo” button. 
 
Step #14:  Select “APL/AEL Info” tab. 
 
Step #15:  Select “Parts List” radio button to display NIINs. 
 
Step #16: Locate and double click the NIIN to display the “Supplemental 

Information” data window. You should see nine buttons to the left of the 
display window. 

 
Step #17: Select “Source” button to display the 1st and 2nd digit of the SM&R Code. 

Code is displayed on the “Text” area. 
 
Step #18: Select “Use Maintenance” button to display the 3rd digit of the SM&R Code. 

The code is displayed on the ‘Code’ area and the description of the Code will 
be displayed on the ‘Text” area. 

 
Step #19: Select “Repair Maintenance” button to display the 4th digit of the SM&R 

Code. The code is displayed on the ‘Code’ area and the description of the 
Code is displayed on the ‘Text’ area. 

 
Step #20: Select “Recoverability” button to display the 5th digit of the SM&R Code. The 

code is displayed on the ‘Code’ area and the code description is displayed on 
the ‘Text’ area. 

 
Step #21: Select “Supplemental Source” button to display the 6th digit of the SM&R 

Code. This code is optional. 
 
Step #22: Select “Allowance Note” button to display the ‘Note’ Code. 
 
Step #23: Select “Allowance Override” button to display the override code. 
 
Step #24: Click “OK” to close the ‘Supplemental Information’ window. 
 
Step #25: Click “Close” button to close current window. 
 
Step #26: Click “Cancel” button … then “Yes” on the prompt to close current window. 
 
Step #27: Click “Close” button to get back to OMMS NG main screen. 
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B. If APL/AEL is available, follow the steps listed below: 
 
Procedures: If APL/AEL is available, follow the steps listed in Step #9 through Step # 27 of 

paragraph A. 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to spot erroneous Storeroom locations or locations outside of the 
item’s primary Storeroom location …  
 
Background Knowledge: 
 
Erroneous location and multiple locations assigned to storeroom items will slow down 
the process of issuing material to the customer. If there’s a need to assign multiple 
location for certain items, assigned a location that is adjacent or located in the same 
Storeroom to speed up verification and inventory of the item.  
 
As you already know, location consolidation is a continuous process. Batch Job JSS160 
can be generated to aid location consolidation or Ad hoc query is another option to pull 
out a listing for storeroom location verification. Consider the tasking below. 
 
Tasking: Run Ad hoc Query to display the following data: niin, location number, 

location precedence, and location quantity. The list should be displayed in 
niin sequence. Output will be used to spot erroneous locations. 

 
Procedures: 
 
To create the Ad Hoc parameters for above tasking, follow the steps listed below: 
 
Step #1: LOGON to R-Supply and GoTo: File>Utilities>Ad hoc Query>Expert. This 

will open the ‘Relational Supply Ad Hoc Query in Expert Mode. 
 
Step #2: Select File>New or select the first icon to the left hand side of the icon 

toolbar. This will open the “Query Checklist” window with only “Tables” 
button being active. 

 
Step #3: Select ‘Tables’ button to display all available R-Supply database tables for 

selection. “Database Tables” window consist of two display boxes: 
‘Available Items’ to the left hand side listing all available database tables 
and to the right hand side display box is the ‘Selected Items’ that display 
the selected database table or tables to be used during the process. 

 
Step #4: Select the database Table or Tables: On the ‘Available Items’ display box, 

scroll up or down to locate and select the item_loc table... then click “Add” 
button or simply double click the database table. Item selected will be 
displayed on the “Selected Items” display box. 

 
Step #5: Click “OK” button to continue. The “Query Checklist” window will redisplay 

for the next step. 
 
Step #6: Select “Columns” button to display the ‘Database Columns’ window. This 

window displays all data element names for the selected database table 
or tables from Step #4. 
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Step #7: Select the “Columns” (data element names) to be displayed on the output. 

Select the following data element names: item_loc.niin, 
item_loc.location_number, item_loc.location_precedence, and 
item_loc.onhand_quantity. These data element names are the column 
headers of the output. To select the item, select and click “Add” button or 
simply double click the item. Selected items will be displayed on the 
“Selected Items” display box.  

 
Note: The columnar sequence of the output can be re-arranged if 

you want. To re-arrange the columnar sequence, select the 
item on the ‘Selected Item’ display box and select “Move item 
up” or “Move item down”… one click at a time. 

 
Step #8: Click “OK” button to accept the columns selected. Again, the “Query 

Checklist” window will redisplay for the next step. 
 
Step #9: At this point, criteria or calculation or sort or group may be selected if 

applicable. The above tasking only calls for NIIN sequence. However, the 
default sequence is NIIN. Therefore, none of the buttons mention above is 
applicable. Proceed to the next step. 

 
Step #10: Select “Run Query” button to display the ‘Query Impact’ window. On the 

‘Query Impact’ window, it will indicate the number of rows to be retrieved or 
displayed. An alert window will display if the rows to be retrieved is more 
than 10,000 rows. If it is, click “OK” button and the output must be split into 
two or three runs to have an output of less than 10,000 items per output. 
Ad hoc Query program will only display the first 10,000 rows per run. The 
output can be split by limiting the number of rows to be retrieved to less 
than 10,000 rows using the “Criteria” option. 

 
Note: If the number of rows to be displayed is less than 10,000 rows 

or if you want to display the first 10,000 rows only, you may 
proceed by selecting the “OK” button to start the program.  

 
If the expected output is more than 10,000 rows and you 
want all rows displayed on the expected output, select 
“Close” button to close the “Query Impact” window and get 
back to ‘Query Checklist’ window… then see Step #12 and 
follow the procedures how to split the output.  

 
Step #11: Select the “Criteria” button to create the split criteria parameters. 
 
Step #12: Create the split criteria parameters. If the expected output is more than 

10,000 rows but less than 20,000 rows, the output will be split into two 
runs. If the expected output is more than 20,000 rows but less than 30,000 
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rows, the output will be split into three runs and so on… Splitting the output 
into several runs is just a matter of selecting a range of NIINs for the 
“Criteria”. (See example below.) 

 
 Example #1: Two runs for over 10,000 rows but less than 20,000 rows: 
 

For the first run, select item_loc.niin as the “Criteria” item and 
“Operator” set to (<) Less Than and the “Condition” is set to 
009999999.  Select “Accept” button to accept the criteria 
parameters. Criteria parameter or parameters will be displayed on 
the criteria display box. Above criteria parameter will display all 
NIINs that are below 00-999-9999. Select “OK” button to close the 
‘Criteria’ window… then select “Run Query” button on the ‘Query 
Checklist’ and select “OK” button on the ‘Query Impact’ window to 
start the program. 
 
For the second run, change the “Operator” to (>=) Greater Than 
or Equal To. Do not change the condition. This will display NIINs 00-
999-9999 and up. To change the ‘Operator’, select the criteria 
parameter to be changed then select “Modify” button to redisplay the 
criteria parameter. Make the ‘Operator’ change then select ‘Replace’ 
button to effect the change. Select “OK” button to close the ‘Criteria’ 
window… then select “Run Query” button on the ‘Query Checklist’ 
and select “OK” button on the ‘Query Impact’ window to start the 
program. 
 

 
  Example #2: Three runs for over 20,000 rows but less than 30,000 rows. 
 

For the first run, the “Criteria” item should be NIIN having the 
“Operator” set to (<) Less than and the “Condition” is set to 
008000000 (or choose the ideal cut-off). This will pick up all NIINs 
below 00-800-0000 (or whatever cut-off NIIN you choose). Select 
“OK” button to close the ‘Criteria’ window… then select “Run 
Query” button on the ‘Query Checklist’ and select “OK” button on 
the ‘Query Impact’ window to start the program. 
 
 
For the second run, select two ranges of NIINs. Select 
item_loc.niin as the criteria with “Operator” set to (>=) Greater Than 
or Equal To and ‘Condition’ is set to 008000000. Go back to 
“Possible Criteria Items” and select item_loc.niin again and set the 
“Operator” to (<=) Less Than or Equal To with the “Condition: set 
to 013000000. Above criteria will select and display NIINs between 
00-800-0000 and 01-300-0000. Select “OK” button to close the 
‘Criteria’ window… then select “Run Query” button on the ‘Query 

 
Sheet 3 of  4 

 
Prepared by: Lonnie Auza – SPAWAR Norfolk 

http://www.force-rsupplyViking.com or www.force-rsupply.com  
134



DRAFT 

 
Sheet 4 of  4 

 
Prepared by: Lonnie Auza – SPAWAR Norfolk 

http://www.force-rsupplyViking.com or www.force-rsupply.com  

Checklist’ and select “OK” button on the ‘Query Impact’ window to 
start the program. 
 
 
For the third run, delete the criteria with NIIN 008000000. Change 
the “Operator” to (>=) Greater Than or Equal To. Do not change the 
“Condition”. This will display NIINs 01-300-0000 and up. Select 
“OK” button to close the ‘Criteria’ window… then select “Run 
Query” button on the ‘Query Checklist’ and select “OK” button on 
the ‘Query Impact’ window to start the program. 
 
 

Note: To delete a ‘Criteria’ item, select the criteria parameter 
on the criteria display box… then select “Delete” 
button to delete the criteria parameter. To modify a 
criteria item, select the criteria line item and select 
“Modify” button to redisplay the ‘Criteria’ item. Make 
changes to the criteria parameters then click or select 
“Replace” button to replace the criteria parameters. 

 
 
 
Action required to the output: 
 

No person other than yourself is familiar with the Storeroom location configuration 
of your stock material Storerooms. Verify the output by eyeballing through the 
output paying close attention to NIIN and Location number. Ensure the location 
configuration met the standard numbering system as it exists in your Activity. You 
can easily spot the erroneous location since it will stand-out the rest of the items. 
If you spot a NIIN with multiple location (indicated by NIIN appearing more than 
once with different locations, especially those shelf-life items indicated with 
expiration dates as locations), verify if the locations are in the same storeroom. 
You may initiate location consolidation if applicable. If locations are from various 
storerooms, you may initiate location consolidation or at least the item is located 
in one storeroom even if additional location is needed. This will speed up the 
material issue process. 

 
Perform and run this Ad hoc query one chunk at a time… overtime you will have 
an outstanding Storeroom location management. 

 
 
 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to “Reconcile Stock and DTO (Direct Turn-Over)” dues …  
 
Background Knowledge: 
 
You may ask why the Activity needs to reconcile the due-ins for Stock and/or DTO 
requisitions. As you may already know, due-in management is critical to the success of 
good Stock Control management. Here’s why it is critical to reconcile the stock and/or 
DTO dues: dto_due_qty and stock_due_qty are data elements in stock_item table.  
When you submit a DTO or Stock requisitions, the dto_due_qty or stock_due_qty data 
field in stock_item table will reflect the total quantity outstanding for those outstanding 
documents and the corresponding outstanding requisitions is posted in active_rqn table. 
When requisitions are completed or partially completed (received/cancelled), due-in 
quantities from the stock_item table will be decremented with the quantities received or 
cancelled. However, in some instances, this is not happening. The document is 
completed in the active_rqn table. However, the due-in quantity in stock_item table 
was not decremented. If the due-in quantities are not updated on the stock_due_qty or 
dto_due_qty, it becomes record discrepancies. For stock requisition, due-in quantity will 
be accounted for when you run a “reorder” (depending on computation used). If this 
happen, the invalid stock due-in quantity on the stock_due_qty in stock_item table will 
prevent the reorder of stock deficiencies. 
 
Considering the preceding scenario, your stock record will reflect a 100% O/H plus on 
order after completion of the top-off “reorder” process. In reality, you are not, because of 
the invalid stock due-in quantity that is hanged-up on the stock_due_qty data field in 
stock_item table. These due-ins does not have an outstanding stock requisitions. 
 
To correct the discrepancy, R-Supply has a built-in function or database alignment 
program (Stock/DTO Dues Reconciliation Program) that clears up those invalid due-in 
quantities. The Stock/DTO reconciliation program will reconcile the due-in quantities in 
the stock_item table to its corresponding outstanding requisitions in the active_rqn table. 
If due-in quantities are present on the dto_due-qty or stock_due_qty data field in 
stock_item table, the program will verify the active_rqn table for its corresponding 
outstanding requisitions. If there are no outstanding requisitions for that particular item, 
the due-ins will be deleted from the stock_item table. On the other hand, if there are 
outstanding requisitions in the active_rqn table, the total due-ins from the outstanding 
requisitions will be posted or reflected in the due-in qty field in stock_item table. This 
program should be run at least weekly at the minimum. It will only take a few minutes to 
run. When running the ‘Stock/DTO reconciliation program, make sure to unchecked the 
‘Report Only’ checkbox. 
 
Procedures: 
 
To run the program, follow the steps listed below: 
 
Step #1: LOGON to R-Supply and GoTo: File>Utilities>Stock/DTO Dues 

Reconciliation. 
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Step #2: All checkboxes are pre-selected as default. This will produce report only 

without affecting the database. Select either ‘Stock’ or ‘DTO’ or both 
options for reconciliation. Uncheck the “Report Only” checkbox to effect 
reconciliation of the database. Un-checking or deselecting the “Report 
Only” checkbox will also produce the hard copy report (depending on the 
‘Control Parameter Indicator’ settings) and at the same time effect 
reconciliation of the database. 

 
Step #3: Click “Apply” icon to initiate the Batch Job. 
 
Step #4: Click “OK” button to submit the Batch Job. 
 
Step #5: Release the Batch Job to NTCSS for processing. GoTo: Site> 

Management>Site Internal> Batch Job Scheduling>Approval. This step is 
applicable only if the “Approval Required” indicator on the Control 
Parameter Update window is set. Otherwise, the Batch Job is automatically 
release to NTCSS for processing. 

 
Step #6: Review the output. No actions required. However, if you selected ‘Report’ 

only and there are some items on the report, you must go back and 
resubmit and run the Batch Job with ‘Report Only’ checkbox being not 
selected to effect changes to the database. Retain output for the record 
until the next scheduled run. 

 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to process ‘Stock Survey’ …  
 
Background Knowledge: 
 
What is ‘Stock Survey’? Stock Survey is defined as the process of documenting stock 
adjustment (either loss or gain) with DD Form 200. What transaction qualifies for 
documenting with DD Form 200? Any stock adjustment equal to or greater than $2,500 
or DLR (7_COG) regardless of money value must have Survey Document (DD Form 
200) on file signed by the Commanding Officer or his/her designate. Transactions 
requiring stock survey document is displayed at the ‘Stock Survey Update’ window 
(Menu Path: Inv>Inventory Control>Stock Survey Update). The prime purpose of ‘Stock 
Survey Update’ display window is to alert the User that stock adjustments (Gain or Loss) 
has been processed against those items with the threshold dollar value mention above. 
Stock Survey update function is used to complete and document Survey adjustments. 
Once the DD Form 200 is prepared and signed, go back to: Inv>Inventory Control>Stock 
Survey Update… select the ‘Survey Created’ checkbox of the target expenditure 
document and click ‘Apply’ icon to complete the process. File the signed DD Form 200 
for SMC inspector. 
 
Procedures: 
 
To process Stock Survey, follow the steps listed below: 
 
Step #1: LOGON to R-Supply and GoTo: Inv>Inventory Control>Stock Survey 

Update. Expenditure document(s) should be dislayed. 
 
Step #2: Verify all records posted or listed on the ‘Stock Survey Update’ window. 

Each line item must have a causative researched documentation 
documenting the event why the inventory adjustment occurs. When the 
exhaustive researched is completed, a Survey Form (DD Form 200) must 
be completed and have the Commanding Officer or his/her designate 
signed the Survey document. These documents maybe required by the 
SMC inspector during the Activity’s Supply Management Certification 
process. 

 
Step #3: After the Survey document is signed, LOGON to R-Supply and GoTo: 

Inv>Inventory Control>Stock Survey Update and complete the Survey by 
checking the ‘Survey Created’ checkbox beside the expenditure document 
number. 

 
Step #4: Click “Apply” icon to complete the Stock Survey process. 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to submit and approve R-Supply Batch Job …  
 
Background Knowledge: 
 
Submitting and/or approving Batch Job is normally done by the FAS (Functional Area 
Supervisor). Other R-Supply Users may not have permission to perform this task. There 
are two types or categories of Batch Jobs in R-Supply. They are: Predefined and Non-
predefined parameters Batch Jobs. Predefined Batch Jobs are batch jobs that when 
submitted, the User does not have the option to select or set the parameters/options of 
the intended results of the Batch Job. Whereas, Non-predefined batch jobs when 
submitted, the User has the option to set the available parameters and other options to 
tailor the expected output of the Batch Job. Example of Non-predefined batch job is 
“Reorder” process. In reorder process, the User has the option to set overseas indicator 
or has the option to reorder a specific type of material. Most non-predefined Batch Jobs 
are submitted via the “Management” options within the “Inventory”, “Logistics” and 
“Financial” Subsystems whereas, predefined batch jobs are normally submitted via 
“Site” Subsystem (Menu path: Site>Management>Site Internal>Batch Job 
Scheduling>Predefined Parameters… then Select a predefined Batch Job. 
 
Procedures: 
 
For demonstration purposes, submit the Batch Job request for SAMMA/SAL report.  
 
To submit the batch job for SAMM/SAL, follow the steps listed below: 
 
Step #1: Logon to R-Supply and GoTo: Inventory>Management>Inventory 

Reports>SAMMA/SAL. 
 
Step #2: Set or Select available options and parameters. 
 
Step #3: Click “Apply” to submit the Batch Job. Batch Job Number is assigned. 
 
  Batch Job Number is 13 digits configuration: JSI217-9015-005  
 
 The third digit of the Batch Job Number designate the Subsystem 

(e.g. JSF (Financial), JSI (Inventory), JSL (Logistics), or JSS Site)) 
 
   Breakdown of the above Batch Job Number: 
 
    JSI –  Batch Job is run in “Inventory” Subsystem 
    217 –  Process number (SAMMA/SAL) 
    9015 – Four Digits Current Julian Date 
    005 – Batch Job serial number (001 thru 999) 
 
Step #4:  Click “OK” button to submit the Batch Job and place this batch job into 

approval queue (if the ‘Approval Required’ indicator for this job is set. 
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Batch Job Control Parameters are set at the Control Parameter Update 
screen. (See the procedures on How to set the Batch Job indicators at the Control 
Parameters Update – Search window.) “Approval Required” indicator in most R-
Supply Batch Jobs are set to ‘On’… so (you, the FAS) will have the chance 
to intercept the Batch Job for approval at the ‘Approval’ queue and verify 
the Batch Job indicators. 

 
Step #5: Approve the Batch Job. GoTo: Site>Management>Site Internal>Batch 

Job Scheduling>Approval. (This step applies only if the “Approval Required” 
indicator is set for the particular Batch Job. If the ‘Required Approval’ checkbox is 
unchecked, the Batch Job is automatically approved and released to NTCSS for 
processing.) Approve the Batch Job by typing “R” in the ‘Status’ field column.  

 
Note: Prior to approving or releasing the Batch Job to NTCSS for 

processing, it is highly recommended to verify the Control 
Parameter of the Batch Job to ensure proper indicators are 
selected. To verify, double click or select the Batch Job and 
click the “Key” icon on the toolbar. The Control Parameter 
Update screen will be displayed. Ensure correct indicator or 
indicators are activated (meaning… a checkmark is displayed 
on the corresponding checkboxes). There are times that the 
FAS will run a Batch Job to check for something in database. 
In this case, you may turn-off the “Print Output” indicator to 
save time, paper and printer ink. If you turn-off the hard copy 
printing, make sure the “Save Output” indicator is set … 
otherwise, you will not see any output at all. Also, if the ‘Print 
Output is unchecked, make sure the default printer is also off 
(unchecked) 

 
Step #6: Check the status of the Batch Job. (GoTo: NTCSS Toolbar>System>Batch 

Job Queue) Select R-Supply application… then select the ‘Approve’ radio 
button on the ‘Job Status’ block. Most of the time, the Batch Job is already 
completed before you get to the Batch Job Queue. 

 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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How to process ‘Suspended’ transactions in R-Supply …  
 
Background Knowledge: 
 
R-Supply transactions are subjected to a series of validation checks before it is recorded 
or written into the database tables. Any transaction that does not meet the criteria during 
transaction validation will be written into the ‘suspense’ table for corrective actions. 
These transactions must be researched, corrected and processed daily. Suspended 
transactions maybe deleted only after exhaustive researched have been conducted with 
positive results. Once deleted, it will be written into the stk_rpt table for ‘Stock Control 
Review’ listing. These transactions are indicated as “Cancelled in Suspense”. 
 
Procedures: 
 
To process suspended transaction, follow the step-by-step procedures listed below: 
 
Step #1: Print the suspense report. GoTo: Log>Management>Logistics Reports> 

Suspense Listing. Select a ‘Function’ category or you may print all 
suspended transactions by selecting ‘All’ checkbox/option… then select 
‘Sort by’ option. 

 
Step #2: Review the ‘Suspense’ report. If ‘All’ option was selected to print the 

suspended transactions, process the suspended transaction in the 
following importance category: (1) ‘MRI’, (2) ‘Receipt’, (3) ‘Status (Supply), 
(4) and others…. 

 
Step #3: Process the suspended transaction one-at-a-time. GoTo: Log> 

Suspense… then select the target ‘Function’. Reason for suspension is 
indicated at the SSP Description field when suspended transaction or 
document is selected. 

 
Step #4: Annotate the corresponding suspended document on the listing to indicate 

the corrective action taken. 
 
Step #5: File the annotated suspense report for the records. This is SMC (Supply 

Management Certification) item. SMC Team may require a proof that Stock 
Control is performing this action on a daily basis. 

 
 
 
Any questions, feedback or comments, email Lonnie Auza. (absalon.auza@navy.mil) 
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